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About vSphere Virtual Machine Administration

vSphere Virtual Machine Administration describes how to create, configure, and manage virtual machines in the
VMware vSphere® environment.

In addition, this information provides introductions to the tasks that you can do within the system as well as
cross-references to the information that describes the tasks.

This information focuses on managing virtual machines in the VMware vSphere Web Client and the VMware
vSphere® Client™ and includes the following information.

n Creating and deploying virtual machines

n Working with templates and clones

n Deploying OVF templates

n Configuring virtual machine hardware, options, and resources

n Managing multitiered applications with VMware vSphere vApp

n Monitoring solutions with the vCenter Solution Manager

n Managing virtual machines, including migration with VMware vSphere® vMotion® and using snapshots

vSphere Virtual Machine Administration covers Vmware ESXi™ and VMware vCenter Server™.

Intended Audience
This information is written for experienced Windows or Linux system administrators who are familiar with
virtualization.
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Introduction to VMware vSphere
Virtual Machines 1

This information introduces the concept of virtual machines and how they function in the infrastructure
environment with vSphere. You will find information about what constitutes a virtual machine and the features
available for managing them.

This chapter includes the following topics:

n “What Is a Virtual Machine?,” on page 9

n “Virtual Machines and the Virtual Infrastructure,” on page 10

n “Virtual Machine Lifecycle,” on page 11

n “Virtual Machine Components,” on page 11

n “Virtual Machine Options and Resources,” on page 11

n “Where to Go From Here,” on page 12

n “vSphere Client and vSphere Web Client,” on page 13

What Is a Virtual Machine?
A virtual machine is a software computer that, like a physical computer, runs an operating system and
applications. The virtual machine is comprised of a set of specification and configuration files and is backed
by the physical resources of a host. Every virtual machine has virtual devices that provide the same
functionality as physical hardware and have additional benefits in terms of portability, manageability, and
security.

A virtual machine consists of several types of files that you store on a supported storage device. The key files
that make up a virtual machine are the configuration file, virtual disk file, NVRAM setting file, and the log file.
You configure virtual machine settings through the vSphere Web Client or the vSphere Client. You do not
need to touch the key files.

A virtual machine can have more files if one or more snapshots exist or if you add Raw Device Mappings
(RDMs).

CAUTION   Do not change, move, or delete these files without instructions from a VMware Technical Support
Representative.

Table 1-1.  Virtual Machine Files

File Usage Description

.vmx vmname.vmx Virtual machine configuration file

.vmxf vmname.vmxf Additional virtual machine configuration files

.vmdk vmname.vmdk Virtual disk characteristics
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Table 1-1.  Virtual Machine Files (Continued)

File Usage Description

-flat.vmdk vmname-flat.vmdk Preallocated virtual disk

.nvram vmname.nvram or nvram Virtual machine BIOS or EFI configuration

.vmsd vmname.vmsd Virtual machine snapshots

.vmsn vmname.vmsn Virtual machine snapshot data file

.vswp vmname.vswp Virtual machine swap file

.vmss vmname.vmss Virtual machine suspend file

.log vmware.log Current virtual machine log file

-#.log vmware-#.log (where # is a number starting
with 1)

Old virtual machine log entries

Virtual Machines and the Virtual Infrastructure
The infrastructure that supports virtual machines consists of at least two software layers, virtualization and
management. In vSphere, ESXi provides the virtualization capabilities that aggregate and present the host
hardware to virtual machines as a normalized set of resources. Virtual machines can run on an isolated ESXi
host or on ESXi hosts that vCenter Server manages.

vCenter Server lets you pool and manage the resources of multiple hosts and lets you effectively monitor and
manage your physical and virtual infrastructure. You can manage resources for virtual machines, provision
virtual machines, schedule tasks, collect statistics logs, create templates, and more. vCenter Server also
provides vSphere vMotion ™, vSphere Storage vMotion, vSphere Distributed Resource Scheduler (DRS),
vSphere High Availability (HA), and vSphere Fault Tolerance. These services enable efficient and automated
resource management and high availability for virtual machines.

The VMware vSphere Web Client and the vSphere Client are interfaces to vCenter Server, ESXi hosts, and
virtual machines. With the vSphere Web Client and the vSphere Client, you can connect remotely to
vCenter Server. With the vSphere Client you can also connect directly to ESXi from any Windows system. The
vSphere Web Client and the vSphere Client are the primary interfaces for managing all aspects of the
vSphere environment. They also provide console access to virtual machines.

The vSphere Web Client and the vSphere Client present the organizational hierarchy of managed objects in
inventory views. Inventories are the hierarchal structure used by vCenter Server or the host to organize
managed objects. This hierarchy includes all of the monitored objects in vCenter Server.

In the vCenter Server hierarchy, a datacenter is the primary container of ESXi hosts, folders, clusters, resource
pools, vSphere vApps, virtual machines, and so on.

Datastores are virtual representations of underlying physical storage resources in the datacenter. A datastore
is the storage location (for example, a physical disk or LUN on a RAID, or a SAN) for virtual machine files.
Datastores hide the idiosyncrasies of the underlying physical storage and present a uniform model for the
storage resources required by virtual machines.

For some resources, options, or hardware to be available to virtual machines, the host must have the
appropriate vSphere license. Licensing in vSphere is applicable to ESXi hosts, vCenter Server, and solutions.
Licensing can be based on different criteria, depending on the specifics of each product. For details about
vSphere licensing, see the vCenter Server and Host Management documentation.

vSphere Virtual Machine Administration
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Virtual Machine Lifecycle
You create and deploy virtual machines into your datacenter in a several ways. You can create a single virtual
machine and install a guest operating system and VMware Tools on it. You can clone or create a template from
an existing virtual machine, or deploy OVF templates.

The vSphere Web Client and the vSphere Client New Virtual Machine wizards and Virtual Machine Properties
editors let you add, configure, or remove most of the virtual machine's hardware, options, and resources. You
monitor CPU, memory, disk, network, and storage metrics using the performance charts in the vSphere Client.
Snapshots let you capture the state of the virtual machine, including the virtual machine memory, settings,
and virtual disks. You can roll back to the previous virtual machine state when needed.

With vSphere vApps, you can manage multitiered applications. You use vSphere Update Manager to perform
orchestrated upgrades to upgrade the virtual hardware and VMware Tools of virtual machines in the inventory
at the same time.

When a virtual machine is no longer needed, you can remove it from the inventory without deleting it from
the datastore, or you can delete the virtual machine and all its files.

Virtual Machine Components
Virtual machines typically have an operating system, VMware Tools, and virtual resources and hardware that
you manage in much the same way as you would manage a physical computer.

You install a guest operating system on a virtual machine the same way as you install an operating system on
a physical computer. You must have a CD/DVD-ROM or ISO image containing the installation files from an
operating system vendor.

VMware Tools is a suite of utilities that enhances the performance of the virtual machine's guest operating
system and improves management of the virtual machine. With VMware Tools, you have more control over
the virtual machine interface.

All virtual machines have a hardware version. The hardware version indicates virtual hardware features that
the virtual machine supports, such as BIOS or EFI, number of virtual slots, maximum number of CPUs,
maximum memory configuration, and other hardware characteristics. The version of the ESXi host on which
you create the virtual machine determines the virtual machine hardware version.

The hardware devices listed in the Virtual Machine Properties editor complete the virtual machine. Not all
devices are configurable. Some hardware devices are part of the virtual motherboard and appear in the
expanded device list of the Virtual Machine Properties editor, but you cannot modify or remove them. For a
list of hardware devices and their functions, see “Virtual Machine Hardware, Options, and Resources Available
to vSphere Virtual Machines,” on page 78.

Access to a virtual machine is controlled by the vSphere administrator.

Virtual Machine Options and Resources
Each virtual device performs the same function for the virtual machine as hardware on a physical computer
does.

A virtual machine might be running in any of several locations, such as ESXi hosts, datacenters, clusters, or
resource pools. Many of the options and resources that you configure have dependencies on and relationships
with these objects.

Every virtual machine has CPU, memory, and disk resources. CPU virtualization emphasizes performance
and runs directly on the processor whenever possible. The underlying physical resources are used whenever
possible. The virtualization layer runs instructions only as needed to make virtual machines operate as if they
were running directly on a physical machine.

Chapter 1 Introduction to VMware vSphere Virtual Machines

VMware, Inc.  11



All recent operating systems provide support for virtual memory, allowing software to use more memory than
the machine physically has. Similarly, the ESXi hypervisor provides support for overcommitting virtual
machine memory, where the amount of guest memory configured for all virtual machines might be larger than
the amount of the host's physical memory.

You can add virtual disks and add more space to existing disks, even when the virtual machine is running.
You can also change the device node and allocate shares of disk bandwidth to the virtual machine.

VMware virtual machines have the following options:

General Options View or modify the virtual machine name, check the location of the
configuration file and the working location of the virtual machine, or change
the guest operating system type.

vApp Options Enable or disable vApp functionality. When vApp is enabled, you can edit and
configure an IP allocation policy and other configurations particular to vApps.

VMware Tools Manage the power controls for the virtual machine and run VMware Tools
scripts. You can also upgrade VMware Tools during power cycling and
synchronize guest time with the host.

General Advanced
Options

Disable acceleration and enable logging, debugging, and statistics. You can also
add configuration parameters.

Power Management Manage guest power options. Suspend the virtual machine or leave the virtual
machine powered on when you put the guest operating system into standby.

CPUID Mask Hide or expose the NX/XD flag. Hiding the NX/XD flag increases vMotion
compatibility between hosts.

Memory/CPU Hotplug Enable or disable CPU and memory hotplug. If the guest operating system
supports this option, you can add Memory or CPU resources to a virtual
machine while the virtual machine is running. You can disable Memory or CPU
hotplug to avoid adding memory or CPUs while the virtual machine is running.
Memory hotplug is supported on all 64 bit operating systems.

Boot Options Set the boot delay when powering on virtual machines or to force BIOS setup
and configure failed boot recovery.

Fibre Channel NPIV Control virtual machine access to LUNs on a per-virtual machine basis. N-port
ID virtualization (NPIV) provides the ability to share a single physical Fibre
Channel HBA port among multiple virtual ports, each with unique identifiers.

Where to Go From Here
You must create, provision, and deploy your virtual machines before you can manage them.

To begin provisioning virtual machines, determine whether to create a single virtual machine and install an
operating system and VMware tools, work with templates and clones, or deploy virtual machines, virtual
appliances, or vApps stored in Open Virtual Machine Format (OVF).

After you provision and deploy virtual machines into the vSphere infrastructure, you can configure and
manage them. You can configure existing virtual machines by modifying or adding hardware or install or
upgrade VMware Tools. You might need to manage multitiered applications with VMware vApps or change
virtual machine startup and shutdown settings, use virtual machine snapshots, work with virtual disks, or
add, remove, or delete virtual machines from the inventory.

vSphere Virtual Machine Administration
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vSphere Client and vSphere Web Client
All administrative functions are available through the vSphere Client. A subset of those functions is available
through the vSphere Web Client.

Table 1-2.  Comparing the Two Clients

vSphere Client vSphere Web Client

For infrastructure configuration and day-to-day operations. For day-to-day operations.

n Locally installed application.
n Windows operating system only.
n Can connect to vCenter Server or directly to hosts.
n Full range of administrative functionality.

n Web application.
n Cross platform.
n Can connect to only vCenter Server.
n Subset of full functionality, focused on virtual machine

deployment and basic monitoring functions. Cannot
configure hosts, clusters, networks, datastores, or
datastore clusters.

n Extensible plug-in-based architecture.

Users: Virtual infrastructure administrators for specialized
functions.

Users: Virtual infrastructure administrators, help desk,
network operations center operators, virtual machine
owners.

The vSphere Client uses the VMware API to access vCenter Server. After the user is authenticated, a session
starts in vCenter Server, and the user sees the resources and virtual machines that are assigned to the user. For
virtual machine console access, the vSphere Client first uses the VMware API to obtain the virtual machine
location from vCenter Server. The vSphere Client then connects to the appropriate host and provides access
to the virtual machine console.

Users can use the vSphere Web Client to access vCenter Server through a Web browser. The
vSphere Web Client uses the VMware API to mediate the communication between the browser and the
vCenter Server.

Chapter 1 Introduction to VMware vSphere Virtual Machines
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About Provisioning Virtual Machines 2
VMware provides several methods to provision vSphere virtual machines. The optimal method for your
environment depends on factors such as the size and type of your infrastructure and the goals that you are
trying to achieve.

Create a single virtual machine if no other virtual machines in your environment have the requirements you
are looking for, such as a particular operating system or hardware configuration. For example, you might need
a virtual machine that is configured only for testing purposes. You can also create a single virtual machine and
install an operating system on it, then use that virtual machine as a template to clone other virtual machines
from. See “Create a Virtual Machine without a Template or Clone in the vSphere Web Client,” on page 20 or
Chapter 4, “Creating a Virtual Machine in the vSphere Client,” on page 29.

Deploy and export virtual machines, virtual appliances, and vApps stored in Open Virtual Machine Format
(OVF) to use a preconfigured virtual machine. A virtual appliance is a prebuilt virtual machine that typically
has an operating system and other software already installed. You can deploy virtual machines from local file
systems, such as local disks (such as C:), removable media (such as CDs or USB keychain drives), and shared
network drives. See Chapter 6, “Deploying OVF Templates,” on page 67.

Create a template to deploy multiple virtual machines from. A template is a master copy of a virtual machine
that you can use to create and provision virtual machines. Templates can be a real time saver. If you have a
virtual machine that you want to clone frequently, make that virtual machine a template. See “Deploy a Virtual
Machine from a Template in the vSphere Web Client,” on page 17 or Chapter 5, “Working with Templates
and Clones in the vSphere Client,” on page 43.

Cloning a virtual machine can save time if you are deploying many similar virtual machines. You can create,
configure, and install software on a single virtual machine and clone it multiple times, rather than creating and
configuring each virtual machine individually. See “Clone a Virtual Machine in the vSphere Web Client,” on
page 24 or Chapter 5, “Working with Templates and Clones in the vSphere Client,” on page 43.
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Deploying Virtual Machines in the
vSphere Web Client 3

To deploy virtual machines in the vCenter Server inventory, you can deploy from a template, create a virtual
machine, or clone an existing virtual machine.

This chapter includes the following topics:

n “Deploy a Virtual Machine from a Template in the vSphere Web Client,” on page 17

n “Create a Virtual Machine without a Template or Clone in the vSphere Web Client,” on page 20

n “Clone a Virtual Machine in the vSphere Web Client,” on page 24

Deploy a Virtual Machine from a Template in the vSphere Web Client
Deploying a virtual machine from a template creates a virtual machine that is a copy of the template. The new
virtual machine has the virtual hardware, installed software, and other properties that are configured for the
template.

Prerequisites

You must have the following privileges to deploy a virtual machine from a template:

n Virtual machine .Inventory.Create from existing on the datacenter or virtual machine folder.

n Virtual machine.Configuration.Add new disk on the datacenter or virtual machine folder.

n Virtual machine.Provisioning.Deploy template on the template or template folder.

n Resource.Assign virtual machine to resource pool on the destination host, cluster, or resource pool.

n Datastore.Allocate space on the destination datastore or datastore folder.

n Network.Assign network on the network to which the virtual machine will be assigned.

n Virtual machine.Provisioning.Customize on the template or template folder if you are customizing the
guest operating system.

n Virtual machine.Provisioning.Read customization specifications on the root vCenter Server if you are
customizing the guest operating system.

Procedure

1 Select to Deploy from a Template on page 18
You can deploy a virtual machine from a template to create a virtual machine that is a copy of the template.

2 Select a Template on page 18
You can create a virtual machine from a template.
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3 Select the Virtual Machine Name and Folder on page 19
When you deploy a virtual machine to the vCenter Server inventory, you name it and select the folder
where it will be located.

4 Select a Resource Pool on page 19
When you deploy a virtual machine, select the host, cluster, vApp, or resource pool in which the virtual
machine will run.

5 Select a Datastore on page 19
When you add a virtual machine to the vCenter Server inventory, you must select the datastore on which
to create the virtual machine's disks.

6 Customize the Guest Operating System on page 20
When you clone a virtual machine or deploy a virtual machine from a template, you can customize the
guest operating system of the virtual machine to change properties such as the computer name, network
settings, and license settings.

7 Customize Virtual Machine Hardware in the vSphere Web Client on page 20
Before you deploy a new virtual machine, you have the option to configure the virtual hardware.

8 Finish Virtual Machine Creation on page 20
Before you deploy the virtual machine, you can review the virtual machine settings.

Select to Deploy from a Template
You can deploy a virtual machine from a template to create a virtual machine that is a copy of the template.

Procedure

1 Select any inventory object that is a valid parent object of a virtual machine, such as a datacenter, folder,

cluster, resource pool, or host and click the Create Virtual Machine icon ( ).

2 Select Deploy from Template and click Next.

Select a Template
You can create a virtual machine from a template.

Procedure

1 Browse or search to locate a template.

2 Select the template.

3 (Optional) Select Customize the operating system to customize the guest operating system of the virtual
machine.

4 (Optional) Select Customize this virtual machine's hardware to configure the virtual machine's hardware
before deployment.

5 (Optional) Select Power On Virtual Machine after creation to power on the virtual machine after creation
is complete.

6 Click Next.

vSphere Virtual Machine Administration
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Select the Virtual Machine Name and Folder
When you deploy a virtual machine to the vCenter Server inventory, you name it and select the folder where
it will be located.

Procedure

1 In the Name text box, type a name for the virtual machine.

2 Select or search for the datacenter or folder in which to deploy the virtual machine.

3 Click Next.

Select a Resource Pool
When you deploy a virtual machine, select the host, cluster, vApp, or resource pool in which the virtual machine
will run.

Procedure

1 Search or browse for the host, cluster, vApp, or resource pool for the virtual machine.

If deploying the virtual machine to the selected location might cause compatibility problems, these
compatibility problems are displayed at the bottom of the window.

2 Click Next.

Select a Datastore
When you add a virtual machine to the vCenter Server inventory, you must select the datastore on which to
create the virtual machine's disks.

Procedure

u Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the
same location on a datastore.

Select a datastore and click Next.

Store all virtual machine files in the
same datastore cluster.

a Select a datastore cluster.
b (Optional) If you do not want to use Storage DRS with this virtual

machine, select Disable Storage DRS for this virtual machine and select
a datastore within the datastore cluster.

c Click Next.

Store virtual machine configuration
files and disks in separate locations.

a Click Advanced.
b For the virtual machine configuration file and for each virtual disk, click

Browse and select a datastore or datastore cluster.
c (Optional) If you selected a datastore cluster and do not want to use

Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the datastore cluster.

d Click OK.
e Click Next.

 

Chapter 3 Deploying Virtual Machines in the vSphere Web Client
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Customize the Guest Operating System
When you clone a virtual machine or deploy a virtual machine from a template, you can customize the guest
operating system of the virtual machine to change properties such as the computer name, network settings,
and license settings.

Customizing guest operating systems can help prevent conflicts that can result if virtual machines with
identical settings are deployed, such as conflicts because of duplicate computer names.

Procedure

u Select a customization specification from the Guest OS Customization drop-down menu and click
Next.

Customize Virtual Machine Hardware in the vSphere Web Client
Before you deploy a new virtual machine, you have the option to configure the virtual hardware.

Procedure

1 (Optional) To add a new virtual hardware device, select the device from the Add a device drop-down
menu and click Add device.

2 (Optional) Click the triangle next to any virtual device to view and configure the device settings.

3 Click Next.

Finish Virtual Machine Creation
Before you deploy the virtual machine, you can review the virtual machine settings.

Procedure

1 Review the virtual machine settings and make any necessary changes by clicking Previous to go back to
the relevant page.

2 Click Finish.

Create a Virtual Machine without a Template or Clone in the
vSphere Web Client

When you create a virtual machine without a template or clone, you configure the virtual hardware, including
processors, memory, and virtual disks.

Prerequisites

You must have the following privileges to create a virtual machine:

n Virtual machine.Inventory.Create new on the destination folder or datacenter.

n Virtual machine.Configuration.Add new disk on the destination folder or datacenter, if you are adding
a new disk.

n Virtual machine.Configuration.Add existing disk on the destination folder or datacenter, if you are
adding an existing disk.

n Virtual machine.Configuration.Raw device on the destination folder or datacenter, if you are using a
RDM or SCSI pass-through device.

n Virtual machine.Configuration.Host USB device on the destination folder or datacenter, if you are
attaching a virtual USB device backed by a host USB device.

vSphere Virtual Machine Administration
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n Virtual machine.Configuration.Advanced  on the destination folder or datacenter, if you are configuring
advanced virtual machine settings.

n Virtual machine.Configuration.Swapfile placement on the destination folder or datacenter, if you are
configuring swapfile placement.

n Virtual machine.Configuration.Disk change tracking on the destination folder or datacenter, if you are
enabling change tracking on the virtual machine's disks.

n Resource.Assign virtual machine to resource pool on the destination host, cluster, or resource pool.

n Datastore.Allocate space on the destination datastore or datastore folder.

n Network.Assign network on the network that the virtual machine will be assigned to.

Procedure

1 Select to Create a Virtual Machine without a Template or Clone on page 21
When you create a virtual machine without a template or clone, you configure the processors, memory,
disks, and other virtual hardware.

2 Select the Virtual Machine Name and Folder on page 22
When you deploy a virtual machine to the vCenter Server inventory, you name it and select the folder
where it will be located.

3 Select a Resource Pool on page 22
When you deploy a virtual machine, select the host, cluster, vApp, or resource pool in which the virtual
machine will run.

4 Select a Datastore on page 22
When you add a virtual machine to the vCenter Server inventory, you must select the datastore on which
to create the virtual machine's disks.

5 Select a Virtual Machine Version on page 22
If the host or cluster where you place the virtual machine supports more than one VMware virtual
machine version, you can select a version for the virtual machine.

6 Select a Guest Operating System on page 23
The guest operating system that you select affects the supported devices and number of virtual CPUs
available for the virtual machine.

7 Customize Virtual Machine Hardware in the vSphere Web Client on page 23
Before you deploy a new virtual machine, you have the option to configure the virtual hardware.

8 Finish Virtual Machine Creation on page 24
Before you deploy the virtual machine, you can review the virtual machine settings.

Select to Create a Virtual Machine without a Template or Clone
When you create a virtual machine without a template or clone, you configure the processors, memory, disks,
and other virtual hardware.

Procedure

1 Select any inventory object that is a valid parent object of a virtual machine, such as a datacenter, folder,

cluster, resource pool, or host and click the Create Virtual Machine icon ( ).

2 Select Create a new virtual machine and click Next.
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Select the Virtual Machine Name and Folder
When you deploy a virtual machine to the vCenter Server inventory, you name it and select the folder where
it will be located.

Procedure

1 In the Name text box, type a name for the virtual machine.

2 Select or search for the datacenter or folder in which to deploy the virtual machine.

3 Click Next.

Select a Resource Pool
When you deploy a virtual machine, select the host, cluster, vApp, or resource pool in which the virtual machine
will run.

Procedure

1 Search or browse for the host, cluster, vApp, or resource pool for the virtual machine.

If deploying the virtual machine to the selected location might cause compatibility problems, these
compatibility problems are displayed at the bottom of the window.

2 Click Next.

Select a Datastore
When you add a virtual machine to the vCenter Server inventory, you must select the datastore on which to
create the virtual machine's disks.

Procedure

u Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the
same location on a datastore.

Select a datastore and click Next.

Store all virtual machine files in the
same datastore cluster.

a Select a datastore cluster.
b (Optional) If you do not want to use Storage DRS with this virtual

machine, select Disable Storage DRS for this virtual machine and select
a datastore within the datastore cluster.

c Click Next.
 

Select a Virtual Machine Version
If the host or cluster where you place the virtual machine supports more than one VMware virtual machine
version, you can select a version for the virtual machine.

Only those options that are compatible with the selected host or cluster appear.
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Procedure

u Select a virtual machine hardware version.

Option Description

Virtual machine version 7 Compatible with ESX/ESXi 4.0 and later hosts. Provides greater virtual
machine functionality. Recommended for virtual machines that need to run
on ESX/ESXi 4.x hosts that do not need to migrate to ESX 3.x hosts.

Virtual machine version 8 Compatible with ESXi 5.0 and later hosts. Provides greater virtual machine
functionality. Recommended for virtual machines that do not need to
migrate to ESX/ESXi 4.x hosts.

 

Select a Guest Operating System
The guest operating system that you select affects the supported devices and number of virtual CPUs available
for the virtual machine.

See the VMware Compatibility Guide for details.

The New Virtual Machine does not install the guest operating system for you. The wizard uses this information
to select appropriate default values, such as the amount of memory needed.

When you select a guest operating system, BIOS or Extensible Firmware Interface (EFI) is selected by default,
depending on the firmware supported by the operating system. Mac OS X Server guest operating systems
support only EFI. If the operating system supports BIOS and EFI, you can change the default from the Options
tab of the Virtual Machine Properties editor after you create the virtual machine and before you install the
guest operating system. If you select EFI, you cannot boot an operating system that supports only BIOS, and
the reverse.

IMPORTANT   Do not change the firmware after the guest operating system is installed.

The Mac OS X Server must run on Apple hardware. You cannot power on a Mac OS X Server if it is running
on other hardware.

Procedure

1 Select the guest operating system family.

2 Select a guest operating system version.

3 If you selected Other (32-bit) or Other (64-bit), enter a name for the operating system in the text box.

4 Click Next.

Customize Virtual Machine Hardware in the vSphere Web Client
Before you deploy a new virtual machine, you have the option to configure the virtual hardware.

Procedure

1 (Optional) To add a new virtual hardware device, select the device from the Add a device drop-down
menu and click Add device.

2 (Optional) Click the triangle next to any virtual device to view and configure the device settings.

3 Click Next.
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Finish Virtual Machine Creation
Before you deploy the virtual machine, you can review the virtual machine settings.

Procedure

1 Review the virtual machine settings and make any necessary changes by clicking Previous to go back to
the relevant page.

2 Click Finish.

Clone a Virtual Machine in the vSphere Web Client
Cloning a virtual machine creates a virtual machine that is a copy of the original. The new virtual machine is
configured with the same virtual hardware, installed software, and other properties that were configured for
the original virtual machine.

NOTE   When heavily loaded applications, such as load generators, are running in the guest operating system
during a clone operation, the virtual machine quiesce operation can fail and VMware Tools might be denied
CPU resources and time out.

Prerequisites

If a load generator is running in the virtual machine, stop it before you perform the clone operation.

You must have the following privileges to clone a virtual machine:

n Virtual machine.Provisioning.Clone virtual machine on the virtual machine you are cloning.

n Virtual machine .Inventory.Create from existing on the datacenter or virtual machine folder.

n Virtual machine.Configuration.Add new disk on the datacenter or virtual machine folder.

n Resource.Assign virtual machine to resource pool on the destination host, cluster, or resource pool.

n Datastore.Allocate space on the destination datastore or datastore folder.

n Network.Assign network on the network to which the virtual machine will be assigned.

n Virtual machine.Provisioning.Customize on the virtual machine or virtual machine folder if you are
customizing the guest operating system.

n Virtual machine.Provisioning.Read customization specifications on the root vCenter Server if you are
customizing the guest operating system.

Procedure

1 Select to Clone a Virtual Machine on page 25
When you clone a virtual machine, you create a copy of an existing virtual machine.

2 Select a Virtual Machine to Clone on page 25
Select the virtual machine to clone.

3 Select the Virtual Machine Name and Folder on page 25
When you deploy a virtual machine to the vCenter Server inventory, you name it and select the folder
where it will be located.

4 Select a Resource Pool on page 26
When you deploy a virtual machine, select the host, cluster, vApp, or resource pool in which the virtual
machine will run.
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5 Select a Datastore on page 26
When you add a virtual machine to the vCenter Server inventory, you must select the datastore on which
to create the virtual machine's disks.

6 Customize the Guest Operating System on page 26
When you clone a virtual machine or deploy a virtual machine from a template, you can customize the
guest operating system of the virtual machine to change properties such as the computer name, network
settings, and license settings.

7 Customize Virtual Machine Hardware in the vSphere Web Client on page 27
Before you deploy a new virtual machine, you have the option to configure the virtual hardware.

8 Finish Virtual Machine Creation on page 27
Before you deploy the virtual machine, you can review the virtual machine settings.

Select to Clone a Virtual Machine
When you clone a virtual machine, you create a copy of an existing virtual machine.

Procedure

1 Select any inventory object that is a valid parent object of a virtual machine, such as a datacenter, folder,

cluster, resource pool, or host and click the Create Virtual Machine icon ( ).

2 Select Clone an existing virtual machine and click Next.

Select a Virtual Machine to Clone
Select the virtual machine to clone.

Procedure

1 Browse or search for the virtual machine and select it.

2 (Optional) Select Customize the operating system to customize the guest operating system of the virtual
machine.

3 (Optional) Select Customize this virtual machine's hardware to configure the virtual machine's hardware
before deployment.

4 (Optional) Select Power On Virtual Machine after creation to power on the virtual machine after creation
is complete.

5 Click Next.

Select the Virtual Machine Name and Folder
When you deploy a virtual machine to the vCenter Server inventory, you name it and select the folder where
it will be located.

Procedure

1 In the Name text box, type a name for the virtual machine.

2 Select or search for the datacenter or folder in which to deploy the virtual machine.

3 Click Next.
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Select a Resource Pool
When you deploy a virtual machine, select the host, cluster, vApp, or resource pool in which the virtual machine
will run.

Procedure

1 Search or browse for the host, cluster, vApp, or resource pool for the virtual machine.

If deploying the virtual machine to the selected location might cause compatibility problems, these
compatibility problems are displayed at the bottom of the window.

2 Click Next.

Select a Datastore
When you add a virtual machine to the vCenter Server inventory, you must select the datastore on which to
create the virtual machine's disks.

Procedure

u Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the
same location on a datastore.

Select a datastore and click Next.

Store all virtual machine files in the
same datastore cluster.

a Select a datastore cluster.
b (Optional) If you do not want to use Storage DRS with this virtual

machine, select Disable Storage DRS for this virtual machine and select
a datastore within the datastore cluster.

c Click Next.

Store virtual machine configuration
files and disks in separate locations.

a Click Advanced.
b For the virtual machine configuration file and for each virtual disk, click

Browse and select a datastore or datastore cluster.
c (Optional) If you selected a datastore cluster and do not want to use

Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the datastore cluster.

d Click OK.
e Click Next.

 

Customize the Guest Operating System
When you clone a virtual machine or deploy a virtual machine from a template, you can customize the guest
operating system of the virtual machine to change properties such as the computer name, network settings,
and license settings.

Customizing guest operating systems can help prevent conflicts that can result if virtual machines with
identical settings are deployed, such as conflicts because of duplicate computer names.

Procedure

u Select a customization specification from the Guest OS Customization drop-down menu and click
Next.
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Customize Virtual Machine Hardware in the vSphere Web Client
Before you deploy a new virtual machine, you have the option to configure the virtual hardware.

Procedure

1 (Optional) To add a new virtual hardware device, select the device from the Add a device drop-down
menu and click Add device.

2 (Optional) Click the triangle next to any virtual device to view and configure the device settings.

3 Click Next.

Finish Virtual Machine Creation
Before you deploy the virtual machine, you can review the virtual machine settings.

Procedure

1 Review the virtual machine settings and make any necessary changes by clicking Previous to go back to
the relevant page.

2 Click Finish.
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Creating a Virtual Machine in the
vSphere Client 4

Virtual machines are the key component in a virtual infrastructure. You can create a single virtual machine to
add to the vSphere inventory.

When you create a virtual machine, you associate it to a particular datacenter, host, cluster, or resource pool,
and a datastore. After you turn on the virtual machine, it consumes resources dynamically as the workload
increases, or it returns resources dynamically as the workload decreases.

Every virtual machine has virtual devices that provide the same function as physical hardware. A virtual
machine gets CPU and memory, access to storage, and network connectivity from the host it runs on.

This chapter includes the following topics:

n “Start the Virtual Machine Creation Process in the vSphere Client,” on page 29

n “Select a Configuration Option for the New Virtual Machine in the vSphere Client,” on page 30

n “Enter a Name and Location for the Virtual Machine in the vSphere Client,” on page 31

n “Select a Host or Cluster in the vSphere Client,” on page 31

n “Select a Resource Pool in the vSphere Client,” on page 32

n “Select a Datastore in the vSphere Client,” on page 32

n “Select a Virtual Machine Version in the vSphere Client,” on page 32

n “Select an Operating System in the vSphere Client,” on page 33

n “Select the Number of Virtual CPUs in the vSphere Client,” on page 34

n “Configure Virtual Memory in the vSphere Client,” on page 34

n “Configure Networks in the vSphere Client,” on page 35

n “Select a SCSI Controller in the vSphere Client,” on page 35

n “Selecting a Virtual Disk Type,” on page 36

n “Complete Virtual Machine Creation in the vSphere Client,” on page 40

n “Installing a Guest Operating System,” on page 40

Start the Virtual Machine Creation Process in the vSphere Client
You use the Create New Virtual Machine wizard to create a virtual machine to place in the vSphere inventory.
You open the wizard from the vSphere Client.

The selections you make in the New Virtual Machine wizard are not saved until you click Finish on the Ready
to Complete page. If you cancel the wizard without completing all tasks, you cannot resume the wizard where
you left off. You must start a new creation task.
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You can create a new virtual machine in a datacenter, host, cluster, resource pool, or virtual machine folder.

Prerequisites

Verify that you have the following privileges:

n Host.Local operations.Create virtual machine

n Virtual machine.Inventory.Create new on the destination folder or datacenter.

n Virtual machine.Configuration.Add new disk on the destination folder or datacenter, if you are adding
a new disk.

n Virtual machine.Configuration.Add existing disk on the destination folder or datacenter, if you are
adding an existing disk.

n Virtual machine.Configuration.Raw device on the destination folder or datacenter, if you are using a
RDM or SCSI pass-through device.

n Virtual Machine.Configuration.Network

n Resource.Assign virtual machine to resource pool on the destination host, cluster, or resource pool.

n Datastore.Allocate space on the destination datastore or datastore folder.

n Network.Assign network on the network that the virtual machine will be assigned to.

Procedure

1 Display the inventory objects in the vSphere Client by using the Host and Clusters view or the VM and
Templates view.

2 Right-click an object and select New > Virtual Machine.

The  New Virtual Machine wizard opens.

What to do next

Select a Typical or Custom configuration option in the New Virtual Machine wizard.

Select a Configuration Option for the New Virtual Machine in the
vSphere Client

The Typical option shortens the virtual machine creation process by skipping choices that you rarely need to
change from their defaults. The Custom option provides more flexibility and choices.

Several relationships affect the information that you must provide during virtual machine creation. These
relationships include the inventory object on which you place the virtual machine, the customization path
option you select, the datastore on which the virtual machine and its files reside, and the host or cluster on
which it runs.

If you select a Typical configuration, the virtual machine hardware version defaults to that of the host on which
you place the virtual machine. If you select a Custom configuration, you can accept the default or select an
earlier hardware version. This configuration is useful if maintaining compatibility with an earlier version of
an ESX/ESXi host is necessary.

Prerequisites

For a Typical configuration, verify that you have the following information:

n Virtual machine name and inventory location.

n Location in which to place the virtual machine (cluster, host, resource pool).

n Datastore on which to store the virtual machine's files.
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n Guest operating system and version.

n Parameters for the virtual disk size and provisioning settings.

In addition to the information for a Typical configuration, for a Custom configuration, verify that you have
the following information:

n Virtual machine version.

n Number of CPUs and memory size.

n Number of NICs, network to connect to, and network adapter types.

n SCSI controller type.

n Disk type (new disk, existing disk, RDM, or no disk).

Procedure

1 On the Configuration page of the New Virtual Machine wizard, select an option for creating the virtual
machine.

2 Click Next.

The Name and Location page appears.

What to do next

Select a name and location for the virtual machine.

Enter a Name and Location for the Virtual Machine in the vSphere Client
The name you enter is used as the virtual machine’s base name in the inventory. It is also used as the name of
the virtual machine’s files.

The name can be up to 80 characters long. If you are connected to vCenter Server and have folders in your
inventory, names must be unique within the folder. Names are not case-sensitive, so the name my_vm is identical
to My_Vm.

Prerequisites

Verify that you have an appropriate naming strategy in place.

Procedure

1 On the Name and Location page of the New Virtual Machine wizard, type a name.

2 Select a folder or the root of the datacenter.

3 Click Next.

The Host / Cluster or the Resource Pool page opens.

Select a Host or Cluster in the vSphere Client
You can place the virtual machine in a cluster or on a host that is not in a cluster.

A cluster is a collection of ESXi hosts and associated virtual machines with shared resources and a shared
management interface. Grouping hosts into clusters allows you to enable many optional features that enhance
the availability and flexibility of your infrastructure.

Procedure

1 On the Host / Cluster page of the New Virtual Machine wizard, select the host or cluster where you want
to run the virtual machine.
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2 Click Next.

If resource pools are configured on the host, the Resource Pool page opens. Otherwise, the Datastore page
opens.

What to do next

Select a resource pool or a datastore on which to run the virtual machine.

Select a Resource Pool in the vSphere Client
Resource pools let you manage your computing resources within a host or cluster by setting them up in a
meaningful hierarchy. Virtual machines and child resource pools share the resources of the parent resource
pool.

The Resource Pool page appears only when resource pools are configured on the host.

Procedure

1 On the Resource Pool page of the New Virtual Machine wizard, navigate to the resource pool where you
want to run the virtual machine.

2 Select the resource pool and click Next.

The virtual machine is placed in the resource pool you selected.

What to do next

Select a datastore in which to store the virtual machine files.

Select a Datastore in the vSphere Client
Datastores are logical containers that hide specifics of each storage device and provide a uniform model for
storing virtual machine files. You can use datastores to store ISO images and virtual machine templates.

You can select from datastores already configured on the destination host or cluster.

Procedure

1 On the Storage page of the New Virtual Machine wizard, select a datastore in which to store the virtual
machine files.

2 (Optional) To turn off Storage DRS for the virtual machine, select Disable Storage DRS for this virtual
machine.

3 (Optional) Apply a virtual machine storage profile from the VM Storage Profile drop-down menu.

Select a datastore that is compatible with the virtual machine storage profile and large enough to hold the
virtual machine and all of its virtual disk files.

The list of datastores shows which datastores are compatible with the selected virtual machine storage
profile.

4 Click Next.

If you selected a Typical configuration path, the Guest Operating System page appears. If you selected a
Custom configuration path, the Virtual Machine Version page appears.

Select a Virtual Machine Version in the vSphere Client
If the host or cluster where you place the virtual machine supports more than one VMware virtual machine
version, you can select a version for the virtual machine.

For virtual machine and host compatibility options, see “Virtual Machine Hardware Versions,” on page 81.
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Procedure

1 Select a virtual machine hardware version.

Option Description

Virtual machine version 8 Compatible with ESXi 5.0 and later hosts. Provides the latest virtual machine
features. Recommended for virtual machines that do not need to migrate to
ESX/ESXi 4.x hosts.

Virtual machine version 7 Compatible with ESX/ESXi 4, 4.x and 5.0 hosts. Recommended for sharing
storage or virtual machines with ESX/ESXi versions 3.5 to 4.1.

Virtual machine version 4 Compatible with ESX/ESXi 4.0 and later hosts. Recommended for virtual
machines that need to run on ESX/ESXi 4 hosts.

 
2 Click Next.

The Guest Operating System page opens.

What to do next

Select a guest operating system for the virtual machine.

Select an Operating System in the vSphere Client
The guest operating system that you select affects the supported devices and number of virtual CPUs available
to the virtual machine.

The New Virtual Machine wizard does not install the guest operating system. The wizard uses this information
to select appropriate default values, such as the amount of memory needed.

When you select a guest operating system, BIOS or Extensible Firmware Interface (EFI) is selected by default,
depending on the firmware supported by the operating system. Mac OS X Server guest operating systems
support only EFI. If the operating system supports BIOS and EFI, you can change the default from the Options
tab of the Virtual Machine Properties editor after you create the virtual machine and before you install the
guest operating system. If you select EFI, you cannot boot an operating system that supports only BIOS, and
the reverse.

IMPORTANT   Do not change the firmware after the guest operating system is installed.

The Mac OS X Server must run on Apple hardware. You cannot power on a Mac OS X Server if it is running
on other hardware.

Procedure

1 On the Guest Operating System page of the New Virtual Machine wizard, select an operating system
family.

2 Select an operating system and version from the drop-down menu and click Next.

If you selected a Novell NetWare guest operating system, the Memory page opens. If any of the total cores
available on the host, the maximum virtual CPUs supported by the virtual machine hardware version, or
the maximum supported CPUs on the guest operating system equal 1, the virtual machine CPU count is
set to 1 and the Memory page opens.

3 If you selected Other (32-bit) or Other (64-bit), enter a name for the operating system in the text box.

4 Click Next.

What to do next

You can add memory or CPUs for the virtual machine.
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Select the Number of Virtual CPUs in the vSphere Client
You can configure a virtual machine to have up to 32 virtual CPUs. The number of licensed CPUs on the host,
the number of CPUs that the guest operating system supports, and the virtual machine hardware version
determine the number of virtual CPUs that you can add.

VMware Virtual Symmetric Multiprocessing (Virtual SMP) enables a single virtual machine to use multiple
physical processors simultaneously. You must have Virtual SMP to power on multiprocessor virtual machines.

Procedure

1 On the CPUs page of the New Virtual Machine wizard, select a value from the Number of virtual
sockets drop-down menu.

2 Select a value from the Number of cores per socket drop-down menu.

To determine the total number of cores, multiply the number of cores per socket by the number of virtual
sockets. The resulting total number of cores is a number equal to or less than the number of logical CPUs
on the host.

The total number of cores appears.

3 Click Next.

The Memory page opens.

What to do next

Select the memory for the virtual machine.

Configure Virtual Memory in the vSphere Client
The amount of memory that you allocate for a virtual machine is the amount of memory that the guest operating
system detects.

Minimum memory size is 4MB for virtual machines that use BIOS firmware. Virtual machines that use EFI
firmware require at least 96MB of RAM or they cannot power on.

Maximum memory size for a virtual machine depends on the host's physical memory and the virtual machine's
hardware version.

If the virtual machine memory is greater than the host memory size, swapping occurs, which can have a severe
effect on virtual machine performance. The memory size must be a multiple of 4MB. The maximum for best
performance represents the threshold above which the host’s physical memory is insufficient to run the virtual
machine at full speed. This value fluctuates as conditions on the host change, for example, as virtual machines
are powered on or off.

Table 4-1.  Maximum Virtual Machine Memory

Introduced in Host Version Virtual Machine Version Maximum Memory Size

ESXi 5.0 8 1011GB

ESX/ESXi 4.x 7 255GB

ESX/ESXi 3.x 4 65,532MB

The ESXi host version indicates when support began for the increased memory size. For example, the memory
size of a version 4 virtual machine running on ESXi 5.0 is restricted to 65,532MB.
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Procedure

1 On the Memory page of the New Virtual Machine wizard, select a size for the virtual memory.

You can use the slider or use the up and down arrows to select the number. To access the predefined
default or recommended setting, click the colored triangles on the right-hand side of the memory bar.

2 Click Next.

The Network page opens.

What to do next

Select network adapters for the virtual machine.

Configure Networks in the vSphere Client
You can select the virtual network interface cards (NICs) to create on the virtual machine so that the virtual
machine can communicate with other hosts and virtual machines. For each NIC, select the network and adapter
type.

CAUTION   Because virtual machines share their physical network hardware with the host, the accidental or
malicious bridging of two networks by a virtual machine can occur. Spanning Tree protocol cannot protect
against these occurrences.

You can select only four NICs during virtual machine creation. You can add more virtual NICs by selecting
Edit the virtual machine settings before completion on the Ready to Complete page of the wizard, or by
editing the virtual machine after it is created.

For more information about networking, see the vSphere Networking documentation.

Procedure

1 On the Network page of the New Virtual Machine wizard, select the number of NICs to connect from the
drop-down menu.

2 For each NIC, select a network and adapter type from the drop-down menus

Depending on the host version and the guest operating system, a choice of adapter types for each virtual
NIC might not be available. In many cases, only one type of adapter is supported. If more than one type
of adapter is supported, the recommended type for the guest operating system is selected by default.

3 (Optional) Click Connect at Power On to connect the NIC when the virtual machine is powered on.

4 Click Next to add a SCSI Controller.

Select a SCSI Controller in the vSphere Client
To access virtual disks, a virtual machine uses virtual SCSI controllers. Each virtual disk that a virtual machine
can access through one of the virtual SCSI controllers resides in the VMFS datastore, NFS-based datastore, or
on a raw disk. The choice of SCSI controller does not affect whether your virtual disk is an IDE or SCSI disk.

The wizard preselects the correct default controller based on the guest operation system you selected on the
Guest Operating System page.

LSI Logic SAS and VMware Paravirtual controllers are available only for virtual machines with hardware
version 7 or later. For details about VMware Paravirtual controllers, including conditions for use and
limitations, see “About VMware Paravirtual SCSI Controllers,” on page 134.

Disks with snapshots might not experience performance gains when used on LSI Logic SAS and LSI Logic
Parallel controllers.
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Procedure

1 On the SCSI Controller page of the New Virtual Machine wizard, accept the default or select a SCSI
controller type.

n BusLogic Parallel

n LSI Logic Parallel

n LSI Logic SAS

n VMware Paravirtual

2 Click Next.

The Select a Disk page opens.

What to do next

Select a disk on which to store the guest operating system files and data.

Selecting a Virtual Disk Type
You can create a virtual disk, use an existing virtual disk, or create Raw Device Mappings (RDMs), which give
your virtual disk direct access to SAN. A virtual disk comprises one or more files on the file system that appear
as a single hard disk to the guest operating system. These disks are portable among hosts.

You use the Create Virtual Machine wizard to add virtual disks during virtual machine creation. To add disks
later, select the Do Not Create Disk option and use the Add Hardware wizard in the Virtual Machine Properties
dialog box.

NOTE   You cannot reassign virtual disks to a different controller type.

You can select from the following options:

n Create a Virtual Disk in the vSphere Client on page 36
When you create a virtual disk, you can specify disk properties such as size, format, clustering features,
and more.

n Use an Existing Virtual Disk in the vSphere Client on page 38
You can use an existing disk that is configured with an operating system or other virtual machine data.
This choice allows you to freely move the virtual hard drive from virtual machine to virtual machine.

n Add an RDM Disk to a Virtual Machine in the vSphere Client on page 38
You can store virtual machine data directly on a SAN LUN instead of storing it in a virtual disk file. This
ability is useful if you are running applications in your virtual machines that must detect the physical
characteristics of the storage device. Mapping a SAN LUN allows you to use existing SAN commands
to manage storage for the disk.

Create a Virtual Disk in the vSphere Client
When you create a virtual disk, you can specify disk properties such as size, format, clustering features, and
more.

For detailed information about disk types, see “About Virtual Disk Provisioning Policies,” on page 122.

Procedure

1 On the Create a Disk page of the New Virtual Machine wizard, select the disk size.

You can increase the disk size later or add disks in the Virtual Machine Properties dialog box.

vSphere Virtual Machine Administration

36  VMware, Inc.



2 Select the format for the virtual machine's disks and click Next.

Option Action

Thick Provision Lazy Zeroed Create a virtual disk in a default thick format. Space required for the virtual
disk is allocated during creation. Any data remaining on the physical device
is not erased during creation, but is zeroed out on demand at a later time on
first write from the virtual machine.

Thick Provision Eager Zeroed Create a thick disk that supports clustering features such as Fault Tolerance.
Space required for the virtual disk is allocated at creation time. In contrast to
the flat format, the data remaining on the physical device is zeroed out during
creation. It might take much longer to create disks in this format than to create
other types of disks.

Thin Provision Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.

 
3 Select a location to store the virtual disk files and click Next.

Option Description

Store with the virtual machine Stores the files with the configuration and other virtual machine files. This
option makes file management easier.

Specify a datastore or datastore
cluster

Stores the file separately from other virtual machine files.

 
The Advanced Options page opens.

4 Accept the default or select a different virtual device node.

In most cases, you can accept the default device node. For a hard disk, a nondefault device node is useful
to control the boot order or to have different SCSI controller types. For example, you might want to boot
from an LSI Logic controller and share a data disk with another virtual machine using a BusLogic controller
with bus sharing turned on.

5 (Optional) To change the way disks are affected by snapshots, click Independent and select an option.

Option Description

Independent - Persistent Disks in persistent mode behave like conventional disks on your physical
computer. All data written to a disk in persistent mode are written
permanently to the disk.

Independent - Nonpersistent Changes to disks in nonpersistent mode are discarded when you power off
or reset the virtual machine. With nonpersistent mode, you can restart the
virtual machine with a virtual disk in the same state every time. Changes to
the disk are written to and read from a redo log file that is deleted when you
power off or reset.

 
6 Click Next.

Your changes are recorded and the Ready to Complete page opens.

What to do next

View the selections for your virtual machine on the Ready to Complete page.

Chapter 4 Creating a Virtual Machine in the vSphere Client

VMware, Inc.  37



Use an Existing Virtual Disk in the vSphere Client
You can use an existing disk that is configured with an operating system or other virtual machine data. This
choice allows you to freely move the virtual hard drive from virtual machine to virtual machine.

Procedure

1 On the Select Existing Disk page of the New Virtual Machine wizard, browse for a virtual disk file, click
OK, and click Next.

2 Accept the default or select a different virtual device node.

In most cases, you can accept the default device node. For a hard disk, a nondefault device node is useful
to control the boot order or to have different SCSI controller types. For example, you might want to boot
from an LSI Logic controller and share a data disk with another virtual machine using a BusLogic controller
with bus sharing turned on.

3 (Optional) To change the way disks are affected by snapshots, click Independent and select an option.

Option Description

Independent - Persistent Disks in persistent mode behave like conventional disks on your physical
computer. All data written to a disk in persistent mode are written
permanently to the disk.

Independent - Nonpersistent Changes to disks in nonpersistent mode are discarded when you power off
or reset the virtual machine. With nonpersistent mode, you can restart the
virtual machine with a virtual disk in the same state every time. Changes to
the disk are written to and read from a redo log file that is deleted when you
power off or reset.

 
4 Click Next.

Your changes are recorded and the Ready to Complete page opens.

What to do next

Review the virtual machine configuration.

Add an RDM Disk to a Virtual Machine in the vSphere Client
You can store virtual machine data directly on a SAN LUN instead of storing it in a virtual disk file. This ability
is useful if you are running applications in your virtual machines that must detect the physical characteristics
of the storage device. Mapping a SAN LUN allows you to use existing SAN commands to manage storage for
the disk.

When you map a LUN to a VMFS volume, vCenter Server creates a Raw Device Mapping (RDM) file that
points to the raw LUN. Encapsulating disk information in a file allows vCenter Server to lock the LUN so that
only one virtual machine can write to it at a time. For details about RDM, see the vSphere Storage documentation.

The RDM file has a .vmdk extension, but the file contains only disk information that describes the mapping to
the LUN on the ESXi host. The actual data is stored on the LUN.

You can create the RDM as an initial disk for a new virtual machine or add it to an existing virtual machine.
When you create the RDM, you specify the LUN to be mapped and the datastore on which to put the RDM.

NOTE   You cannot deploy a virtual machine from a template and store its data on a LUN. You can only store
its data in a virtual disk file.
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Procedure

1 On the Select a Disk page of the New Virtual Machine wizard, select Raw Device Mapping and click
Next.

2 From the list of SAN disks or LUNs, select a LUN for your virtual machine to access directly and click
Next.

3 Select a datastore for the LUN mapping file and click Next.

You can place the RDM file on the same datastore where your virtual machine configuration file resides,
or select a different datastore.

NOTE   To use vMotion for virtual machines with enabled NPIV, make sure that the RDM files of the virtual
machines are located on the same datastore. You cannot perform Storage vMotion or vMotion between
datastores when NPIV is enabled.

4 Select a compatibility mode and click Next.

Option Description

Physical Allows the guest operating system to access the hardware directly. Physical
compatibility is useful if you are using SAN-aware applications on the virtual
machine. However, a virtual machine with a physical compatibility RDM
cannot be cloned, made into a template, or migrated if the migration involves
copying the disk.

Virtual Allows the RDM to behave as if it were a virtual disk, so you can use such
features as taking a snapshot, cloning, and so on. When you clone the disk
or make a template from it, the contents of the LUN are copied into
a .vmdk virtual disk file. When you migrate a virtual compatibility mode
RDM, you can migrate the mapping file or copy the contents of the LUN into
a virtual disk.

 
5 Accept the default or select a different virtual device node.

In most cases, you can accept the default device node. For a hard disk, a nondefault device node is useful
to control the boot order or to have different SCSI controller types. For example, you might want to boot
from an LSI Logic controller and share a data disk with another virtual machine using a BusLogic controller
with bus sharing turned on.

6 (Optional) To change the way disks are affected by snapshots, click Independent and select an option.

Option Description

Independent - Persistent Disks in persistent mode behave like conventional disks on your physical
computer. All data written to a disk in persistent mode are written
permanently to the disk.

Independent - Nonpersistent Changes to disks in nonpersistent mode are discarded when you power off
or reset the virtual machine. With nonpersistent mode, you can restart the
virtual machine with a virtual disk in the same state every time. Changes to
the disk are written to and read from a redo log file that is deleted when you
power off or reset.

 
7 Click Next.

Your changes are recorded and the Ready to Complete page opens.

What to do next

Review the virtual machine configuration.
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Complete Virtual Machine Creation in the vSphere Client
The Ready to Complete page lets you review the configuration selections that you made for the virtual machine.
You can change existing settings, configure resources, add hardware, and more.

You can configure additional virtual machine settings before or after completing the wizard.

Procedure

1 On the Ready to Complete page of the New Virtual Machine wizard, review the configuration settings for
the virtual machine.

2 (Optional) Select Edit the virtual machine settings before completion and click Continue.

The Virtual Machine Properties editor opens. After you complete your changes and click Finish, both the
Virtual Machine Properties editor and the New Virtual Machine wizard close. You cannot go back to
review the wizard settings unless you click Cancel.

3 (Optional) Click Cancel to go back and review the wizard settings.

4 Click Finish to complete the creation task and close the wizard.

The virtual machine appears in the vSphere Client Inventory view.

What to do next

Before you can use the new virtual machine, you must partition and format the virtual drive, install a guest
operating system, and install VMware Tools. Typically, the operating system’s installation program handles
partitioning and formatting the virtual drive.

Installing a Guest Operating System
A virtual machine is not complete until you install the guest operating system and VMware Tools. Installing
a guest operating system in your virtual machine is essentially the same as installing it in a physical computer.

The basic steps for a typical operating system are described in this section. See VMware Guest Operating System
Installation on the VMware website for more information about individual guest operating systems.

Using PXE with Virtual Machines
You can start a virtual machine from a network device and remotely install a guest operating system using a
Preboot Execution Environment (PXE). You do not need the operating system installation media. When you
turn on the virtual machine, the virtual machine detects the PXE server.

PXE booting is supported for Guest Operating Systems that are listed in the VMware Guest Operating System
Compatibility list and whose operating system vendor supports PXE booting of the operating system.

The virtual machine must meet the following requirements:

n Have a virtual disk without operating system software and with enough free disk space to store the
intended system software.

n Have a network adapter connected to the network where the PXE server resides.

For details about guest operating system installation, see the  Guest Operating System Installation Guide at 
http://partnerweb.vmware.com/GOSIG/home.html.
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Install a Guest Operating System from Media
You can install a guest operating system from a CD-ROM or from an ISO image. Installing from an ISO image
is typically faster and more convenient than a CD-ROM installation.

Prerequisites

n Verify that the installation ISO image is present on a VMFS datastore or network file system (NFS) volume
accessible to the ESXi host.

n Verify that you have the installation instructions that the operating system vendor provides.

Procedure

1 Open the vSphere Client and log in to the vCenter Server system or host on which the virtual machine
resides.

2 Select an installation method.

Option Action

CD-ROM Insert the installation CD-ROM for your guest operating system into the CD-
ROM drive of your ESXi host.

ISO image a Right-click the virtual machine in the inventory list and select Edit
Settings.

b Click the Hardware tab and select CD/DVD Drive.
c In the Device Type panel, select Datastore ISO File and browse for the

ISO image for your guest operating system.
 

3 Right-click the virtual machine and select Power > Power On.

A green right arrow appears next to the virtual machine icon in the inventory list.

4 Follow the installation instructions that the operating system vendor provides.

What to do next

Install VMware Tools. Installing VMware Tools in the guest operating system is important. Although the guest
operating system can run without VMware Tools, you lose important functionality and convenience without
them. See the Installing and Configuring VMware Tools documentation.
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Working with Templates and Clones in
the vSphere Client 5

A clone is a copy of a virtual machine. A template is a master copy of a virtual machine that can be used to
create many clones.

When you clone a virtual machine, you create a copy of the entire virtual machine, including its settings, any
configured virtual devices, installed software, and other contents of the virtual machine's disks. You also have
the option to use guest operating system customization to change some of the properties of the clone, such as
the computer name and networking settings.

Cloning a virtual machine can save time if you are deploying many similar virtual machines. You can create,
configure, and install software on a single virtual machine, and then clone it multiple times, rather than creating
and configuring each virtual machine individually.

If you create a virtual machine that you want to clone frequently, make that virtual machine a template. A
template is a master copy of a virtual machine that can be used to create and provision virtual machines.
Templates cannot be powered on or edited, and are more difficult to alter than ordinary virtual machine. A
template offers a more secure way of preserving a virtual machine configuration that you want to deploy many
times.

When you clone a virtual machine or deploy a virtual machine from a template, the resulting cloned virtual
machine is independent of the original virtual machine or template. Changes to the original virtual machine
or template are not reflected in the cloned virtual machine, and changes to the cloned virtual machine are not
reflected in the original virtual machine or template.

This chapter includes the following topics:

n “Clone a Virtual Machine in the vSphere Client,” on page 44

n “Create a Scheduled Task to Clone a Virtual Machine in the vSphere Client,” on page 46

n “Create a Template in the vSphere Client,” on page 47

n “Deploy a Virtual Machine from a Template in the vSphere Client,” on page 50

n “Change Template Software or Virtual Machine Configuration,” on page 53

n “Change Template Name in the vSphere Client,” on page 53

n “Deleting Templates,” on page 53

n “Convert a Template to a Virtual Machine in the vSphere Client,” on page 55

n “Customizing Guest Operating Systems,” on page 55
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Clone a Virtual Machine in the vSphere Client
Cloning a virtual machine creates a duplicate of the virtual machine with the same configuration and installed
software as the original.

Optionally, you can customize the guest operating system of the clone to change the virtual machine name,
network settings, and other properties. This prevents conflicts that can occur if a virtual machine and a clone
with identical guest operating system settings are deployed simultaneously.

Prerequisites

n You must be connected to vCenter Server in order to clone a virtual machine. You cannot clone virtual
machines if you connect directly to an ESXi host.

n To customize the guest operating system of the virtual machine, check that your guest operating system
meets the requirements for customization. See “Guest Operating System Customization Requirements,”
on page 55.

n To use a customization specification, you must first create or import the customization specification.

n To use a custom script to generate the host name or IP address for the new virtual machine, configure the
script. See “Configure a Script to Generate Computer Names and IP Addresses During Guest Operating
System Customization in the vSphere Client,” on page 56.

Procedure

1 Right-click the virtual machine and select Clone.

2 Enter a virtual machine name, select a location, and click Next.

3 Select a host or cluster on which to run the new virtual machine.

Option Action

Run the virtual machine on a
standalone host.

Select the host and click Next.

Run the virtual machine in a cluster
with DRS automatic placement.

Select the cluster and click Next.

Run the virtual machine in a cluster
without DRS automatic placement.

a Select the cluster and click Next.
b Select a host within the cluster and click Next.

 
4 Select a resource pool in which to run the virtual machine and click Next.
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5 Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the
same location on a datastore.

a (Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

b Select a datastore and click Next.

Store all virtual machine files in the
same datastore cluster.

a (Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

b Select a datastore cluster.
c (Optional) If you do not want to use Storage DRS with this virtual

machine, select Disable Storage DRS for this virtual machine and select
a datastore within the datastore cluster.

d Click Next.

Store virtual machine configuration
files and disks in separate locations.

a Click Advanced.
b For the virtual machine configuration file and for each virtual disk, click

Browse and select a datastore or datastore cluster.
c (Optional) Apply a virtual machine storage profile from the VM Storage

Profile drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

d (Optional) If you selected a datastore cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the datastore cluster.

e Click Next.
 

6 Select the format for the virtual machine's disks and click Next.

Option Action

Same format as source Use the same format as the source virtual machine.

Thick Provision Lazy Zeroed Create a virtual disk in a default thick format. Space required for the virtual
disk is allocated during creation. Any data remaining on the physical device
is not erased during creation, but is zeroed out on demand at a later time on
first write from the virtual machine.

Thick Provision Eager Zeroed Create a thick disk that supports clustering features such as Fault Tolerance.
Space required for the virtual disk is allocated at creation time. In contrast to
the flat format, the data remaining on the physical device is zeroed out during
creation. It might take much longer to create disks in this format than to create
other types of disks.

Thin Provision Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.
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7 Select a guest operating system customization option.

Option Description

Do not customize Select Do not customize and click Next.
Does not customize any of the guest operating system settings. All settings
remain identical to those of the source virtual machine.

Customize using the Customization
Wizard

Opens the Customization Wizard so that you can select customization
options for the guest operating system.
Select this option and click Next to launch the Customization Wizard.
n To customize a Linux guest operating system, see “Customize Linux

During Cloning or Deployment in the vSphere Client,” on page 59.
n To customize a Windows guest operating system, see “Customize

Windows During Cloning or Deployment in the vSphere Client,” on
page 57.

Customize using an existing
customization specification

Uses the settings in a saved customization specification to customize the
guest operating system.
a Select Customize using an existing customization specification.
b Select the customization specification that you want to use.
c (Optional) Select Use the Customization Wizard to temporarily adjust

the specification before deployment if you want to make changes to the
specification for this deployment only.

d Click Next.
 

8 Review your selections and select whether to power on the virtual machine or edit virtual machine settings.

Option Action

Power on this virtual machine after
creation

Select this option and click Finish.
The virtual machine powers on after the deployment task completes.

Edit virtual hardware a Select this option and click Continue.
b In the Virtual Machine Properties dialog box, make any changes and click

OK.

Show all storage recommendations This option appears only when the virtual machine disks are stored on a
datastore cluster and Storage DRS is enabled.
When you select this option, the Virtual Machine Storage Placement
Recommendations dialog box appears when you click Continue. The dialog
box lists the datastores in the datastore cluster that are recommended for
virtual machine placement.

Edit Storage DRS rules This option appears only when the virtual machine disks are stored on a
datastore cluster.
This option is selected when you select Edit virtual hardware. You can edit
Storage DRS rules on the Options tab of the Virtual Machine Properties
dialog box.
When you select the Edit Storage DRS rules check box, the Storage DRS rules
dialog box appears when you click Continue.

 
The cloned virtual machine is deployed. You cannot use or edit the virtual machine until the cloning is
complete. This might take several minutes if the cloning involves creating a virtual disk. You can cancel the
cloning at any point before the customization stage.

Create a Scheduled Task to Clone a Virtual Machine in the vSphere
Client

This procedure creates a scheduled task to clone a virtual machine.

Procedure

1 Start the vSphere Client, and log in to the vCenter Server system.
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2 From the Home page, click Scheduled Tasks.

3 Select File > New > Scheduled Task, or click New.

The Select a Task to Schedule dialog box appears.

4 Select Clone a virtual machine from the drop-down menu, and click OK.

The Clone Virtual Machine wizard appears.

5 Select the virtual machine to clone and click Next.

6 Follow the wizard through the same steps as those in the previous task in which you cloned a virtual
machine.

7 Enter a name and a task description in the text box.

8 Select the frequency of the task.

9 Select Now or Later. If later, enter the time and date when you want the virtual machine to be deployed,
and click Next.

To see the calendar, click Later, and click the drop-down arrow to select a date from the calendar. A red
circle indicates today’s date, and a dark circle indicates the scheduled date.

10 Review the information on the Ready to Complete New Virtual Machine page, and click Finish.

Optionally, you can select the check box to power on the new virtual machine after it is created.

vCenter Server adds the new task to the scheduled task list and completes it at the designated time. When
it is time to perform the task, vCenter Server first verifies that the user who created the task still has
permission to complete the task. If the permission levels are not acceptable, vCenter Server sends a
message to the log and the task is not performed.

Create a Template in the vSphere Client
Create a template to create a master image of a virtual machine from which you can deploy many virtual
machines.

You can create a template by converting a virtual machine to a template, cloning a virtual machine to a template,
or cloning another template.

Convert a Virtual Machine to a Template in the vSphere Client
You can convert a virtual machine directly to a template instead of making a copy by cloning.

When you convert a virtual machine to a template, you cannot edit or power on the template unless you convert
it back to a virtual machine.

Prerequisites

n You must be connected to vCenter Server to convert a virtual machine to a template. You cannot create
templates if you connect the vSphere Client directly to an ESXi host.

n Before you convert a virtual machine to a template, select it in the inventory and power it off.

Procedure

u Right-click the virtual machine and select Template > Convert to Template.

vCenter Server marks that virtual machine as a template and displays the task in the Recent Tasks pane.
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Clone Virtual Machine to Template in the vSphere Client
Cloning a virtual machine to a template creates a template copy of the virtual machine while leaving the original
virtual machine in place.

Prerequisites

You must be connected to vCenter Server to clone a virtual machine to a template. You cannot create templates
if you connect directly to an ESXi host.

Procedure

1 Right-click the virtual machine and select Template > Clone to Template.

2 Give the new template a name, select its inventory location, and click Next.

3 Pass through the target location page and click Next.

4 Specify in which format to store the template’s virtual disks and click Next.

Option Action

Same format as source Use the same format as the source virtual machine.

Thick Provision Lazy Zeroed Create a virtual disk in a default thick format. Space required for the virtual
disk is allocated during creation. Any data remaining on the physical device
is not erased during creation, but is zeroed out on demand at a later time on
first write from the virtual machine.

Thick Provision Eager Zeroed Create a thick disk that supports clustering features such as Fault Tolerance.
Space required for the virtual disk is allocated at creation time. In contrast to
the flat format, the data remaining on the physical device is zeroed out during
creation. It might take much longer to create disks in this format than to create
other types of disks.

Thin Provision Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.
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5 Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the
same location on a datastore.

a (Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

b Select a datastore and click Next.

Store all virtual machine files in the
same datastore cluster.

a (Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

b Select a datastore cluster.
c (Optional) If you do not want to use Storage DRS with this virtual

machine, select Disable Storage DRS for this virtual machine and select
a datastore within the datastore cluster.

d Click Next.

Store virtual machine configuration
files and disks in separate locations.

a Click Advanced.
b For the virtual machine configuration file and for each virtual disk, click

Browse and select a datastore or datastore cluster.
c (Optional) Apply a virtual machine storage profile from the VM Storage

Profile drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

d (Optional) If you selected a datastore cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the datastore cluster.

e Click Next.
 

6 Click Finish.

vCenter Server displays the Tasks inventory panel for reference and adds the cloned template to the list
in the information panel.

Clone a Template in the vSphere Client
Clone a template to create a copy of it.

Prerequisites

You must be connected to vCenter Server to clone a template. You cannot create templates if you connect
directly to an ESXi host.

Procedure

1 Right-click the template and select Clone.

2 Give the new template a unique name and description and click Next.

3 Select the host or cluster and click Next.

4 Select a datastore for the template and click Next.
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5 Specify in which format to store the template’s virtual disks.

Option Action

Same format as source Use the same format as the source virtual machine.

Thick Provision Lazy Zeroed Create a virtual disk in a default thick format. Space required for the virtual
disk is allocated during creation. Any data remaining on the physical device
is not erased during creation, but is zeroed out on demand at a later time on
first write from the virtual machine.

Thick Provision Eager Zeroed Create a thick disk that supports clustering features such as Fault Tolerance.
Space required for the virtual disk is allocated at creation time. In contrast to
the flat format, the data remaining on the physical device is zeroed out during
creation. It might take much longer to create disks in this format than to create
other types of disks.

Thin Provision Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.

 
6 Click Next.

7 Review the information for the template and click Finish.

You cannot use the new template until the cloning task completes.

vCenter Server adds the cloned template to the list in the Virtual Machines tab.

Deploy a Virtual Machine from a Template in the vSphere Client
Deploying a virtual machine from a template creates a new virtual machine that is a copy of the template. The
new virtual machine has the virtual hardware, installed software, and other properties configured for the
template.

Prerequisites

n Verify that you are connected to vCenter Server. You cannot work with templates if you connect the
vSphere Client directly to an ESXi host.

n You must be connected to vCenter Server to deploy a virtual machine from a template. You cannot deploy
from a template if you connect the vSphere Client directly to an ESXi host.

n To customize the guest operating system of the virtual machine, check that your guest operating system
meets the requirements for customization. See “Guest Operating System Customization Requirements,”
on page 55.

n To use a customization specification, you must first create or import the customization specification.

Procedure

1 Right-click the template, and select Deploy Virtual Machine from this Template.

2 Enter a virtual machine name, select a location, and click Next.

3 Select a host or cluster on which to run the new virtual machine.

Option Action

Run the virtual machine on a
standalone host.

Select the host and click Next.

Run the virtual machine in a cluster
with DRS automatic placement.

Select the cluster and click Next.

Run the virtual machine in a cluster
without DRS automatic placement.

a Select the cluster and click Next.
b Select a host within the cluster and click Next.
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4 Select a resource pool in which to run the virtual machine and click Next.

5 Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the
same location on a datastore.

a (Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

b Select a datastore and click Next.

Store all virtual machine files in the
same datastore cluster.

a (Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

b Select a datastore cluster.
c (Optional) If you do not want to use Storage DRS with this virtual

machine, select Disable Storage DRS for this virtual machine and select
a datastore within the datastore cluster.

d Click Next.

Store virtual machine configuration
files and disks in separate locations.

a Click Advanced.
b For the virtual machine configuration file and for each virtual disk, click

Browse and select a datastore or datastore cluster.
c (Optional) Apply a virtual machine storage profile from the VM Storage

Profile drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

d (Optional) If you selected a datastore cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the datastore cluster.

e Click Next.
 

6 Select the format for the virtual machine's disks and click Next.

Option Action

Same format as source Use the same format as the source virtual machine.

Thick Provision Lazy Zeroed Create a virtual disk in a default thick format. Space required for the virtual
disk is allocated during creation. Any data remaining on the physical device
is not erased during creation, but is zeroed out on demand at a later time on
first write from the virtual machine.

Thick Provision Eager Zeroed Create a thick disk that supports clustering features such as Fault Tolerance.
Space required for the virtual disk is allocated at creation time. In contrast to
the flat format, the data remaining on the physical device is zeroed out during
creation. It might take much longer to create disks in this format than to create
other types of disks.

Thin Provision Use the thin provisioned format. At first, a thin provisioned disk uses only
as much datastore space as the disk initially needs. If the thin disk needs more
space later, it can grow to the maximum capacity allocated to it.

 

Chapter 5 Working with Templates and Clones in the vSphere Client

VMware, Inc.  51



7 Select a guest operating system customization option.

Option Description

Do not customize Select Do not customize and click Next.
Does not customize any of the guest operating system settings. All settings
remain identical to those of the source virtual machine.

Customize using the Customization
Wizard

Opens the Customization Wizard so that you can select customization
options for the guest operating system.
Select this option and click Next to launch the Customization Wizard.
n To customize a Linux guest operating system, see “Customize Linux

During Cloning or Deployment in the vSphere Client,” on page 59.
n To customize a Windows guest operating system, see “Customize

Windows During Cloning or Deployment in the vSphere Client,” on
page 57.

Customize using an existing
customization specification

Uses the settings in a saved customization specification to customize the
guest operating system.
a Select Customize using an existing customization specification.
b Select the customization specification that you want to use.
c (Optional) Select Use the Customization Wizard to temporarily adjust

the specification before deployment if you want to make changes to the
specification for this deployment only.

d Click Next.
 

8 Review your selections and select whether to power on the virtual machine or edit virtual machine settings.

Option Action

Power on this virtual machine after
creation

Select this option and click Finish.
The virtual machine powers on after the deployment task completes.

Edit virtual hardware a Select this option and click Continue.
b In the Virtual Machine Properties dialog box, make any changes and click

OK.

Show all storage recommendations This option appears only when the virtual machine disks are stored on a
datastore cluster and Storage DRS is enabled.
When you select this option, the Virtual Machine Storage Placement
Recommendations dialog box appears when you click Continue. The dialog
box lists the datastores in the datastore cluster that are recommended for
virtual machine placement.

Edit Storage DRS rules This option appears only when the virtual machine disks are stored on a
datastore cluster.
This option is selected when you select Edit virtual hardware. You can edit
Storage DRS rules on the Options tab of the Virtual Machine Properties
dialog box.
When you select the Edit Storage DRS rules check box, the Storage DRS rules
dialog box appears when you click Continue.

 
The virtual machine is deployed. You cannot use or edit the virtual machine until the deployment is complete.
This might take several minutes if the deployment involves creating a virtual disk.
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Change Template Software or Virtual Machine Configuration
To change the virtual hardware or virtual machine options in a template, or to upgrade an application, you
must convert the template to a virtual machine. After you have edited the virtual machine, convert it back to
a template.

Prerequisites

Verify that you are connected to vCenter Server. You cannot work with templates if you connect the vSphere
Client directly to an ESXi host.

Procedure

1 Convert the template to a virtual machine.

2 Edit the virtual machine.

3 Convert the virtual machine to a template.

Change Template Name in the vSphere Client
Unlike other changes to templates, you do not have to convert a template to a virtual machine to change the
name of a template.

Prerequisites

Verify that you are connected to vCenter Server. You cannot work with templates if you connect the vSphere
Client directly to an ESXi host.

Procedure

1 Right-click the template and select Rename.

2 Enter a new name and click outside the field to save your changes.

Deleting Templates
You can delete a template by removing it from the inventory or deleting the template from the disk. If you
remove the template from the inventory, it remains on the disk and can be reregistered with vCenter Server
to restore it to the inventory.

n Remove Templates from the Inventory in the vSphere Client on page 54
If you remove a template from the inventory, it is unregistered from the vCenter Server inventory, but
it is not removed from the datastore.

n Delete a Template from the Disk in the vSphere Client on page 54
Deleted templates are permanently removed from the system.

n Reregister Templates in the vSphere Client on page 54
Templates can become unregistered from the vCenter Server if they are removed from the inventory or
if the hosts with which they are associated are removed from the vCenter Server and then readded.
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Remove Templates from the Inventory in the vSphere Client
If you remove a template from the inventory, it is unregistered from the vCenter Server inventory, but it is not
removed from the datastore.

Prerequisites

You must be connected to vCenter Server to remove a template from the inventory. You cannot work with
templates if you connect directly to an ESXi host.

Procedure

1 Right-click the template, and select Remove from Inventory.

2 Click OK to confirm removing the template from the vCenter Server database.

The template is unregistered from the vCenter Server inventory.

Delete a Template from the Disk in the vSphere Client
Deleted templates are permanently removed from the system.

Prerequisites

You must be connected to vCenter Server to delete a template. You cannot work with templates if you connect
the vSphere Client directly to an ESXi host.

Procedure

1 Right-click the template, and select Delete from Disk.

2 Click OK to confirm removing the template from the datastore.

The template is deleted from the disk and cannot be recovered.

Reregister Templates in the vSphere Client
Templates can become unregistered from the vCenter Server if they are removed from the inventory or if the
hosts with which they are associated are removed from the vCenter Server and then readded.

Procedure

1 Start the vSphere client, and log in to the vCenter Server system.

2 From the Home page, click VMs and Templates.

3 Right-click the datastore that contains the template and select Browse Datastore.

4 Browse through the datastore folders to find the .vmtx file.

5 Right-click the .vmtx file and select Add to Inventory.

The Add to Inventory wizard appears.

6 Enter a template machine name, select a location, and click Next.

If you want the template to retain its original name, do not enter a name in the Add to Inventory wizard.
vCenter Server will use the original name if the field in the wizard is left blank.

7 Select a host or cluster on which to store the template, and click Next.

8 Review your selections, and click Finish.

The template is registered to the host. You can view the template from the host’s Virtual Machine tab.
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Convert a Template to a Virtual Machine in the vSphere Client
Converting a template to a virtual machine changes the template rather than making a copy. You can convert
a template to a virtual machine to edit the template. You might also convert a template to a virtual machine if
you no longer need to preserve it as a master image for deploying virtual machines.

Prerequisites

You must be connected to vCenter Server to convert a template to a virtual machine. You cannot work with
templates if you connect directly to an ESXi host.

Procedure

1 Right-click the template and select Convert to Virtual Machine.

2 Select the host or cluster on which to run the virtual machine.

Option Action

Run the virtual machine on a
standalone host.

Select the host and click Next.

Run the virtual machine in a cluster
with DRS automatic placement.

Select the cluster and click Next.

Run the virtual machine in a cluster
without DRS automatic placement.

a Select the cluster and click Next.
b Select a host within the cluster and click Next.

 
If the template resides on a legacy VMFS2 datastore, you must select the host on which the template was
created as the destination for the virtual machine.

3 Select a resource pool in which to run the virtual machine and click Next.

4 Review your selections and click Finish.

Customizing Guest Operating Systems
When you clone a virtual machine or deploy a virtual machine from a template, you can customize the guest
operating system of the virtual machine to change properties such as the computer name, network settings,
and license settings.

Customizing guest operating systems can help prevent conflicts that can result if virtual machines with
identical settings are deployed, such as conflicts due to duplicate computer names.

You can specify the customization settings by choosing to launch the Guest Customization wizard during the
cloning or deployment process. Alternatively, you can create customization specifications, which are
customization settings stored in the vCenter Server database. During the cloning or deployment process, you
can select a customization specification to apply to the new virtual machine.

Use the Customization Specification Manager to manage customization specifications you create with the
Guest Customization wizard.

Guest Operating System Customization Requirements
To customize the guest operating system, you must configure the virtual machine and guest to meet VMware
Tools and virtual disk requirements. Other requirements apply, depending on the guest operating system type.

VMware Tools Requirements
The current version of VMware Tools must be installed on the virtual machine or template to customize the
guest operating system during cloning or deployment.
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Virtual Disk Requirements
The guest operating system being customized must be installed on a disk attached as SCSI node 0:0 in the
virtual machine configuration.

Windows Requirements
Customization of Windows guest operating systems requires the following conditions:

n The ESXi host that the virtual machine is running on must be 3.5 or later.

Guest operating system customization is supported on multiple Windows operating systems.

Linux Requirements
Customization of Linux guest operating systems requires that Perl is installed in the Linux guest operating
system.

Guest operating system customization is supported on multiple Linux distributions.

Verifying Customization Support for a Guest Operating System
To verify customization support for Windows operating systems or Linux distributions and compatible
ESXi hosts, see the VMware Compatibility Guide at VMware.com. You can use this online tool to search for the
guest operating system and ESXi version. After the tool generates your list, click the guest operating system
to see whether guest customization is supported.

Configure a Script to Generate Computer Names and IP Addresses During Guest
Operating System Customization in the vSphere Client

As an alternative to entering the computer name or IP addresses for virtual NICs during guest operating system
customization, you can create a custom application and configure it so that vCenter Server can use it to generate
the computer name and IP addresses.

The application can be an arbitrary executable binary or script file appropriate for the corresponding operating
system in which vCenter Server is running. After you configure a name-ip-generation application in vCenter
Server, each time you initiate a guest os customization for a virtual machine, the name-ip-app is executed and
an XML string is generated in place and passed to its standard input. The name-ip-generation application on
its behalf should generate and return the resulting XML string through its standard output.

The application must comply with the reference XML file in the VMware knowledge base article at 
http://kb.vmware.com/kb/2007557.

Prerequisites

Verify that Perl is installed on vCenter Server.

Procedure

1 Create the script and save it on the vCenter Server system's local disk.

2 In the vSphere Client connected to vCenter Server, select Administration > vCenter Server Settings.

3 Select Advanced Settings.

4 Enter the configuration parameters for the script.

a In the Key text box, type config.guestcust.name-ip-generator.arg1.

b In the Value text box, type c:\sample-generate-name-ip.pl and clickAdd.

c In the Key text box, type config.guestcust.name-ip-generator.arg2.
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d In the Value text box, type the path to the script file on the vCenter Server system and click Add. For
example, type c:\sample-generate-name-ip.pl.

e In the Key text box, type config.guestcust.name-ip-generator.program.

f In the Value text box, type c:\perl\bin\perl.exe and click Add.

5 Click OK.

You can select the option to use an application to generate computer names or IP addresses during
customization.

Customize Windows During Cloning or Deployment in the vSphere Client
When you deploy a new virtual machine from a template or clone an existing virtual machine, you can
customize Windows guest operating systems for the virtual machine.

NOTE   The default administrator password is not preserved for Windows Server 2008 after customization.
During customization, the Windows Sysprep utility deletes and recreates the administrator account on
Windows Server 2008. You must reset the administrator password when the virtual machine boots the first
time after customization.

Prerequisites

Verify that all requirements for customization are met. See “Guest Operating System Customization
Requirements,” on page 55.

Procedure

1 On the Guest Customization page of the Clone Virtual Machine wizard, select Customize using the
Customization Wizard and click Next.

2 Type the virtual machine owner’s name and organization and click Next.

3 Enter the guest operating system's computer name and click Next.

The operating system uses this name to identify itself on the network. On Linux systems, it is called the
host name.

Option Action

Enter a name a Type a name.

The name can contain alphanumeric characters and the hyphen (-)
character. It cannot contain periods (.) or blank spaces and cannot be
made up of digits only. Names are case-insensitive.

b (Optional) To ensure that the name is unique, select Append a numeric
value to ensure uniqueness. This appends a hyphen followed by a
numeric value to the virtual machine name. The name is truncated if it
exceeds 15 characters when combined with the numeric value.

Use the virtual machine name The computer name that vCenter Server creates is identical to the name of
the virtual machine on which the guest operating system is running. If the
name exceeds 15 characters, it is truncated.

Enter a name in the Deploy wizard The vSphere Client prompts you to enter a name after the cloning or
deployment is complete.

Generate a name using the custom
application configured with vCenter
Server

Enter a parameter that can be passed to the custom application.
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4 Provide licensing information for the Windows operating system and click Next.

Option Action

For non-server operating systems Type the Windows product key for the new guest operating system.

For server operating systems a Type the Windows product key for the new guest operating system.
b Select Include Server License Information.
c Select either Per seat or Per server.
d (Optional) If you selected Per server, enter the maximum number of

simultaneous connections for the server to accept.
 

5 Configure the administrator password for the virtual machine and click Next.

a Type a password for the administrator account and confirm the password by typing it again.

NOTE   You can change the administrator password only if the administrator password on the source
Windows virtual machine is blank. If the source Windows virtual machine or template already has a
password, the administrator password does not change.

b (Optional) To log users into the guest operating system as Administrator, select the check box, and
select the number of times to log in automatically.

6 Select the time zone for the virtual machine and click Next.

7 (Optional) On the Run Once page, specify commands to run the first time a user logs into the guest
operating system and click Next.

See the Microsoft Sysprep documentation for more information on Run Once commands.

8 Select the type of network settings to apply to the guest operating system.

Option Action

Typical settings Select Typical settings and click Next.
vCenter Server configures all network interfaces from a DHCP server using
default settings.

Custom settings a Select Custom settings and click Next.
b For each network interface in the virtual machine, click the ellipsis button

(...) to open the Network Properties dialog box.
c Enter IP address and other network settings and click OK.
d When all network interfaces are configured, click Next.

 
9 Select how the virtual machine will participate in the network and click Next.

Option Action

Workgroup Type a workgroup name. For example, MSHOME.

Windows Server Domain a Type the domain name.
b Type the user name and password for a user account that has permission

to add a computer to the specified domain.
 

10 (Optional) Select Generate New Security ID (SID) and click Next.

A Windows Security ID (SID) is used in some Windows operating systems to uniquely identify systems
and users. If you do not select this option, the new virtual machine has the same SID as the virtual machine
or template from which it was cloned or deployed.

Duplicate SIDs do not cause problems when the computers are part of a domain and only domain user
accounts are used. However, if the computers are part of a Workgroup or local user accounts are used,
duplicate SIDs can compromise file access controls. For more information, see the documentation for your
Microsoft Windows operating system.
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11 Save the customized options as an .xml file.

a Select Save this customization specification for later use.

b Specify the filename for the specification and click Next.

12 Click Finish to save your changes.

You return to the Deploy Template or Clone Virtual Machine wizard. The customization is carried out after
you complete the Deploy Template or Clone Virtual Machine wizard.

When the new virtual machine boots for the first time, the guest operating system runs finalization scripts to
complete the customization process. The virtual machine might reboot a number of times during this process.

If the guest operating system pauses when the new virtual machine boots, it might be waiting for you to correct
errors, such as an incorrect product key or invalid user name. Open the virtual machine’s console to determine
whether the system is waiting for information.

What to do next

After you deploy and customize versions of Windows XP or Windows 2003 that are not volume licensed, you
might need to reactivate your operating system on the new virtual machine.

If the new virtual machine encounters customization errors while it is booting, the errors are logged to %WINDIR
%\temp\vmware-imc. To view the error log file, click the Windows Start button and select Programs >
Administrative Tools > Event Viewer.

Customize Linux During Cloning or Deployment in the vSphere Client
In the process of deploying a new virtual machine from a template or cloning an existing virtual machine, you
can customize Linux guest operating systems for the virtual machine.

Prerequisites

Ensure that all requirements for customization are met. See “Guest Operating System Customization
Requirements,” on page 55.

Procedure

1 On the Guest Customization page of the Clone Virtual Machine wizard, select Customize using the
Customization Wizard and click Next.

2 Specify how to determine the host name to identify the guest operating system on the network.

Option Action

Enter a name a Type a name.

The name can contain alphanumeric characters and the hyphen (-)
character. It cannot contain periods (.) or blank spaces and cannot be
made up of digits only. Names are case-insensitive.

b (Optional) To ensure that the name is unique, select Append a numeric
value to ensure uniqueness. This appends a hyphen followed by a
numeric value to the virtual machine name. The name is truncated if it
exceeds 15 characters when combined with the numeric value.

Use the virtual machine name The computer name that vCenter Server creates is identical to the name of
the virtual machine on which the guest operating system is running. If the
name exceeds 15 characters, it is truncated.

Enter a name in the Deploy wizard The vSphere Client prompts you to enter a name after the cloning or
deployment is complete.

Generate a name using the custom
application configured with vCenter
Server

Enter a parameter that can be passed to the custom application.
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3 Enter the Domain Name for the computer and click Next.

4 Select the time zone for the virtual machine and click Next.

5 Select the type of network settings to apply to the guest operating system.

Option Action

Typical settings Select Typical settings and click Next.
vCenter Server configures all network interfaces from a DHCP server using
default settings.

Custom settings a Select Custom settings and click Next.
b For each network interface in the virtual machine, click the ellipsis button

(...) to open the Network Properties dialog box.
c Enter IP address and other network settings and click OK.
d When all network interfaces are configured, click Next.

 
6 Enter DNS and domain settings.

7 Save the customized options as an .xml file.

a Select Save this customization specification for later use.

b Specify the filename for the specification and click Next.

8 Click Finish to save your changes.

You return to the Deploy Template or Clone Virtual Machine wizard. The customization is carried out after
you complete the Deploy Template or Clone Virtual Machine wizard.

When the new virtual machine boots for the first time, the guest operating system runs finalization scripts to
complete the customization process. The virtual machine might reboot a number of times during this process.

If the guest operating system pauses when the new virtual machine boots, it might be waiting for you to correct
errors, such as an incorrect product key or invalid user name. Open the virtual machine’s console to determine
whether the system is waiting for information.

What to do next

If the new virtual machine encounters customization errors while it is booting, the errors are reported using
the guest’s system logging mechanism. View the errors by opening /var/log/vmware-
imc/toolsDeployPkg.log.

Managing Customization Specifications in the vSphere Client
Customization specifications are XML files that contain guest operating system settings for virtual machines.
You create customization specifications with the Guest Customization wizard, and manage specifications
using the Customization Specification Manager.

vCenter Server saves the customized configuration parameters in the vCenter Server database. If the
customization settings are saved, the administrator, and domain administrator, passwords are stored in
encrypted format in the database. Because the certificate used to encrypt the passwords is unique to each
vCenter Server system, reinstalling vCenter Server, or attaching a new instance of the server the database,
invalidates the encrypted passwords. The passwords must be re-entered before they can be used.
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Create a Customization Specification for Linux in the vSphere Client
Use the Guest Customization wizard to save guest operating system settings in a specification that you can
apply when cloning virtual machines or deploying from templates.

Prerequisites

Ensure that all requirements for customization are met. See “Guest Operating System Customization
Requirements,” on page 55.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Click New.

3 Select Linux from the Target Virtual Machine OS menu.

4 Under Customization Specification Information, enter a name for the specification and an optional
description and click Next.

5 Specify how to determine the host name to identify the guest operating system on the network.

Option Action

Enter a name a Type a name.

The name can contain alphanumeric characters and the hyphen (-)
character. It cannot contain periods (.) or blank spaces and cannot be
made up of digits only. Names are case-insensitive.

b (Optional) To ensure that the name is unique, select Append a numeric
value to ensure uniqueness. This appends a hyphen followed by a
numeric value to the virtual machine name. The name is truncated if it
exceeds 15 characters when combined with the numeric value.

Use the virtual machine name The computer name that vCenter Server creates is identical to the name of
the virtual machine on which the guest operating system is running. If the
name exceeds 15 characters, it is truncated.

Enter a name in the Deploy wizard The vSphere Client prompts you to enter a name after the cloning or
deployment is complete.

Generate a name using the custom
application configured with vCenter
Server

Enter a parameter that can be passed to the custom application.

 
6 Enter the Domain Name for the computer and click Next.

7 Select the time zone for the virtual machine and click Next.

8 Select the type of network settings to apply to the guest operating system.

Option Action

Typical settings Select Typical settings and click Next.
vCenter Server configures all network interfaces from a DHCP server using
default settings.

Custom settings a Select Custom settings and click Next.
b For each network interface in the virtual machine, click the ellipsis button

(...) to open the Network Properties dialog box.
c Enter IP address and other network settings and click OK.
d When all network interfaces are configured, click Next.

 
9 Enter DNS and domain settings.

10 Click Finish to save your changes.
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The customization specification you created is listed in the Customization Specification Manager, and can be
used to customize virtual machine guest operating systems.

Create a Customization Specification for Windows in the vSphere Client
Use the Guest Customization wizard to save Windows guest operating system settings in a specification that
you can apply when cloning virtual machines or deploying from templates.

NOTE   The default administrator password is not preserved for Windows Server 2008 after customization.
During customization, the Windows Sysprep utility deletes and recreates the administrator account on
Windows Server 2008. You must reset the administrator password when the virtual machine boots the first
time after customization.

Prerequisites

Ensure that all requirements for customization are met. See “Guest Operating System Customization
Requirements,” on page 55.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Click New.

3 In the Guest Customization wizard, select Windows from the Target Virtual Machine OS menu.

4 Under Customization Specification Information, enter a name for the specification and an optional
description and click Next.

5 Type the virtual machine owner’s name and organization and click Next.

6 Enter the guest operating system's computer name and click Next.

The operating system uses this name to identify itself on the network. On Linux systems, it is called the
host name.

Option Action

Enter a name a Type a name.

The name can contain alphanumeric characters and the hyphen (-)
character. It cannot contain periods (.) or blank spaces and cannot be
made up of digits only. Names are case-insensitive.

b (Optional) To ensure that the name is unique, select Append a numeric
value to ensure uniqueness. This appends a hyphen followed by a
numeric value to the virtual machine name. The name is truncated if it
exceeds 15 characters when combined with the numeric value.

Use the virtual machine name The computer name that vCenter Server creates is identical to the name of
the virtual machine on which the guest operating system is running. If the
name exceeds 15 characters, it is truncated.

Enter a name in the Deploy wizard The vSphere Client prompts you to enter a name after the cloning or
deployment is complete.

Generate a name using the custom
application configured with vCenter
Server

Enter a parameter that can be passed to the custom application.
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7 Provide licensing information for the Windows operating system and click Next.

Option Action

For non-server operating systems Type the Windows product key for the new guest operating system.

For server operating systems a Type the Windows product key for the new guest operating system.
b Select Include Server License Information.
c Select either Per seat or Per server.
d (Optional) If you selected Per server, enter the maximum number of

simultaneous connections for the server to accept.
 

8 Configure the administrator password for the virtual machine and click Next.

a Type a password for the administrator account and confirm the password by typing it again.

NOTE   You can change the administrator password only if the administrator password on the source
Windows virtual machine is blank. If the source Windows virtual machine or template already has a
password, the administrator password does not change.

b (Optional) To log users into the guest operating system as Administrator, select the check box, and
select the number of times to log in automatically.

9 Select the time zone for the virtual machine and click Next.

10 (Optional) On the Run Once page, specify commands to run the first time a user logs into the guest
operating system and click Next.

See the Microsoft Sysprep documentation for more information on Run Once commands.

11 Select the type of network settings to apply to the guest operating system.

Option Action

Typical settings Select Typical settings and click Next.
vCenter Server configures all network interfaces from a DHCP server using
default settings.

Custom settings a Select Custom settings and click Next.
b For each network interface in the virtual machine, click the ellipsis button

(...) to open the Network Properties dialog box.
c Enter IP address and other network settings and click OK.
d When all network interfaces are configured, click Next.

 
12 Select how the virtual machine will participate in the network and click Next.

Option Action

Workgroup Type a workgroup name. For example, MSHOME.

Windows Server Domain a Type the domain name.
b Type the user name and password for a user account that has permission

to add a computer to the specified domain.
 

13 (Optional) Select Generate New Security ID (SID) and click Next.

A Windows Security ID (SID) is used in some Windows operating systems to uniquely identify systems
and users. If you do not select this option, the new virtual machine has the same SID as the virtual machine
or template from which it was cloned or deployed.

Duplicate SIDs do not cause problems when the computers are part of a domain and only domain user
accounts are used. However, if the computers are part of a Workgroup or local user accounts are used,
duplicate SIDs can compromise file access controls. For more information, see the documentation for your
Microsoft Windows operating system.
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14 Click Finish to save your changes.

The customization specification you created is listed in the Customization Specification Manager, and can be
used to customize virtual machine guest operating systems.

Create a Customization Specification for Windows Using a Custom Sysprep Answer
File in the vSphere Client
A custom sysprep answer file is a file that stores a number of customization settings such as computer name,
licensing information, and workgroup or domain settings. You can supply a custom sysprep answer file as an
alternative to specifying many of the settings in the Guest Customization wizard.

Windows 2000, Windows Server 2003, and Windows XP use a text file called sysprep.inf. Windows Server
2008, Windows Vista, and Windows 7 use an XML file called sysprep.xml. You can create these files using a
text editor, or use the Microsoft Setup Manager utility to generate them. For more information about how to
create a custom sysprep answer file, see the documentation for the relevant operating system.

Prerequisites

Ensure that all requirements for customization are met. See “Guest Operating System Customization
Requirements,” on page 55.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Click New.

3 In the Guest Customization wizard, select Windows from the Target Virtual Machine OS menu.

4 (Optional) Select Use Custom Sysprep Answer File.

5 Under Customization Specification Information, enter a name for the specification and an optional
description and click Next.

6 Select the option to import or create a sysprep answer file and click Next.

Option Description

Import a Sysprep answer file Click Browse and browse to the file.

Create a Sysprep answer file Type the contents of the file in the text box.
 

7 Select the type of network settings to apply to the guest operating system.

Option Action

Typical settings Select Typical settings and click Next.
vCenter Server configures all network interfaces from a DHCP server using
default settings.

Custom settings a Select Custom settings and click Next.
b For each network interface in the virtual machine, click the ellipsis button

(...) to open the Network Properties dialog box.
c Enter IP address and other network settings and click OK.
d When all network interfaces are configured, click Next.

 
8 (Optional) Select Generate New Security ID (SID) and click Next.

A Windows Security ID (SID) is used in some Windows operating systems to uniquely identify systems
and users. If you do not select this option, the new virtual machine has the same SID as the virtual machine
or template from which it was cloned or deployed.
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Duplicate SIDs do not cause problems when the computers are part of a domain and only domain user
accounts are used. However, if the computers are part of a Workgroup or local user accounts are used,
duplicate SIDs can compromise file access controls. For more information, see the documentation for your
Microsoft Windows operating system.

9 Click Finish to save your changes.

The customization specification you created is listed in the Customization Specification Manager, and can be
used to customize virtual machine guest operating systems.

Edit a Customization Specification in the vSphere Client
You can edit existing specifications using the Customization Specification Manager.

Prerequisites

You must have at least one customization specification.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Right-click a specification and select Edit.

3 Proceed through the Guest Customization wizard to change specification settings.

Remove a Customization Specification in the vSphere Client
You can remove customization specifications from the Customization Specification Manager.

Prerequisites

You must have at least one customization specification.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Right-click a specification and select Remove.

3 In the confirmation dialog box, select Yes.

The specification is deleted from the disk.

Copy a Customization Specification in the vSphere Client
You can copy an existing customization specification using the Customization Specification Manager.

Prerequisites

You must have at least one customization specification.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Right-click a specification and select Copy.

A new specification is created, Copy of specification_name.
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Export a Customization Specification in the vSphere Client
You can export customization specifications and save them as .xml files. To apply an exported specification to
a virtual machine, import the .xml file using the Customization Specification Manager.

Prerequisites

You must have at least one customization specification.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Right-click a specification and select Export.

3 In the Save As dialog, enter a file name and location.

4 Click Save.

The specification is saved as an .xml file to the location you specified.

Import a Customization Specification in the vSphere Client
You can import an existing specification using the Customization Specification Manager, and use the
specification to customize the guest operating system of a virtual machine.

Prerequisites

Before you begin, you must have at least one customization specification saved as an xml file located on a file
system accessible from the vSphere Client.

Procedure

1 From the vSphere Client Home page, select Customization Specifications Manager.

2 Click Import.

3 From the Open dialog, browse to the .xml to import and click Open.

The imported specification is added to the list of customization specifications.
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Deploying OVF Templates 6
The VMware vSphere Client (vSphere Client) allows you to deploy and export virtual machines, virtual
appliances, and vApps stored in Open Virtual Machine Format (OVF). An appliance is a pre-configured virtual
machine that typically includes a preinstalled guest operating system and other software.

Deploying an OVF template allows you to add pre-configured virtual machines to your vCenter Server or
ESXi inventory. Deploying an OVF template is similar to deploying a virtual machine from a template.
However, you can deploy an OVF template from any local file system accessible from the vSphere Client
machine, or from a remote web server. The local file systems can include local disks (such as C:), removable
media (such as CDs or USB keychain drives), and shared network drives.

Exporting OVF templates allows you to create virtual appliances that can be imported by other users. You can
use the export function to distribute pre-installed software as a virtual appliance, or as a means of distributing
template virtual machines to users, including users who cannot directly access and use the templates in your
vCenter Server inventory.

This chapter includes the following topics:

n “About OVF,” on page 67

n “Deploy an OVF Template,” on page 68

n “Browse VMware Virtual Appliance Marketplace,” on page 69

n “Export an OVF Template,” on page 70

About OVF
OVF is a file format that allows for exchange of virtual appliances across products and platforms.

The OVF format offers the following advantages:

n OVF files are compressed, allowing for faster downloads.

n The vSphere Client validates an OVF file before importing it, and ensures that it is compatible with the
intended destination server. If the appliance is incompatible with the selected host, it cannot be imported
and an error message appears.

n OVF can encapsulate multi-tiered applications and more than one virtual machine.
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Deploy an OVF Template
You can deploy an OVF template from a local file system accessible to the vSphere Client machine, or from a
web URL.

Procedure

1 In the vSphere Client, select File > Deploy OVF Template.

The Deploy OVF Template wizard appears.

2 Specify the source location and click Next.

Option Action

Deploy from File Browse your file system for an OVF or OVA template.

Deploy from URL Specify a URL to an OVF template located on the internet. Example:
http://vmware.com/VMTN/appliance.ovf

 
3 View the OVF Template Details page and click Next.

4 If license agreements are packaged with the OVF template, the End User License Agreement page appears.
Agree to accept the terms of the licenses and click Next.

5 (Optional) Edit the name and select the folder location within the inventory where the vApp will reside,
and click Next.

NOTE   When the vSphere Client is connected directly to an ESXi host, the option to select the folder location
does not appear.

6 Select the deployment configuration from the drop-down menu and click Next.

The option selected typically controls the memory settings, number of CPUs and reservations, and
application-level configuration parameters.

NOTE   This page appears only if the OVF template contains deployment options.

7 Select the host or cluster on which you want to deploy the OVF template and click Next.

8 Select the host on which you want to run the deployed OVF template, and click Next.

NOTE   This page appears only if the destination is a resource pool associated with a cluster with DRS
disabled or in manual mode.

9 Navigate to, and select the resource pool where you want to run the OVF template and click Next.

NOTE   This page appears only if the cluster contains a resource pool.

10 (Optional) Apply a virtual machine storage profile from the VM Storage Profile drop-down menu.

IMPORTANT   You cannot select a virtual machine storage profile if the host or cluster in which the virtual
machine runs has a license that does not include virtual machine storage profiles.

The list of datastores shows which datastores are compatible and which are incompatible with the selected
virtual machine storage profile.
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11 Select a datastore to store the deployed OVF template, and click Next.

Datastores are a unifying abstraction for storage locations such as Fibre Channel, iSCSI LUNs, or NAS
volumes. On this page, you select from datastores already configured on the destination cluster or host.
The virtual machine configuration file and virtual disk files are stored on the datastore. Select a datastore
large enough to accommodate the virtual machine and all of its virtual disk files.

12 Select the disk format to store the virtual machine virtual disks, and click Next.

Format Description

Thick Provisioned Lazy Zeroed Creates a virtual disk in a default thick format. Space required for the virtual
disk is allocated when the virtual disk is created data remaining on the
physical device is not erased during creation, but is zeroed out on demand
at a later time on first write from the virtual machine.

Thick Provision Eager Zeroed A type of thick virtual disk that supports clustering features such as Fault
tolerance. Space required for the virtual disk is allocated at creation time. In
contrast to the flat format the data remaining on the physical device is zeroed
out when the virtual disk is created. it might take much longer to create disks
in this format than to create other types o disks.

Thin Provision Use this format to save storage space. For the thin disk, you provision as
much datastore space as the disk would require based on the value that you
enter for the disk size. However, the thin disk starts small and at first, uses
only as much datastore space as the disk needs for its initial operations.

 
13 If the appliance that you are deploying has one ore more vService dependencies, select a binding service

provider.

14 For each network specified in the OVF template, select a network by right-clicking the Destination
Network column in your infrastructure to set up the network mapping and click Next.

15 On the IP Allocation page, configure how IP addresses are allocated for the virtual appliance and click
Next.

Option Description

Fixed You will be prompted to enter the IP addresses in the Appliance
Properties page.

Transient IP addresses are allocated from a specified range when the appliance is
powered on. The IP addresses are released when the appliance is powered
off.

DHCP A DHCP server is used to allocate the IP addresses.
 
This page does not appear if the deployed OVF template does not contain information about the IP scheme
it supports.

16 Set the user-configurable properties and click Next.

The set of properties that you are prompted to enter depend on the selected IP allocation scheme. For
example, you are prompted for IP related information for the deployed virtual machines only in the case
of a fixed IP allocation scheme.

17 Review your settings and click Finish.

The progress of the import task appears in the vSphere Client Status panel.

Browse VMware Virtual Appliance Marketplace
Available vApps appear in the main panel.

To get to the Virtual Appliance Marketplace page, select File > Browse VA Marketplace from the main menu.
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Procedure

u Select an available vApp and click Download Now.

The OVF Template Details page appears.

Export an OVF Template
An OVF package captures the state of a virtual machine or vApp into a self-contained package. The disk files
are stored in a compressed, sparse format.

Required privilege: vApp.Export

Procedure

1 Select the virtual machine or vApp and select File > Export > Export OVF Template.

2 In the Export OVF Template dialog, type the Name of the template.

For example, type MyVm.

NOTE   When exporting an OVF template with a name that contains asterisk (*) characters, those characters
turn into underscore characters (_).

3 Enter the Directory location where the exported virtual machine template is saved, or click “...” to browse
for the location.

The C:\ drive is the default location where the template is stored.

For example, OvfLib.

4 In the Format field, determine how you want to store the files.

n Select Folder of files (OVF) to store the OVF template as a set of files (.ovf, .vmdk, and .mf) This
format is optimal if you plan to publish the OVF files on a web server or image library. The package
can be imported, for example, into the vSphere client by publishing the URL to the .ovf file.

n Select Single file (OVA) to package the OVF template into a single .ova file. This might be convenient
to distribute the OVF package as a single file if it needs to be explicitly downloaded from a web site
or moved around using a USB key.

5 In Description, type a description for the virtual machine.

By default, the text from the Notes pane on the virtual machine’s Summary tab appears in this text box.

6 Select the checkbox if you want to include image files attached to floppy and CD/DVD devices in the OVF
package.

NOTE   This checkbox only shows if the virtual machine is connected to an ISO file or if the floppy drive
is connected to a floppy image.

7 Click OK.

The download process is shown in the Export window.

Example: Folder Locations for OVF and OVA Files
If you type OvfLib for a new OVF folder, the following files might be created:

n C:\OvfLib\MyVm\MyVm.ovfI

n C:\OvfLib\MyVm.mf

n C:\OvfLib\MyVm-disk1.vmdk
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If you type C:\NewFolder\OvfLib for a new OVF folder, the following files might be created:

n C:\NewFolder\OvfLib\MyVm\MyVm.ovfI

n C:\NewFolder\OvfLib\MyVm.mf

n C:\NewFolder\OvfLib\MyVm-disk1.vmdk

If you choose to export into the OVA format, and type MyVm, the file C:\MyVm.ova is created.
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Installing the Microsoft Sysprep Tool 7
You install the Microsoft Sysprep tool so that you can customize Windows guest operating systems.

Using the Sysprep tool is useful when you clone virtual machines. The guest operating system customization
feature in vCenter Server uses the functions of the Sysprep tool. Verify that your vCenter Server system meets
the following requirements before you customize your virtual machine’s Windows guest operating systems:

n Install the Microsoft Sysprep tool. Microsoft includes the system tool set on the installation CD-ROM discs
for Windows 2000, Windows XP, and Windows 2003. The Sysprep tool is built in to the Windows Vista
and Windows 2008 operating systems.

n The correct versions of the Sysprep is installed for each guest operating system you want to customize.

n The password for the local administrator account on the virtual machines is set to blank ("").

NOTE   Customization operations will fail if the correct version of the Sysprep tool is not found.

This chapter includes the following topics:

n “Install the Microsoft Sysprep Tool from a Microsoft Web Site,” on page 73

n “Install the Microsoft Sysprep Tool from the Windows Operating System CD,” on page 74

Install the Microsoft Sysprep Tool from a Microsoft Web Site
You can download and install the Microsoft Sysprep tool from the Microsoft Web site.

Prerequisites

Verify that you download the correct version for the guest operating system to customize. Microsoft has a
different version of Sysprep for each release and service pack of Windows. You must use the version of Sysprep
specific to the operating system that you are deploying.

The ALLUSERSPROFILE location is usually \Documents And Settings\All Users\. This is also the location of
the vpxd.cfg file. On Windows 2008, the file location is C:\ProgramData\VMware\VMware
VirtualCenter\sysprep\.

For the VMware vCenter Server Appliance, extract the contents of the .cab file for the Sysprep Tool version
you downloaded to /etc/vmware-vpx/sysprep. For example, /etc/vmware-vpx/sysprep/2k, /etc/vmware-
vpx/sysprep/xp. The vpx daemon process must have read permission on the files.

Procedure

1 Open a browser window and navigate to the Microsoft Download Center.

2 Navigate to the page that contains the download link to the version of the Sysprep tools that you want.

3 Click Download and save the file to your local disk.
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4 Open and expand the .cab file.

5 Extract the files to the provided directory.

The following Sysprep support directories were created during the vCenter Server installation:

C:\ALLUSERSPROFILE\Application Data\Vmware\VMware VirtualCenter\sysprep

...\1.1\

...\2k\

...\xp\ 

...\svr2003\

...\xp-64\

...\svr2003-64\

6 Select the subdirectory that corresponds to your operating system.

7 Click OK to expand the files.

The contents of the .cab file vary, depending on the operating system.

What to do next

You are now ready to customize a new virtual machine with a supported Windows guest operating system
when you clone an existing virtual machine.

Install the Microsoft Sysprep Tool from the Windows Operating System
CD

You can install the Microsoft Sysprep tool from a CD.

The ALLUSERSPROFILE location is usually \Documents and Settings\All Users\. This is also the location of
the vpxd.cfg file. On Windows 2008, the file location is C:\ProgramData\VMware\VMware
VirtualCenter\sysprep\.

For the VMware vCenter Server Appliance, extract the contents of the DEPLOY.CAB file for the Sysprep Tool
version you downloaded to /etc/vmware-vpx/sysprep. For example, /etc/vmware-
vpx/sysprep/2k, /etc/vmware-vpx/sysprep/xp. The vpx daemon process must have read permission on the
files.

Procedure

1 Insert the Windows operating system CD into the CD-ROM drive, often the D: drive.

2 Locate the DEPLOY.CAB file in the \Support\Tools directory on the CD .

3 Open and expand the DEPLOY.CAB file.

4 Extract the files to the directory appropriate to your Sysprep guest operating system.

The following Sysprep support directories were created during the vCenter Server installation:

C:\ALLUSERSPROFILE\Application Data\Vmware\VMware VirtualCenter\sysprep

...\1.1\ 

...\2k\ 

...\xp\ 

...\svr2003\

...\xp-64\

...\svr2003-64\

5 Select the subdirectory that corresponds to your operating system.

6 Click OK to expand the files.

The contents of the .cab file vary, depending on the operating system.
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7 Repeat this procedure to extract Sysprep files for each of the Windows guest operating systems that you
plan to customize using vCenter Server.

What to do next

You are now ready to customize a new virtual machine with a supported Windows guest operating system
when you clone an existing virtual machine.
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Configuring Virtual Machines 8
You can add or configure most virtual machine properties during the virtual machine creation process or after
you create the virtual machine and install the guest operating system.

You configure virtual machines and change nearly every characteristic that you selected when you created the
virtual machine.

You can configure three types of virtual machine properties.

Hardware View existing hardware configuration and add or remove hardware.

Options View and configure a number of virtual machine properties, such as power
management interaction between the guest operating system and virtual
machine, and VMware Tools settings.

Resources Configure CPUs, CPU hyperthreading resources, memory and disks.

This chapter includes the following topics:

n “Virtual Machine Hardware, Options, and Resources Available to vSphere Virtual Machines,” on
page 78

n “Virtual Machine Hardware Versions,” on page 81

n “Determine the Hardware Version of a Virtual Machine in the vSphere Web Client,” on page 82

n “Locate the Hardware Version of a Virtual Machine in the vSphere Client,” on page 83

n “Change the Virtual Machine Name in the vSphere Web Client,” on page 83

n “Change the Virtual Machine Name in the vSphere Client,” on page 83

n “View the Virtual Machine Configuration File Location in the vSphere Web Client,” on page 84

n “View the Virtual Machine Configuration File Location in the vSphere Client,” on page 84

n “Edit Configuration File Parameters in the vSphere Web Client,” on page 84

n “Edit Configuration File Parameters in the vSphere Client,” on page 85

n “Change the Virtual Machine Console Options for Remote Users in the vSphere Web Client,” on
page 86

n “Change the Configured Guest Operating System in the vSphere Client,” on page 86

n “Configure Virtual Machines to Automatically Upgrade VMware Tools,” on page 87

n “Virtual CPU Configuration,” on page 88

n “Virtual Memory Configuration,” on page 100

n “Network Virtual Machine Configuration,” on page 107
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n “Parallel and Serial Port Configuration,” on page 111

n “Virtual Disk Configuration,” on page 121

n “Understanding Virtual Machine Storage Profiles,” on page 131

n “SCSI Controller Configuration,” on page 132

n “Other Virtual Machine Device Configuration,” on page 136

n “Configuring vServices,” on page 148

n “USB Configuration from an ESXi Host to a Virtual Machine,” on page 149

n “USB Configuration from a Client Computer to a Virtual Machine in the vSphere Web Client,” on
page 159

n “USB Configuration from a Client Computer to a Virtual Machine in the vSphere Client,” on page 164

n “Cannot Copy Data From an ESXi Host to a USB Device That Is Connected to the Host,” on page 170

n “Add a Shared Smart Card Reader to Virtual Machines in the vSphere Client,” on page 170

n “Add a Shared Smart Card Reader to Virtual Machines in the vSphere Web Client,” on page 171

n “Manage Power Management Settings for a Virtual Machine,” on page 171

n “Configure the Virtual Machine Power States,” on page 172

n “Delay the Boot Sequence in the vSphere Web Client,” on page 174

n “Delay the Boot Sequence in the vSphere Client,” on page 174

n “Enable Virtual Machine Logging in the vSphere Web Client,” on page 175

n “Enable Logging in the vSphere Client,” on page 175

n “Disable Virtual Machine Acceleration in the vSphere Web Client,” on page 175

n “Disable Acceleration in the vSphere Client,” on page 176

n “Configure Virtual Machine Debugging and Statistics in the vSphere Web Client,” on page 176

n “Configure Debugging and Statistics in the vSphere Client,” on page 177

Virtual Machine Hardware, Options, and Resources Available to
vSphere Virtual Machines

VMware provides devices, options, resources, profiles, and vServices that you can configure or add to your
virtual machine.

Virtual Machine Hardware
Not all hardware devices are available to every virtual machine. The host that the virtual machine runs on and
the guest operating system must support devices that you add or configurations that you make.

In some cases, the host might not have the required vSphere license for a resource, option, or device. Licensing
in vSphere is applicable to ESXi hosts, vCenter Server, and solutions and can be based on different criteria,
depending on the specifics of each product. For details about vSphere licensing, see the vCenter Server and Host
Management documentation.

You can add or configure some virtual machine hardware, only if the virtual machine uses the latest available
hardware version. The PCI and SIO virtual hardware devices are part of the virtual motherboard, but cannot
be configured or removed.
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Table 8-1.  Virtual Machine Hardware

Hardware Device Description

CPU You can configure a virtual machine that runs on an ESXi host to have one or more
virtual processors. A virtual machine cannot have more virtual CPUs than the
actual number of logical CPUs on the host. You can change the number of CPUs
allocated to a virtual machine and configure advanced CPU features, such as the
CPU Identification Mask and hyperthreaded core sharing.

Chipset The motherboard uses VMware proprietary devices based on the following chips:
n Intel 440BX AGPset 82443BX Host Bridge/Controller
n Intel 82371AB (PIIX4) PCI ISA IDE Xcelerator
n National Semiconductor PC87338 ACPI 1.0 and PC98/99 Compliant SuperI/O
n Intel 82093AA I/O Advanced Programmable Interrupt Controller

DVD/CD-ROM Drive Installed by default when you create a new vSphere virtual machine. You can
configure DVD/CD-ROM devices to connect to client devices, host devices, or
Datastore ISO files. You can add, remove, or configure DVD/CD-ROM devices.

Floppy Drive Installed by default when you create a new vSphere virtual machine. You can
connect to a floppy drive located on the ESXi host, a floppy (.flp) image, or the
floppy drive on your local system. You can add, remove, or configure floppy
devices.

Hard Disk Stores the virtual machine's operating system, program files, and other data
associated with its activities. A virtual disk is a large physical file, or a set of files,
that can be copied, moved, archived, and backed up as easily as any other file.

IDE 0, IDE 1 By default, two Integrated Drive Electronics (IDE) interfaces are presented to the
virtual machine. The IDE interface (controller) is a standard way for storage
devices (Floppy drives, hard drives and CD-ROM drives) to connect to the virtual
machine.

Keyboard Mirrors the keyboard that is connected to the virtual machine console when you
first connect to the console.

Memory The virtual hardware memory size determines how much memory applications
that are running inside the virtual machine have available to them. A virtual
machine cannot benefit from more memory resources than its configured virtual
hardware memory size.

Network Adapter ESXi networking features provide communication between virtual machines on
the same host, between virtual machines on different hosts, and between other
virtual and physical machines. When you configure a virtual machine, you can
add network adapters (NICs) and specify the adapter type.

Parallel port Interface for connecting peripherals to the virtual machine. The virtual parallel
port can connect to a file. You can add, remove, or configure virtual parallel ports.

PCI controller Bus on the virtual machine motherboard that communicates with components
such as hard disks and other devices. One PCI controller is presented to the virtual
machine. You cannot configure or remove this device.

PCI Device You can add up to six PCI vSphere DirectPath devices to a virtual machine. The
devices must be reserved for PCI passthrough on the host on which the virtual
machine runs. Snapshots are not supported with DirectPath I/O passthrough
devices.

Pointing device Mirrors the pointing device that is connected to the virtual machine console when
you first connect to the console.

Serial Port Interface for connecting peripherals to the virtual machine. The virtual serial port
can connect to a physical serial port, to a file on the host computer, or over the
network. You can also use it to establish a direct connection between two virtual
machines or a connection between a virtual machine and an application on the
host computer. A virtual machine can use up to four virtual serial ports. You can
add, remove, or configure virtual serial ports.
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Table 8-1.  Virtual Machine Hardware (Continued)

Hardware Device Description

SCSI controller Provides access to virtual disks. The SCSI virtual controller appears to a virtual
machine as different types of controllers, including BusLogic Parallel, LSI Logic
Parallel, LSI Logic SAS, and VMware Paravirtual. You can change the SCSI
controller type, allocate bus sharing for a virtual machine, or add a paravirtualized
SCSI controller.

SCSI device By default, a SCSI device interface is available to the virtual machine. The SCSI
interface is a typical way to connect storage devices (floppy drives, hard drives,
and DVD/CD-ROMs) to a virtual machine. You can add, remove, or configure
SCSI devices.

SIO controller Provides serial and parallel ports, floppy devices, and performs system
management activities. One SIO controller is available to the virtual machine. You
cannot configure or remove this device.

USB controller The USB hardware chip that provides USB function to the USB ports that it
manages. The virtual USB Controller is the software virtualization of the USB host
controller function in the virtual machine.

USB device You can add multiple USB devices, such as security dongles and mass storage
devices, to a virtual machine. The USB devices can be connected to an ESXi host
or a client computer.

VMCI Virtual Machine Communication Interface device. Provides a high-speed
communication channel between a virtual machine and the hypervisor. You can
also enable VMCI for communication between virtual machines. You cannot add
or remove VMCI devices.

Virtual Machine Options
The virtual machine options define a range of virtual machine properties, such as the virtual machine name
and the virtual machine behavior with the guest operating system and VMware Tools. In addition, the options
define vApp functionality and other options that you rarely need to change from their defaults. You change
the virtual machine settings on the Options tab of the Virtual Machine Properties Editor

Table 8-2.  Virtual Machine Options

Options Description

General Options Display name and type of guest operating system. Location of the virtual machine and its
configuration file.

vApp Options Options for functionality, product information, properties, and OVF settings specific to
virtual appliances.

VMware Tools Power Controls behavior, VMware Tools scripts, and automatic updates.

Power Management Virtual machine Suspend behavior.

You can change advanced virtual machine settings on the Options tab.

Table 8-3.  Advanced Virtual Machine Options

Advanced Options Description

General Acceleration, logging, debugging and statistics.

CPUID Mask NX flag and advanced identification mask options.

Memory/CPU Hotplug Hot add enablement for individual virtual machines.

Boot Options Virtual machine boot options. Add a delay before booting or force entry into the BIOS or
EFI setup screen.

Fibre Channel NPIV Virtual node and port World Wide Names (WWNs).
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Table 8-3.  Advanced Virtual Machine Options (Continued)

Advanced Options Description

CPU/MMU Virtualization Settings for enabling Hardware Page Table Virtualization. In some new processors, controls
the use of hardware support for virtual MMUs.

Swapfile Location Swapfile location.

SDRS Rules Set affinity rules for virtual disks within a datastore cluster.

Virtual Machine Resources
You can adjust the host resource allocation for the selected virtual machine on the Resources tab.

Table 8-4.  Virtual Machine Resources

Virtual Machine Resource Go to

CPU “Virtual CPU Configuration,” on page 88

Memory “Virtual Memory Configuration,” on page 100

Disk “Virtual Disk Configuration,” on page 121

Advanced CPU (hyperthreaded
core sharing)

“Virtual CPU Configuration,” on page 88

Profiles
You can associate a virtual machine storage profile with a virtual machine to define the storage capabilities
that are required by the applications running on the virtual machine. See “Understanding Virtual Machine
Storage Profiles,” on page 131.

vServices
You can add a vService dependency to a virtual machine or vApp. This dependency allows a virtual machine
or vApp to request that a specific vService be available. See “Configuring vServices,” on page 148.

Virtual Machine Hardware Versions
The hardware version of a virtual machine reflects the virtual machine's supported virtual hardware features.
These features correspond to the physical hardware available on the ESXi host on which you create the virtual
machine. Virtual hardware features include BIOS and EFI, available virtual PCI slots, maximum number of
CPUs, maximum memory configuration, and other characteristics typical to hardware.

When you create a virtual machine, you can accept the default hardware version, which corresponds to the
host on which you create the virtual machine, or an earlier version. You can use an earlier hardware version
in the following situations:

n To standardize testing and deployment in your virtual environment.

n If you do not need the capabilities of the newer version.

n To maintain compatibility with older hosts.

Virtual machines with hardware versions earlier than version 8 can run on ESXi 5.0 hosts, but do not have all
the capabilities available in hardware version 8. For example, you cannot use 32 virtual processors or 1011GB
of memory in virtual machines with hardware versions earlier than version 8.
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The vSphere Web Client or the vSphere Client allows you to upgrade virtual machines only to the latest
hardware version. If virtual machines do not have to stay compatible with older ESX/ESXi hosts, you can
upgrade them on ESXi 5.0 hosts. In this case, they are upgraded to version 8.

n To maintain virtual machine compatibility with ESX/ESXi 3.5 hosts, upgrade the virtual machine on an
ESX/ESXi 3.5 host, which results in a virtual machine upgrade to version 4.

n To maintain virtual machine compatibility with ESX/ESXi 4.x hosts, upgrade the virtual machine on an
ESX/ESXi 4.x host, which results in a virtual machine upgrade to version 7.

A virtual machine can have an earlier hardware version than that of the host on which it runs in the following
cases:

n You migrate a virtual machine created on an ESX/ESXi 4.x or earlier host to an ESXi 5.0 host.

n You create a virtual machine on an ESXi 5.0 host by using an existing virtual disk that was created on an
ESX/ESXi 4.x or earlier host.

n You add a virtual disk created on an ESX/ESXi 4.x or earlier host to a virtual machine created on an
ESXi 5.0 host.

You can create, edit, and run different virtual machine versions on a host if the host supports that version.
Sometimes, virtual machine actions on a host are limited or the virtual machine has no access to the host.

Table 8-5.  ESXi Hosts and Compatible Virtual Machine Hardware Versions

Version 8 Version 7 Version 4
Compatible with vCenter
Server Version

ESXi 5.0 Create, edit, run Create, edit, run Edit, run vCenter Server 5.0

ESX/ESXi 4.x Not supported Create, edit, run Create, edit, run vCenter Server 4.x

ESX Server 3.x Not supported Not supported Create, edit, run VirtualCenter Server 2.x and
later

Version 3 virtual machines are not supported on ESXi 5.0 hosts. To make full use of these virtual machines,
upgrade the virtual hardware.

NOTE   Virtual machine hardware version 4 might be listed as VM3 in documentation for earlier versions of
ESX/ESXi.

Determine the Hardware Version of a Virtual Machine in the
vSphere Web Client

Determine the hardware version of a virtual machine to determine which hosts and features the virtual machine
is compatible with.

Procedure

u Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

The VM Hardware panel displays the hardware version in the HW Version field.
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Locate the Hardware Version of a Virtual Machine in the vSphere Client
You can locate the hardware version of a virtual machine by looking in the virtual machine Summary tab or
the Virtual Machine Properties dialog box. You can also locate the hardware version for multiple virtual
machines on the Virtual Machine tab of a datacenter, host, or cluster.

Procedure

1 In the vSphere Client inventory, select the virtual machine.

2 Select a method for viewing the version information.

Option Description

Click the Summary tab. The virtual machine hardware version appears under General on the virtual
machine's Summary tab.

Right-click the virtual machine and
select Edit Settings.

The virtual machine hardware version appears in the upper-right corner of
the Virtual Machine Properties dialog box.

Select a datacenter, host, or cluster
and click the Virtual Machine tab.

The virtual machine hardware version appears in the VM Version column.
If the VM Version column is not displayed, right-click any column title and
select VM Version.

 

Change the Virtual Machine Name in the vSphere Web Client
Changing the name of a virtual machine changes the name used to identify the virtual machine in the
vCenter Server inventory, but does not change the name used as the computer name by the guest operating
system.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click VM Options.

4 In the VM Name text box, type a new name for the virtual machine.

5 Click OK.

Change the Virtual Machine Name in the vSphere Client
You can change the virtual machine name in the Virtual Machine Name panel in the Virtual Machine
Properties dialog box.

Changing the name does not change the name of any virtual machine files or the name of the directory that
the files are located in.

Prerequisites

n Verify that you are connected to the vCenter Server or ESXi host on which the virtual machine runs.

n Verify that you have access to the virtual machine in the vSphere Client inventory list.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.
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2 Click the Options tab and select General Options.

3 Type a new name for the virtual machine.

4 Click OK to save your changes and close the dialog box.

View the Virtual Machine Configuration File Location in the
vSphere Web Client

You can view the location of the virtual machine configuration and working files. This information is useful
when you are configuring backup systems.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click VM Options.

4 Click the General Options triangle.

The location of the virtual machine configuration file appears in the VM Config File text box.

View the Virtual Machine Configuration File Location in the vSphere
Client

You can view the location of the virtual machine configuration and working files. This information is useful
when you are configuring backup systems.

Prerequisites

n Verify that you are connected to the vCenter Server or ESXi host on which the virtual machine runs.

n Verify that you have access to the virtual machine in the vSphere Client inventory list.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and select General Options.

3 Record the location of the configuration and working files and click OK to close the dialog box.

Edit Configuration File Parameters in the vSphere Web Client
You can change or add virtual machine configuration parameters if you intend to use experimental features
or when instructed by a VMware technical support representative.

You also might see VMware documentation that instructs you to change or add a parameter. In such cases,
you can safely follow the recommended procedure.

The following conditions apply:

n To change a parameter, you change the existing value for the keyword/value pair. For example, if you
start with the keyword/value pair, keyword/value, and change it to keyword/value2, the result is
keyword=value2.
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n You cannot delete a configuration parameter entry.

CAUTION   You must assign a value to configuration parameter keywords. If you don't assign a value, the
keyword can return a value of 0, false, or disable, which can result in a virtual machine that cannot power on.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click VM Options.

4 Click the Advanced triangle to expand the advanced options.

5 Click Edit Configuration.

6 (Optional) To add a parameter, click Add Row and enter a name and value for the parameter.

7 (Optional) To change a parameter, type a new value in the Value text box for that parameter.

8 Click OK.

Edit Configuration File Parameters in the vSphere Client
You can change or add virtual machine configuration parameters if you intend to use experimental features
or when instructed by a VMware technical support representative.

You also might see VMware documentation that instructs you to change or add a parameter. In such cases,
you can safely follow the recommended procedure.

The following conditions apply:

n To change a parameter, you change the existing value for the keyword/value pair. For example, if you
start with the keyword/value pair, keyword/value, and change it to keyword/value2, the result is
keyword=value2.

n You cannot delete a configuration parameter entry.

CAUTION   You must assign a value to configuration parameter keywords. If you don't assign a value, the
keyword can return a value of 0, false, or disable, which can result in a virtual machine that cannot power on.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced, click General.

3 Click Configuration Parameters.

4 (Optional) Change or add a parameter.

5 Click OK to exit the Configuration Parameters dialog box.

6 Click OK to save your changes and close the dialog box.
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Change the Virtual Machine Console Options for Remote Users in the
vSphere Web Client

In the vSphere Web Client, you can limit the number of simultaneous connections to a virtual machine and
lock the guest operating system when the last remote user disconnects from the virtual machine console.

Prerequisites

n Verify that VMware Tools is installed and running.

n To use the Guest OS lock option, you must have a Windows XP or later guest operating system.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click VM Options.

4 Click the Remote Console Options triange to expand the remote console options.

5 Click the check box to select an option.

Option Description

Guest OS lock (*) Locks the guest operating system when the last remote user disconnects.

Maximum number of sessions Limits the number of simultaneous connections to this virtual machine.
 

Change the Configured Guest Operating System in the vSphere Client
When you change the guest operating system type in the virtual machine settings, you change the setting for
the guest operating system in the virtual machine's configuration file. To change the guest operating system
itself, you must install the new operating system in the virtual machine.

When you set the guest operating system type for a new virtual machine, vCenter Server chooses configuration
defaults based on the guest type. Changing the guest operating system type after the virtual machine is created
does not retroactively change those settings. It affects the recommendations and setting ranges offered after
the change.

Prerequisites

Power off the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and select General Options.

3 Select a guest operating system type and version.

4 Click OK to save your changes and close the dialog box.

The virtual machine configuration parameters for the guest operating system are changed. You can now install
the guest operating system.
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Change the Configured Guest Operating System in the vSphere Web Client
When you change the guest operating system type in the virtual machine settings, you change the setting for
the guest operating system in the virtual machine's configuration file. To change the guest operating system
itself, you must install the new operating system in the virtual machine.

You might change the guest operating system, for example, if you are upgrading the guest operating system
installed in the virtual machine.

When you set the guest operating system type for a new virtual machine, vCenter Server chooses configuration
defaults based on the guest type. Changing the guest operating system type after the virtual machine is created
does not retroactively change those settings. It affects the recommendations and setting ranges offered after
the change.

Prerequisites

Power off the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click VM Options.

4 Click the General Options triangle to show the guest operating system options.

5 From the Guest OS drop-down menu, select the guest operating system family.

6 Select a guest operating system version.

7 If you selected Other (32-bit) or Other (64-bit), enter a name for the operating system in the text box.

8 Click OK.

Configure Virtual Machines to Automatically Upgrade VMware Tools
You can configure virtual machines to automatically update VMware Tools.

NOTE   Automatic VMware Tools upgrade is not supported for virtual machines with Solaris or NetWare guest
operating systems.

Prerequisites

n Verify that the virtual machines have a version of VMware Tools shipped with ESX/ESXi 3.5 or later
installed.

n Verify that the virtual machines are hosted on ESX/ESXi 3.5 or later and vCenter Server 3.5 or later.

n Verify that the virtual machines are running a Linux or Windows guest OS that ESX/ESXi 3.5 or later and
vCenter Server 3.5 or later support.

Procedure

1 Right-click the virtual machine and click Edit Settings.

2 Click the Options tab and select VMware Tools.

3 Select Check and upgrade Tools during power cycling in the Advanced pane.
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4 Click OK to save your changes and close the dialog box.

The next time the virtual machine is powered on, it checks the ESX/ESXi host for a newer version of VMware
Tools. If one is available, it is installed and the guest operating system is restarted (if required).

Virtual CPU Configuration
You can add, change, or configure CPU resources to improve virtual machine performance. You can set most
of the CPU parameters during virtual machine creation or after the guest operating system is installed. Some
actions require you to power off the virtual machine before changing the settings.

VMware uses the following terminology. Understanding these terms can help you plan your CPU resource
allocation strategy.

CPU The CPU or processor is the portion of a computer system that carries out the
instructions of a computer program and is the primary element carrying out
the computer's functions. CPUs contain cores.

CPU Socket A physical connector on a computer motherboard that accepts a single physical
CPU. Many motherboards can have multiple sockets that can in turn accept
multicore processors (CPUs). The vSphere Client computes the total number
of cores to give the virtual machine from the number of virtual sockets and
cores per socket that you select. The vSphere Web Client computes the total
number of virtual sockets from the number of cores and cores per socket that
you select.

Core Comprises a unit containing an L1 cache and functional units needed to run
programs. Cores can independently run programs or threads. One or more
cores can exist on a single CPU.

Corelet An AMD processor corelet is architecturally equivalent to a logical processor.
Certain future AMD processors will comprise a number of compute units,
where each compute unit has a number of corelets. Unlike a traditional
processor core, a corelet lacks a complete set of private, dedicated execution
resources. It shares some execution resources with other corelets such as an L1
Instruction Cache or a floating-point execution unit. AMD refers to corelets as
cores, but because these are unlike traditional cores, VMware uses the
nomenclature of “corelets” to make resource sharing more apparent.

Thread Some cores can run independent streams of instructions simultaneously. In
existing implementations, cores can run one or two software threads at one
time by multiplexing the functional units of the core between the software
threads, as necessary. Such cores are called dual or multithreaded.

Resource sharing Shares specify the relative priority or importance of a virtual machine or
resource pool. If a virtual machine has twice as many shares of a resource as
another virtual machine, it is entitled to consume twice as much of that resource
when these two virtual machines are competing for resources.

Resource allocation You can change CPU resource allocation settings, such as shares, reservation,
and limit, when available resource capacity does not meet demands. For
example, if at year end the workload on accounting increases, you can increase
the accounting resource pool reserve.

vSphere Virtual
Symmetric
Multiprocessing (Virtual
SMP)

Feature that enables a single virtual machine to have multiple cores.
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Virtual CPU Limitations
The maximum number of virtual CPUs that you can assign to a virtual machine depends on the number of
logical CPUs on the host, the host license, and the type of guest operating system that is installed on the virtual
machine.

Be aware of the following limitations:

n A virtual machine cannot have more virtual CPUs than the number of logical cores on the host. The number
of logical cores is equal to the number of physical cores if hyperthreading is disabled or two times that
number if hyperthreading is enabled.

n Not every guest operating system supports Virtual SMP, and some that do require reinstallation if the
number of CPUs changes. For more information about using Virtual SMP, search the VMware Knowledge
Base.

n Guest operating systems that support Virtual SMP might support fewer processors than are available on
the host. For information about Virtual SMP support, see the VMware Compatibility Guide.

n Running Virtual SMP virtual machines on hyperthreaded hosts with Virtual SMP can affect virtual
machine performance. Running uniprocessor virtual machines on hyperthreaded hosts can also affect
virtual machine performance.

Configuring Multicore Virtual CPUs
VMware multicore virtual CPU support lets you control the number of cores per virtual socket in a virtual
machine. This capability lets operating systems with socket restrictions use more of the host CPU's cores, which
increases overall performance.

IMPORTANT   When you configure your virtual machine for multicore virtual CPU settings, you must ensure
that your configuration complies with the requirements of the guest operating system EULA.

Using multicore virtual CPUs can be useful when you run operating systems or applications that can take
advantage of only a limited number of CPU sockets. Previously, each virtual CPU was, by default, assigned
to a single-core socket, so that the virtual machine would have as many sockets as virtual CPUs.

You can configure a virtual machine that runs on an ESXi host to have up to 32 virtual CPUs. A virtual machine
cannot have more virtual CPUs than the actual number of logical CPUs on the host. The number of logical
CPUs is the number of physical processor cores or two times that number if hyperthreading is enabled. For
example, if a host has 32 logical CPUs, you can configure the virtual machine for 32 virtual CPUs.

You configure how the virtual CPUs are assigned in terms of sockets and cores. For example, you can configure
a virtual machine with 12 virtual CPUs in the following ways:

n 12 virtual sockets with 1 core per socket

n 6 virtual sockets with 2 cores per socket

n 4 virtual sockets with 3 cores per socket

n 3 virtual sockets with 4 cores per socket

n 2 virtual sockets with 6 cores per socket

n 1 virtual socket with 12 cores per socket

For multicore CPUs, the host must have a license for Virtual SMP.

For more information about multicore CPUs, see the vSphere Resource Management documentation. You can
also search the VMware Knowledge Base for articles about multicore CPUs.
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Change CPU Hot Plug Settings in the vSphere Web Client
The CPU hot plug option lets you add CPU resources for a virtual machine while the machine is powered on.

The following conditions apply:

n For best results, use hardware version 8 virtual machines.

n Hot-adding multicore virtual CPUs is supported only with hardware version 8 virtual machines.

n Not all guest operating systems support CPU hot add. You can disable these settings if the guest is not
supported.

n To use the CPU hot-add feature with hardware version 7 virtual machines, set the Number of cores per
socket to 1.

n Adding CPU resources to a running virtual machine with CPU hot plug enabled disconnects and
reconnects all USB passthrough devices connected to that virtual machine.

Prerequisites

Verify that the virtual machine is running under the following conditions:

n VMware Tools is installed. This condition is required for hot plug functionality with Linux guest operating
systems.

n The virtual machine has a guest operating system that supports CPU hot plug.

n The virtual machine is using hardware version 7 or later.

n The virtual machine is powered off.

n Required privileges: Virtual Machine.Configuration.Settings

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the CPU triangle to expand the CPU options.

5 Select Enable CPU Hot Add to enable adding CPUs while this virtual machine is powered on.

6 Click OK.

Change CPU Hot-Plug Settings in the vSphere Client
The CPU hot plug option lets you add CPU resources for a virtual machine while the machine is powered on.

The following conditions apply:

n For best results, use hardware version 8 virtual machines.

n Hot-adding multicore virtual CPUs is supported only with hardware version 8 virtual machines.

n Not all guest operating systems support CPU hot add. You can disable these settings if the guest is not
supported.
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n To use the CPU hot-add feature with hardware version 7 virtual machines, set Number of cores per
socket to 1.

n Adding CPU resources to a running virtual machine with CPU hot plug enabled disconnects and
reconnects all USB passthrough devices connected to that virtual machine.

Prerequisites

Verify that the virtual machine is running under the following conditions:

n VMware Tools is installed. This condition is required for hot plug functionality with Linux guest operating
systems.

n The virtual machine has a guest operating system that supports CPU hot plug.

n The virtual machine is using hardware version 7 or later.

n The virtual machine is powered off.

n Required privileges: Virtual Machine.Configuration.Settings on the virtual machine

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced, select Memory/CPU Hotplug.

3 Change the CPU Hot Plug setting.

4 Click OK to save your changes and close the dialog box.

What to do next

You can now add CPUs to the powered on virtual machine.

Change the Number of Virtual CPUs in the vSphere Web Client
You can configure a virtual machine that runs on an ESXi host to have up to 32 virtual CPUs. You can change
the number of virtual CPUs while the virtual machine is running or powered off.

Virtual CPU hot add is supported for virtual machines with multicore CPU support and running on hardware
version 8 or later. When the virtual machine is powered on, and CPU hot add is enabled, you can hot add
virtual CPUs to the running virtual machine. You can only add multiples of the number of cores per socket.
For multicore CPUs, the host must have a license for vSphere Virtual Symmetric Multiprocessing (Virtual
SMP).

IMPORTANT   When you configure your virtual machine for multicore virtual CPU settings, you must ensure
that your configuration complies with the requirements of the guest operating system EULA.

Prerequisites

n If CPU hot add is not enabled, power off the virtual machine before adding CPUs.

n If CPU hot remove is not enabled, power off the virtual machine before removing CPUs.

n To hot add multicore CPUs, verify that the virtual machine has hardware version 8.

n Required privilege: Virtual Machine.Configuration.Change CPU Count on the virtual machine
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Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Expand the CPU options, and select the number of cores for the virtual machine from the Cores drop-
down menu.

5 Select the number of cores per socket from the Cores Per Socket drop-down menu.

6 Click OK.

Change the Number of Virtual CPUs in the vSphere Client
You can configure a virtual machine that runs on an ESXi host to have up to 32 virtual CPUs. You can change
the number of virtual CPUs while the virtual machine is running or powered off.

Virtual CPU hot add is supported for virtual machines with multicore CPU support that are running on
hardware version 8 or later. When the virtual machine is powered on, and CPU hot add is enabled, you can
hot add virtual CPUs to the running virtual machine. You can add only multiples of the number of cores per
socket. For multicore CPUs, the host must have a license for vSphere Virtual Symmetric Multiprocessing
(Virtual SMP).

IMPORTANT   When you configure your virtual machine for multicore virtual CPU settings, you must ensure
that your configuration complies with the requirements of the guest operating system EULA.

Prerequisites

n If CPU hot add is not enabled, power off the virtual machine before adding CPUs.

n If CPU hot remove is not enabled, power off the virtual machine before removing CPUs.

n To hot add multicore CPUs, verify that the virtual machine has hardware version 8.

n Required privilege: Virtual Machine.Configuration.Change CPU Count on the virtual machine

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select CPUs.

3 Select a value from the Number of virtual sockets drop-down menu.

4 Select a value from the Number of cores per socket drop-down menu.

The resulting total number of cores is a number equal to or less than the number of logical CPUs on the
host.

5 Click OK to save your changes and close the dialog box.

Example: Adding Multicore CPU Resources to a Virtual Machine
You might have the following existing CPU resources, which you configured for the virtual machine while
you were creating it, or after you created it and it was in a powered off state.
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CPU Resource Settings Existing Value

Number of virtual sockets 2

Number of cores per socket 2

Total number of cores 4

With CPU hot plug enabled and the virtual machine running, you can select the number of sockets to add from
the Number of virtual sockets drop-down menu. The Number of cores per socket drop-down menu is
unavailable and retains a value of 2. If you select 3 virtual sockets, you are adding 1 socket with 2 cores so that
the virtual machine has 6 virtual CPUs.

CPU Resource Settings Existing Value Hot-plug value

Number of virtual sockets 2 3

Number of cores per socket 2 2

Total Number of cores 4 6

Allocate CPU Resources in vSphere Web Client
You can change the amount of CPU resources allocated to a virtual machine by using the shares, reservations,
and limits settings.

A virtual machine has the following user-defined settings that affect its CPU resource allocation.

Limit Places a limit on the consumption of CPU time for a virtual machine. This value
is expressed in MHz.

Reservation Specifies the guaranteed minimum allocation for a virtual machine. The
reservation is expressed in MHz.

Shares Each virtual machine is granted a number of CPU shares. The more shares a
virtual machine has, the more often it gets a time slice of a CPU when there is
no CPU idle time. Shares represent a relative metric for allocating CPU
capacity.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the CPU triangle to expand the CPU options.
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5 Allocate the CPU capacity for the virtual machine.

Option Description

Reservation Guaranteed CPU allocation for this virtual machine.

Limit Upper limit for this virtual machine’s CPU allocation. Select Unlimited to
specify no upper limit.

Shares CPU shares for this virtual machine with respect to the parent’s total. Sibling
virtual machines share resources according to their relative share values
bounded by the reservation and limit. Select Low, Normal, or High, which
specify share values respectively in a 1:2:4 ratio. Select Custom to give each
virtual machine a specific number of shares, which express a proportional
weight.

 
6 Click OK.

Allocate CPU Resources in the vSphere Client
You can change the amount of CPU resources allocated to a virtual machine by using the shares, reservations,
and limits settings.

A virtual machine has the following user-defined settings that affect its CPU resource allocation.

Limit Places a limit on the consumption of CPU time for a virtual machine. This value
is expressed in MHz.

Reservation Specifies the guaranteed minimum allocation for a virtual machine. The
reservation is expressed in MHz.

Shares Each virtual machine is granted a number of CPU shares. The more shares a
virtual machine has, the more often it gets a time slice of a CPU when there is
no CPU idle time. Shares represent a relative metric for allocating CPU
capacity.

Prerequisites

Required Privilege: Virtual machine.Configuration.Change resource

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Resources tab and select CPU.

3 Allocate the CPU capacity for this virtual machine.

Option Description

Shares CPU shares for this virtual machine with respect to the parent’s total. Sibling
virtual machines share resources according to their relative share values
bounded by the reservation and limit. Select Low, Normal, or High, which
specify share values respectively in a 1:2:4 ratio. Select Custom to give each
virtual machine a specific number of shares, which express a proportional
weight.

Reservation Guaranteed CPU allocation for this virtual machine.

Limit Upper limit for this virtual machine’s CPU allocation. Select Unlimited to
specify no upper limit.

 
4 Click OK to save your changes and close the dialog box.

vSphere Virtual Machine Administration

94  VMware, Inc.



Configuring Advanced CPU Scheduling Settings
You can select CPU options that involve scheduling the virtual machine processing to physical processor cores
and hyperthreads. ESXi generally manages processor scheduling well, even when hyperthreading is enabled.
These settings are useful only for detailed tweaking of critical virtual machines.

Configure Hyperthreaded Core Sharing in the vSphere Web Client
You can select how the virtual CPUs of a virtual machine share physical cores on a hyperthreaded system.

Hyperthreading technology allows a single physical processor to behave like two logical processors. The
hyperthreaded core sharing option provides detailed control over whether to schedule a virtual machine to
share a physical processor core. The processor can run two independent applications at the same time.
Although hyperthreading does not double the performance of a system, it can increase performance by better
utilizing idle resources.

Prerequisites

n The hyperthreaded core sharing option must be enabled in your system's BIOS settings. For more
information, see the vSphere Resource Management documentation.

n Power off the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the CPU triangle to expand the CPU options.

5 In the HT Sharing drop-down menu, select a sharing mode.

Option Description

Any (default) The virtual CPUs of this virtual machine can share cores with other virtual
CPUs of this or other virtual machines.

None The virtual CPUs of this virtual machine have exclusive use of a processor
core whenever they are scheduled to it. The other hyperthread of the core is
halted while this virtual machine is using the core.

Internal On a virtual machine with exactly two virtual processors, the two virtual
processors are allowed to share one physical core (at the discretion of the
host scheduler), but this virtual machine never shares a core with any other
virtual machine. If this virtual machine has any other number of processors
other than two, this setting is the same as the None setting.

 
6 Click OK.
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Configure Hyperthreaded Core Sharing in the vSphere Client
You can select how the virtual CPUs of a virtual machine share physical cores on a hyperthreaded system.

Hyperthreading technology allows a single physical processor to behave like two logical processors. The
hyperthreaded core sharing option provides detailed control over whether to schedule a virtual machine to
share a physical processor core. The processor can run two independent applications at the same time.
Although hyperthreading does not double the performance of a system, it can increase performance by better
utilizing idle resources.

Prerequisites

n The hyperthreaded core sharing option must be enabled in your system's BIOS settings. For more
information, see the Resource Management documentation.

n Power off the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Resources tab and select Advanced CPU.

3 Select a mode from the Hyperthreading Sharing Mode drop-down menu.

Option Description

Any (default) The virtual CPUs of this virtual machine can share cores with other virtual
CPUs of this or other virtual machines.

None The virtual CPUs of this virtual machine have exclusive use of a processor
core whenever they are scheduled to it. The other hyperthread of the core is
halted while this virtual machine is using the core.

Internal On a virtual machine with exactly two virtual processors, the two virtual
processors are allowed to share one physical core (at the discretion of the
host scheduler), but this virtual machine never shares a core with any other
virtual machine. If this virtual machine has any other number of processors
other than two, this setting is the same as the None setting.

 
4 Click OK to save your changes and close the dialog box.

Configure Processor Scheduling Affinity in the vSphere Web Client
The Scheduling Affinity option gives you detailed control over how virtual machine CPUs are distributed
across the host's physical cores (and hyperthreads if hyperthreading is enabled). This panel does not appear
for virtual machines in a DRS cluster or when the host has only one processor core and no hyperthreading.

Using CPU affinity, you can assign a virtual machine to a specific processor. This assignment allows you to
restrict the assignment of virtual machines to a specific available processor in multiprocessor systems.

For potential issues with CPU affinity, see the vSphere Resource Management documentation.

Prerequisites

Power off the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.
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2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the CPU triangle to expand the CPU options.

5 In the Scheduling Affinity panel, enter a comma-separated list of hyphenated processor ranges.

For example, "0,4-7" would indicate affinity with CPUs 0,4,5,6, and 7. Selecting all processors is identical
to selecting no affinity. You must provide at least as many processor affinities as you have virtual CPUs.

6 Click OK.

Configure Processor Scheduling Affinity in the vSphere Client
The Scheduling Affinity option gives you detailed control over how virtual machine CPUs are distributed
across the host's physical cores (and hyperthreads if hyperthreading is enabled). This panel does not appear
for virtual machines in a DRS cluster or when the host has only one processor core and no hyperthreading.

Using CPU affinity, you can assign a virtual machine to a specific processor. This assignment allows you to
restrict the assignment of virtual machines to a specific available processor in multiprocessor systems.

For potential issues with CPU affinity, see the Resource Management documentation.

Prerequisites

Power off the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Resources tab and select Advanced CPU.

3 In the Scheduling Affinity panel, enter a comma-separated list of hyphenated processor ranges.

For example, "0,4-7" would indicate affinity with CPUs 0,4,5,6, and 7. Selecting all processors is identical
to selecting no affinity. You must provide at least as many processor affinities as you have virtual CPUs.

4 Click OK to save your changes and close the dialog box.

Change CPU Identification Mask Settings in the vSphere Web Client
CPU identification (CPU ID) masks control the CPU features visible to the virtual machine's guest operating
system. Masking or hiding CPU features can make a virtual machine widely available to ESXi hosts for
migration. vCenter Server compares the CPU features available to a virtual machine with the CPU features of
the destination host to determine whether to allow or disallow migration with vMotion.

For example, masking the AMD No eXecute (NX) and the Intel eXecute Disable (XD) bits prevents the virtual
machine from using these features, but provides compatibility that allows you to migrate virtual machines to
ESXi hosts that do not include this capability. When the NX/XD bit is visible to the guest operating system, the
virtual machine can use this feature, but you can migrate the virtual machine only to hosts on which the feature
is enabled.

Prerequisites

Power off the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.
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2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the CPU triangle to expand the CPU options.

5 In the CPUID Mask drop-down menu, select an NX/XD option.

Option Description

Hide the NX/XD flag from guest Increases vMotion compatibility.
Hiding the NX/XD flag increases vMotion compatibility between hosts, but
might disable certain CPU security features.

Expose the NX/XD flag to guest Keeps all CPU security features enabled.

Keep current Advanced setting
values for the NX/XD flag

Uses the NX/XD flag settings specified in the CPU Identification Mask dialog
box. Enabled only when current settings specify something other than what
is specified in the other NX/XD flag options, for example, if the NX/XD flag
bit setting varies with processor brand.

 
6 Click OK.

Change CPU Identification Mask Settings in the vSphere Client
CPU identification (CPU ID) masks control the CPU features visible to the virtual machine's guest operating
system. Masking or hiding CPU features can make a virtual machine widely available to ESXi hosts for
migration. vCenter Server compares the CPU features available to a virtual machine with the CPU features of
the destination host to determine whether to allow or disallow migration with vMotion.

For example, masking the AMD No eXecute (NX) and the Intel eXecute Disable (XD) bits prevents the virtual
machine from using these features, but provides compatibility that allows you to migrate virtual machines to
ESXi hosts that do not include this capability. When the NX/XD bit is visible to the guest operating system, the
virtual machine can use this feature, but you can migrate the virtual machine only to hosts on which the feature
is enabled.

NOTE   You rarely need to change the CPU identification mask configuration settings. Almost all changes are
made only to the NX/XD bit.

See the vCenter Server and Host Management documentation for detailed information about vMotion
compatibility and CPU masks.

Prerequisites

n Verify that you have access to the virtual machine in the vSphere Client inventory list.

n Power off the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced, select CPUID Mask.
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3 In the CPU Identification Mask panel, select an NX flag option.

Option Description

Hide the NX/XD flag from guest Increases vMotion compatibility.
Hiding the NX/XD flag increases vMotion compatibility between hosts, but
might disable certain CPU security features.

Expose the NX/XD flag to guest Keeps all CPU security features enabled.

Keep current Advanced setting
values for the NX/XD flag

Uses the NX/XD flag settings specified in the CPU Identification Mask dialog
box. Enabled only when current settings specify something other than what
is specified in the other NX/XD flag options, for example, if the NX/XD flag
bit setting varies with processor brand.

 
4 (Optional) To edit mask values other than the NX bit or to set NX mask values to states other than “0” or

“H”, click Advanced.

a Select the relevant tab.

b Click a row and edit the mask value.

To view an explanation of a values symbol, click Legend.

c Click OK to apply the changes and return to the Virtual Machine Properties dialog box.

5 Click OK to save your changes and close the dialog box.

Change CPU/MMU Virtualization Settings in the vSphere Web Client
ESXi can determine whether a virtual machine should use hardware support for virtualization. It makes this
determination based on the processor type and the virtual machine. Overriding the automatic selection can
provide better performance for some use cases.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the CPU triangle to expand the CPU settings.

5 From the CPU/MMU Virtualization drop-down menu, select an instruction set.

n Automatic

n Software CPU and MMU

n Hardware CPU, Software MMU

n Hardware CPU and MMU

6 Click OK.
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Change CPU/MMU Virtualization Settings in the vSphere Client
ESXi can determine whether a virtual machine should use hardware support for virtualization. It makes this
determination based on the processor type and the virtual machine. Overriding the automatic selection can
provide better performance for some use cases.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced, select CPU/MMU Virtualization.

3 Select an instruction set.

n Automatic

n Use only software virtualization

n Use hardware support for CPU virtualization (VT/AMD-V) only

n Use hardware support for both CPU and MMU virtualization (VT/AMD-V and EPT/RVI)

4 Click OK to save your changes and close the dialog box.

Virtual Memory Configuration
You can add, change, or configure virtual machine memory resources or options to enhance virtual machine
performance. You can set most of the memory parameters during virtual machine creation or after the guest
operating system is installed. Some actions require that you power off the virtual machine before changing the
settings.

Memory resource configuration is distinct from the virtual hardware memory size, which you configure on
the Hardware tab. The memory resource setting determines how much of the host's memory is allocated to a
virtual machine. The virtual hardware memory size determines how much memory applications that are
running inside the virtual machine have available to them. A virtual machine cannot benefit from more
memory resources than its configured virtual hardware memory size. The ESXi host caps memory resource
use to the maximum useful for the virtual machine, so you can accept the default of Unlimited memory
resources.

Change the Memory Configuration in the vSphere Web Client
You can reconfigure the memory allocated to a virtual machine.

Minimum memory size is 4MB for virtual machines that use BIOS firmware. Virtual machines that use EFI
firmware require at least 96MB of RAM or they cannot power on.

Maximum memory size for a virtual machine depends on the host's physical memory and the virtual machine's
hardware version.

If the virtual machine memory is greater than the host memory size, swapping occurs, which can have a severe
effect on virtual machine performance. The memory size must be a multiple of 4MB. The maximum for best
performance represents the threshold above which the host’s physical memory is insufficient to run the virtual
machine at full speed. This value fluctuates as conditions on the host change, for example, as virtual machines
are powered on or off.
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Table 8-6.  Maximum Virtual Machine Memory

Introduced in Host Version Virtual Machine Version Maximum Memory Size

ESXi 5.0 8 1011GB

ESX/ESXi 4.x 7 255GB

ESX/ESXi 3.x 4 65,532MB

The ESXi host version indicates when support began for the increased memory size. For example, the memory
size of a version 4 virtual machine running on ESXi 5.0 is restricted to 65,532MB.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 In the RAM text box, type the amount of RAM to assign to the virtual machine or select one of the suggested
values from the drop-down menu.

4 Select whether the memory is specified in MB or GB.

5 Click OK.

Change the Memory Configuration in the vSphere Client
You can reconfigure the memory allocated to a virtual machine's hardware.

Minimum memory size is 4MB for virtual machines that use BIOS firmware. Virtual machines that use EFI
firmware require at least 96MB of RAM or they cannot power on.

Maximum memory size for a virtual machine depends on the host's physical memory and the virtual machine's
hardware version.

If the virtual machine memory is greater than the host memory size, swapping occurs, which can have a severe
effect on virtual machine performance. The memory size must be a multiple of 4MB. The maximum for best
performance represents the threshold above which the host’s physical memory is insufficient to run the virtual
machine at full speed. This value fluctuates as conditions on the host change, for example, as virtual machines
are powered on or off.

Table 8-7.  Maximum Virtual Machine Memory

Introduced in Host Version Virtual Machine Version Maximum Memory Size

ESXi 5.0 8 1011GB

ESX/ESXi 4.x 7 255GB

ESX/ESXi 3.x 4 65,532MB

The ESXi host version indicates when support began for the increased memory size. For example, the memory
size of a version 4 virtual machine running on ESXi 5.0 is restricted to 65,532MB.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select Memory.
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3 Adjust the amount of memory allocated to the virtual machine.

4 Click OK to save your changes and close the dialog box.

Allocate Memory Resources in the vSphere Web Client
You can change the amount of memory resources allocated to a virtual machine by using the shares,
reservations, and limits settings.

The following user-defined settings affect the memory resource allocation of a virtual machine.

Limit Places a limit on the consumption of memory for a virtual machine. This value
is expressed in megabytes.

Reservation Specifies the guaranteed minimum allocation for a virtual machine. The
reservation is expressed in megabytes. If the reservation cannot be met, the
virtual machine will not power on.

Shares Each virtual machine is granted a number of memory shares. The more shares
a virtual machine has, the greater share of host memory it receives. Shares
represent a relative metric for allocating memory capacity. For more
information about share values, see the vSphere Resource Management
documentation.

Assigning a reservation to a virtual machine that is larger than its configured memory is wasteful. The
vSphere Web Client prevents you from making such an assignment on the Resources tab. If you give a virtual
machine a large reservation and reduce its configured memory size on the Hardware tab, the reservation is
reduced to match the new configured memory size. You must power off the virtual machine before configuring
memory resources.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the Memory triangle to expand the memory options.

5 Allocate the memory capacity for the virtual machine.

Option Description

Reservation Guaranteed memory allocation for this virtual machine.

Limit Upper limit for this virtual machine’s memory allocation. Select Unlimited
to specify no upper limit.

Shares The values Low, Normal, High, and Custom are compared to the sum of all
shares of all virtual machines on the server.

 
6 Click OK.
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Allocate Memory Resources in the vSphere Client
You can change the amount of memory resources allocated to a virtual machine by using the shares,
reservations, and limits settings.

A virtual machine has three user-defined settings that affect its memory resource allocation.

Limit Places a limit on the consumption of memory for a virtual machine. This value
is expressed in megabytes.

Reservation Specifies the guaranteed minimum allocation for a virtual machine. The
reservation is expressed in megabytes.

Shares Each virtual machine is granted a number of memory shares. The more shares
a virtual machine has, the more often it gets a time slice of a memory when no
memory idle time is present. Shares represent a relative metric for allocating
memory capacity. For more information about share values, see the vSphere
Resource Management documentation.

Assigning a virtual machine a reservation larger than its configured memory is wasteful. The vSphere Client
does not allow you to make such an assignment on the Resources tab. If you give a virtual machine a large
reservation and then reduce its configured memory size on the Hardware tab, the reservation is reduced to
match the new configured memory size. You must power off the virtual machine before configuring memory
resources.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Resources tab and select Memory.

3 Allocated the memory capacity for this virtual machine.

Option Description

Shares The values Low, Normal, High, and Custom are compared to the sum of all
shares of all virtual machines on the server. You can use share allocation
symbolic values to configure their conversion into numeric values.

Reservation Guaranteed memory allocation for this virtual machine.

Limit Upper limit for this virtual machine’s memory allocation.

Unlimited No upper limit is specified.
 

4 Click OK to save your changes and close the dialog box.

Change Memory Hot Add Settings in the vSphere Web Client
Memory hot add lets you add memory resources for a virtual machine while the machine is powered on.

Enabling memory hot add produces some extra memory overhead on theESXi host for the virtual machine.

Prerequisites

n Power off the virtual machine.

n Ensure that the virtual machine has a guest operating system that supports memory hot add functionality.

n Ensure that the virtual machine is using hardware version 7 or later.

n Ensure that VMware Tools is installed.
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Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the Memory triangle to expand the memory options.

5 Select Enable to enable adding memory to the virtual machine while it is powered on.

6 Click OK.

Change Memory Hot-Add Settings in the vSphere Client
Memory hot add lets you add memory resources for a virtual machine while the machine is powered on.

Prerequisites

n The virtual machine has a guest operating system that supports Memory hot add functionality.

n The virtual machine is using hardware version 7 or later.

n VMware Tools is installed.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced, select Memory/CPU Hotplug.

3 Enable or disable memory hot add.

n Enable memory hot add for this virtual machine.

n Disable memory hot add for this virtual machine.

4 Click OK to save your changes and close the dialog box.

Associate Memory Allocation with a NUMA Node in the vSphere Web Client
You can specify that all future memory allocations on a virtual machine use pages associated with a single
NUMA node. The NUMA code is also known as manual memory affinity. When the virtual machine uses local
memory, the performance improves on that virtual machine.

The following conditions apply to memory optimization with NUMA:

n The NUMA option is available only if the host uses NUMA memory architecture.

n Affinity settings are meaningful only when used to modify the performance of a specific set of virtual
machines on one host. This option is not available when the virtual machine resides on a DRS cluster. All
affinity values are cleared when you move the virtual machine to a new host.

n You can specify nodes to use for future memory allocations only if you also specified CPU affinity. If you
make manual changes only to the memory affinity settings, automatic NUMA rebalancing does not work
properly.

n Checking all the boxes is the same as applying no affinity.

For information about NUMA and advanced memory resources, including usage examples, see the Resource
Management documentation.
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Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the Memory triangle to expand the Memory options.

5 In the NUMA Memory Affinity panel, set the NUMA node affinity for the virtual machine.

6 Click OK.

Associate Memory Allocations with a NUMA Node in the vSphere Client
You can specify that all future memory allocations on a virtual machine use pages associated with a single
NUMA node (also known as manual memory affinity). When the virtual machine uses local memory, the
performance improves on that virtual machine.

The following conditions apply to memory optimization with NUMA:

n The NUMA option is available on the Advanced Memory Resources page only if the host uses NUMA
memory architecture.

n Affinity settings are meaningful only when used to modify the performance of a specific set of virtual
machines on one host. This option is not available when the virtual machine resides on a DRS cluster. All
affinity values are cleared when you move the virtual machine to a new host.

n You can specify nodes to use for future memory allocations only if you have also specified CPU affinity.
If you make manual changes only to the memory affinity settings, automatic NUMA rebalancing does not
work properly.

n Checking all the boxes is the same as applying no affinity.

For information about NUMA and advanced memory resources, including usage examples, see the Resource
Management documentation.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Select the Resources tab, and select Memory.

3 In the NUMA Memory Affinity panel, set the NUMA node affinity for the virtual machine.

n No affinity

n Use memory from nodes

4 Click OK to save your changes and close the dialog box.
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Change the Swap File Location in the vSphere Web Client
When a virtual machine is powered on, the system creates a VMkernel swap file to serve as a backing store for
the virtual machine's RAM contents. You can accept the default swap file location or save the file to a different
location. By default, the swap file is stored in the same location as the virtual machine's configuration file.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click VM Options.

4 Click the Advanced triangle to expand the advanced options.

5 Select an option.

Option Description

Default Stores the virtual machine swap file at the default location defined by the
host or cluster swap file settings.

Always store with the virtual
machine

Stores the virtual machine swap file in the same folder as the virtual machine
configuration file.

Store in the host's swapfile datastore If the host or cluster settings define a location for the swap file, this location
is used. Otherwise, the swap file is stored with the virtual machine.

 
6 Click OK.

Change the Swap File Location in the vSphere Client
When a virtual machine is powered on, the system creates a VMkernel swap file to serve as a backing store for
the virtual machine's RAM contents. You can accept the default swap file location or save the file to a different
location. By default, the swap file is stored in the same location as the virtual machine's configuration file.

For more information about host swap file settings, see the vCenter Server and Host Management documentation.
For more information about cluster settings, see the Resource Management documentation.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Option tab and under Advanced, select Swapfile Location.

3 Select an option.

Option Description

Default Stores the virtual machine swap file at the default location defined by the
host or cluster swap file settings.

Always store with the virtual
machine

Stores the virtual machine swap file in the same folder as the virtual machine
configuration file.

Store in the host's swapfile datastore Stores the virtual machine swap file in the swap file datastore defined by the
host or cluster swap file settings.

 
4 Click OK to save your changes and close the dialog box.
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Network Virtual Machine Configuration
ESXi networking features provide communication between virtual machines on the same host, between virtual
machines on different hosts, and between other virtual and physical machines. The networking features also
allow management of ESXi hosts and provide communication between VMkernel services (NFS, iSCSI, or
vSphere vMotion) and the physical network. When you configure networking for a virtual machine, you select
or change an adapter type, a network connection, and whether to connect the network when the virtual machine
powers on.

Network Adapter Types
When you configure a virtual machine, you can add network adapters (NICs) and specify the adapter type.

The type of network adapters that are available depend on the following factors:

n The virtual machine version, which depends on what host created it or most recently updated it.

n Whether the virtual machine has been updated to the latest version for the current host.

n The guest operating system.

The following NIC types are supported:

E1000 Emulated version of the Intel 82545EM Gigabit Ethernet NIC, with drivers
available in most newer guest operating systems, including Windows XP and
later and Linux versions 2.4.19 and later.

Flexible Identifies itself as a Vlance adapter when a virtual machine boots, but initializes
itself and functions as either a Vlance or a VMXNET adapter, depending on
which driver initializes it. With VMware Tools installed, the VMXNET driver
changes the Vlance adapter to the higher performance VMXNET adapter.

Vlance Emulated version of the AMD 79C970 PCnet32 LANCE NIC, an older 10 Mbps
NIC with drivers available in most 32bit guest operating systems except
Windows Vista and later. A virtual machine configured with this network
adapter can use its network immediately.

VMXNET Optimized for performance in a virtual machine and has no physical
counterpart. Because operating system vendors do not provide built-in drivers
for this card, you must install VMware Tools to have a driver for the VMXNET
network adapter available.

VMXNET 2 (Enhanced) Based on the VMXNET adapter but provides high-performance features
commonly used on modern networks, such as jumbo frames and hardware
offloads. VMXNET 2 (Enhanced) is available only for some guest operating
systems on ESX/ESXi 3.5 and later.

VMXNET 3 Next generation of a paravirtualized NIC designed for performance. VMXNET
3 offers all the features available in VMXNET 2 and adds several new features,
such as multiqueue support (also known as Receive Side Scaling in Windows),
IPv6 offloads, and MSI/MSI-X interrupt delivery. VMXNET 3 is not related to
VMXNET or VMXNET 2.

For network adapter compatibility considerations, see the VMware Compatibility Guide.
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Network Adapters and Legacy Virtual Machines
Legacy virtual machines are virtual machines that are supported by the product in use, but are not current for
that product. The default network adapter types for all legacy virtual machines depend on the adapters
available and compatible to the guest operating system and the version of virtual hardware on which the virtual
machine was created.

If you do not upgrade a virtual machine to correspond with an upgrade to a newer version of an ESXi host,
your adapter settings remain unchanged. If you upgrade your virtual machine to take advantage of newer
virtual hardware, your default adapter settings will likely change to be compatible with the guest operating
system and upgraded host hardware.

To verify the network adapters that are available to your supported guest operating system for a particular
version of vSphere ESXi, see the VMware Compatibility Guide.

Change the Virtual Network Adapter (NIC) Configuration in the
vSphere Web Client

You can change the power-on connection setting, the MAC address, and the network connection for the virtual
network adapter configuration for a virtual machine.

Prerequisites

Required privilege: Network.Assign network on a network if you are changing the network the virtual
machine connects to.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle next to the network adapter to expand the network adapter options.

5 (Optional) Specify how the MAC address is assigned.

n Select Automatic to automatically assign a MAC address.

n Select Manual to manually enter the MAC address you want.

6 From the Network Connection drop-down menu, select the network to connect to.

The menu lists all networks configured for virtual machine use on the host.

7 (Optional) Change the Status settings.

Option Description

Connected Select or deselect this option while the virtual machine is running to connect
or disconnect the virtual network adapter. This check box is not available
when the virtual machine is not powered on.

Connect at power on Select this option for the virtual network adapter to connect to the network
when the virtual machine powers on. If you do not check this option, you
must manually connect the adapter in order for the virtual machine to access
the network.

 
8 Click OK.
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Change the Virtual Network Adapter (NIC) Configuration in the vSphere Client
You can change the power-on connection setting, the MAC address, and the network connection for the virtual
network adapter configuration for a virtual machine.

Prerequisites

Required Privileges:

n Virtual machine.Configuration.Modify device settings for editing the MAC address and network.

n Virtual machine.Interaction.Device connection for changing Connect and Connect at power on.

n Network.Assign network

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the appropriate NIC in the Hardware list.

3 (Optional) To connect the virtual NIC when the virtual machine is powered on, select Connect at power
on.

4 (Optional) Click the blue information icon under DirectPath I/O to view details regarding the virtual NIC's
DirectPath I/O status and capability.

5 Select an option for MAC address configuration.

Option Description

Automatic vSphere assigns a MAC address automatically.

Manual Type the MAC address to use.
 

6 Configure the Network Connection for the virtual NIC.

Option Description

Standard settings The virtual NIC connects to a standard or distributed port group. Select the
port group for the virtual NIC to connect to from the Network label drop-
down menu.

Advanced settings The virtual NIC connects to a specific port on a vSphere distributed switch.
This option appears only when a vSphere distributed switch is available.
a Click Switch to advanced settings.
b Select a vSphere distributed switch for the virtual NIC to use from the

VDS drop-down menu.
c Type the Port ID of the distributed port for virtual NIC to connect to.

 
7 Click OK to save your changes and close the dialog box.

Add a Network Adapter to a Virtual Machine in the vSphere Web Client
When you add a network adapter (NIC) to a virtual machine, you select the adapter type, network connection,
and whether the device should connect when the virtual machine is powered on.

Prerequisites

Required privilege: Network.Assign network on a network.
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Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select Network and click Add device.

The new network adapter appears in the virtual devices list above.

5 Click the triangle next to the new network adapter to expand the network adapter options.

6 From the Adapter Type drop-down menu, select the adapter type to use.

7 (Optional) Specify how the MAC address is assigned.

n Select Automatic to automatically assign a MAC address.

n Select Manual to manually enter the MAC address you want.

8 From the Network Connection drop-down menu, select the network to connect to.

The menu lists all networks configured for virtual machine use on the host.

9 (Optional) Change the Device status settings.

Option Description

Connected Select or deselect this option while the virtual machine is running to connect
or disconnect the virtual network adapter. This check box is not available
when the virtual machine is not powered on.

Connect at power on Select this option for the virtual network adapter to connect to the network
when the virtual machine powers on. If you do not check this option, you
must manually connect the adapter in order for the virtual machine to access
the network.

 
10 Click OK.

Add a Network Adapter to a Virtual Machine in the vSphere Client
When you add a Network adapter (NIC) to a virtual machine, you select the adapter type, the network
connection, and whether the device should connect when the virtual machine is powered on.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select Ethernet Adapter, and click Next.

4 Select an adapter type from the drop-down menu.

5 In the Network connection panel, select either a named network with a specified label or a legacy network.

6 To connect the virtual NIC when the virtual machine is powered on, select Connect at power on.

7 Click Next.

8 Review your selections and click Finish.

9 Click OK to save your changes and close the dialog box.
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Parallel and Serial Port Configuration
Parallel and serial ports are interfaces for connecting peripherals to the virtual machine. The virtual serial port
can connect to a physical serial port or to a file on the host computer. You can also use it to establish a direct
connection between two virtual machines or a connection between a virtual machine and an application on
the host computer. You can add parallel and serial ports and change the serial port configuration.

Using Serial Ports with vSphere Virtual Machines
You can set up virtual serial ports connections for vSphere virtual machines in several ways. The connection
method that you select depends on the task that you need to accomplish.

You can set up virtual serial ports to send data in the following ways.

Physical serial port on
the host

Sets the virtual machine to use a physical serial port on the host computer. This
method is useful for using an external modem or a hand-held device in a virtual
machine.

Output to file Sends output from the virtual serial port to a file on the host computer. This
method is useful for capturing the data that a program running in the virtual
machine sends to the virtual serial port.

Connect to a named pipe Sets a direct connection between two virtual machines or a connection between
a virtual machine and an application on the host computer. With this method,
two virtual machines or a virtual machine and a process on the host can
communicate as if they were physical machines connected by a serial cable. For
example, you can use this option for remote debugging on a virtual machine.

Connect over the
network

Enables a serial connection to and from a virtual machine's serial port over the
network. The Virtual Serial Port Concentrator (vSPC) aggregates traffic from
multiple serial ports onto one management console. vSPC behavior is similar
to physical serial port concentrators. Using a vSPC also allows network
connections to a virtual machine's serial ports to migrate seamlessly when you
use vMotion to migrate the virtual machine. For requirements and steps to
configure the Avocent ACS v6000 virtual serial port concentrator, see 
http://kb.vmware.com/kb/1022303.

Server and Client Connections for Named Pipe and Network Serial Ports
You can select a client or server connection for serial ports. Your selection determines whether the system waits
for a connection or initiates it. Typically, to control a virtual machine over a serial port, you select a server
connection. This selection allows you to control the connections, which is useful if you connect to the virtual
machine only occasionally. To use a serial port for logging, select a client connection. This selection allows the
virtual machine to connect to the logging server when the virtual machine starts and to disconnect when it
stops.

Adding a Firewall Rule Set for Network Serial Ports
Before you connect network-backed virtual serial ports, you must add one of the following firewall rule sets
to prevent the firewall from blocking traffic:

n VM serial port connected to vSPC. Use to connect the serial port output through a network with the Use
virtual serial port concentrator option enabled to allow only outgoing communication from the host.
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n VM serial port connected over network. Use to connect the serial port output through a network without
the virtual serial port concentrator.

IMPORTANT   Do not change the allowed IP list for either rule set. Updates to the IP list can affect other network
services that might be blocked by the firewall.

For details about adding rule sets to a firewall, see the vSphere Security documentation.

Physical Serial Port Conditions
When you use a physical serial port for serial port passthrough from an ESXi host to a virtual machine, the
following conditions apply:

Supported Not Supported

Serial ports that are integrated
into the motherboard

Migration with vMotion

Serial ports connected through USB are not supported for serial port passthrough. They
might be supported by USB passthrough from an ESXi host to a virtual machine. See “USB
Configuration from an ESXi Host to a Virtual Machine,” on page 149.

Adding a Firewall Rule Set for Serial Port Network Connections
If you add or configure a serial port that is backed by a remote network connection, ESXi firewall settings can
prevent transmissions.

Before you connect network-backed virtual serial ports, you must add one of the following firewall rule sets
to prevent the firewall from blocking communication:

n VM serial port connected to vSPC. Use to connect the serial port output through a network with the Use
virtual serial port concentrator option enabled to allow only outgoing communication from the host.

n VM serial port connected over network. Use to connect the serial port output through a network without
the virtual serial port concentrator.

IMPORTANT   Do not change the allowed IP list for either rule set. Updates to the IP list can affect other network
services that might be blocked by the firewall.

For details about allowing access to an ESXi service through the firewall, see the vSphere Security
documentation.

Change the Serial Port Configuration in the vSphere Web Client
A virtual machine can use up to four virtual serial ports. You can connect the virtual serial port to a physical
serial port or to a file on the host computer. You can also use a host-side named pipe to set up a direct connection
between two virtual machines or a connection between a virtual machine and an application on the host
computer. In addition, you can use a port or vSPC URI to connect a serial port over the network.

Virtual machines can be in a powered-on state during configuration.

Prerequisites

n Check that you known the correct media types for the port to access, vSPC connections, and any conditions
that might apply. See “Using Serial Ports with vSphere Virtual Machines,” on page 111.

n To connect a serial port over a network, add a Firewall rule set. See “Adding a Firewall Rule Set for Serial
Port Network Connections,” on page 112.

n Required privileges:

n Virtual machine.Configuration.Modify device settings on the virtual machine.
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n Virtual machine.Interaction.Device connection on the virtual machine to change the device
connection status.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle next to the serial port to expand the serial port options.

5 (Optional) Change the Device status settings.

Option Description

Connected Connects or disconnects the device while the virtual machine is running.

Connect at power on Connects the device whenever you power on the virtual machine. You can
change this setting when the virtual machine is either powered on or
powered off.

 
6 Select a connection type.

Option Action

Use physical serial port Select this option to have the virtual machine use a physical serial port on
the host computer. Select the serial port from the drop-down menu.

Use output file Select this option to send output from the virtual serial port to a file on the
host computer. Browse to select an output file to connect the serial port to.

Use named pipe Select this option to set a direct connection between two virtual machines or
a connection between a virtual machine and an application on the host
computer.
a Type a name for the pipe in the Pipe Name field.
b Select the Near end and Far end of the pipe from the drop-down menus.

Connect over the network Select Use network to connect through a remote network.
a Select the network backing.

n Select Server to have the virtual machine monitor incoming
connections from other hosts.

n Select Client to have the virtual machine initiate a connection to
another host.

b Enter a Port URI.

The URI is the remote end of the serial port to which the virtual machine's
serial port should connect.

c If vSPC is used as an intermediate step to access all virtual machines
through a single IP address, select Use Virtual Serial Port
Concentrator and enter the vSPC URI location.

 
7 (Optional) Select Yield on poll.

Select this option only for guest operating systems that use serial ports in polled mode. This option
prevents the guest from consuming excessive CPUs.

8 Click OK.
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Example: Establishing Serial Port Network Connections to a Client or Server
If you do not use vSPC and you configure your virtual machine with a serial port connected as a server with
a telnet://:12345 URI, you can connect to your virtual machine's serial port from your Linux or Windows
operating system.

telnet yourESXiServerIPAddress 12345

Similarly, if you run the Telnet Server on your Linux system on port 23 (telnet://yourLinuxBox:23), you
configure the virtual machine as a client URI.

telnet://yourLinuxBox:23

The virtual machine initiates the connection to your Linux system on port 23.

Change the Serial Port Configuration in the vSphere Client
A virtual machine can use up to four virtual serial ports. You can connect the virtual serial port to a physical
serial port or to a file on the host computer. You can also set up a direct connection between two virtual
machines or a connection between a virtual machine and an application on the host computer by using a host-
side-named pipe. In addition, you can use a port or vSPC URI to connect a serial port over the network.

Virtual machines can be in a powered-on state during configuration.

Prerequisites

n Check that you known the correct media types for the port to access, vSPC connections, and any conditions
that might apply. See “Using Serial Ports with vSphere Virtual Machines,” on page 111.

n To connect a serial port over a network, add a Firewall rule set. See “Adding a Firewall Rule Set for Serial
Port Network Connections,” on page 112.

n Required privilege: Virtual machine.Configuration.Device connection

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select a serial port in the Hardware list.

3 (Optional) Change the Device status settings.

Option Description

Connected Connects or disconnects the device while the virtual machine is running.

Connect at power on Connects the device whenever you power on the virtual machine. You can
change this setting when the virtual machine is either powered on or
powered off.

 
4 Select a connection type.

Option Action

Use physical serial port Select this option to have the virtual machine use a physical serial port on
the host computer. Select the serial port from the drop-down menu.

Use output file Select this option to send output from the virtual serial port to a file on the
host computer. Browse to select an output file to connect the serial port to.
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Option Action

Use named pipe Select this option to set a direct connection between two virtual machines or
a connection between a virtual machine and an application on the host
computer.
a Type a name for the pipe in the Pipe Name field.
b Select the Near end and Far end of the pipe from the drop-down menus.

Connect over the network Select Use network to connect through a remote network.
a Select the network backing.

n Select Server to have the virtual machine monitor incoming
connections from other hosts.

n Select Client to have the virtual machine initiate a connection to
another host.

b Enter a Port URI.

The URI is the remote end of the serial port to which the virtual machine's
serial port should connect.

c If vSPC is used as an intermediate step to access all virtual machines
through a single IP address, select Use Virtual Serial Port
Concentrator and enter the vSPC URI location.

 
5 (Optional) Select Yield on poll.

Select this option only for guest operating systems that use serial ports in polled mode. This option
prevents the guest from consuming excessive CPUs.

6 Click OK to save your changes and close the dialog box.

Example: Establishing Serial Port Network Connections to a Client or Server
If you do not use vSPC and you configure your virtual machine with a serial port connected as a server with
a telnet://:12345 URI, you can connect to your virtual machine's serial port from your Linux or Windows
operating system.

telnet yourESXiServerIPAddress 12345

Similarly, if you run the Telnet Server on your Linux system on port 23 (telnet://yourLinuxBox:23), you
configure the virtual machine as a client URI.

telnet://yourLinuxBox:23

The virtual machine initiates the connection to your Linux system on port 23.

Add a Serial Port to a Virtual Machine in the vSphere Web Client
A virtual machine can use up to four virtual serial ports. You can connect the virtual serial port to a physical
serial port or to a file on the host computer. You can also use a host-side named pipe to set up a direct connection
between two virtual machines or a connection between a virtual machine and an application on the host
computer. In addition, you can use a port or vSPC URI to connect a serial port over the network.

Prerequisites

n Verify that the virtual machine is powered off.

n Check that you known the correct media types for the port to access, vSPC connections, and any conditions
that might apply. See “Using Serial Ports with vSphere Virtual Machines,” on page 111.

n To connect a serial port over a network, add a Firewall rule set. See “Adding a Firewall Rule Set for Serial
Port Network Connections,” on page 112.

n Required privilege: Virtual Machine .Configuration.Add or Remove Device

Chapter 8 Configuring Virtual Machines

VMware, Inc.  115



Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select Serial Port and click Add device.

The serial port appears in the virtual device list.

5 Click the triangle next to the serial port to expand the serial port options.

6 Select a connection type.

Option Action

Use physical serial port Select this option to have the virtual machine use a physical serial port on
the host computer. Select the serial port from the drop-down menu.

Use output file Select this option to send output from the virtual serial port to a file on the
host computer. Browse to select an output file to connect the serial port to.

Use named pipe Select this option to set a direct connection between two virtual machines or
a connection between a virtual machine and an application on the host
computer.
a Type a name for the pipe in the Pipe Name field.
b Select the Near end and Far end of the pipe from the drop-down menus.

Connect over the network Select Use network to connect through a remote network.
a Select the network backing.

n Select Server to have the virtual machine monitor incoming
connections from other hosts.

n Select Client to have the virtual machine initiate a connection to
another host.

b Enter a Port URI.

The URI is the remote end of the serial port to which the virtual machine's
serial port should connect.

c If vSPC is used as an intermediate step to access all virtual machines
through a single IP address, select Use Virtual Serial Port
Concentrator and enter the vSPC URI location.

 
7 (Optional) Select Yield on poll.

Select this option only for guest operating systems that use serial ports in polled mode. This option
prevents the guest from consuming excessive CPUs.

8 (Optional) Deselect Connect at power on if you do not want the parallel port device to be connected when
the virtual machine powers on.

9 Click OK.

Example: Establishing Serial Port Network Connections to a Client or Server
If you do not use vSPC and you configure your virtual machine with a serial port connected as a server with
a telnet://:12345 URI, you can connect to your virtual machine's serial port from your Linux or Windows
operating system.

telnet yourESXiServerIPAddress 12345
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Similarly, if you run the Telnet Server on your Linux system on port 23 (telnet://yourLinuxBox:23), you
configure the virtual machine as a client URI.

telnet://yourLinuxBox:23

The virtual machine initiates the connection to your Linux system on port 23.

Add a Serial Port to a Virtual Machine in the vSphere Client
A virtual machine can use up to four virtual serial ports. You can connect the virtual serial port to a physical
serial port or to a file on the host computer. You can also use a host-side-named pipe to set up a direct connection
between two virtual machines or a connection between a virtual machine and an application on the host
computer. In addition, you can use a port or vSPC URI to connect a serial port over the network.

Prerequisites

n Verify that the virtual machine is powered off.

n Familiarize yourself with the media types for the port to access, vSPC connections, and any conditions
that might apply. See “Using Serial Ports with vSphere Virtual Machines,” on page 111.

n To connect a serial port over a network, add a Firewall rule set. See “Adding a Firewall Rule Set for Serial
Port Network Connections,” on page 112.

n Required privilege: Virtual Machine .Configuration.Add or Remove Device

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select Add.

3 Select Serial Port and click Next.

4 On the Serial Port Type page, select the type of media for the port to access.

Option Description

Use physical serial port on the host Click Next and select the port from the drop-down menu.

Output to file Click Next and browse to the location of the file on the host to store the output
of the virtual serial port.

Connect to named pipe a Click Next and type a name for the pipe in the Pipe Name field.
b Select the Near end and Far end of the pipe from the drop-down menus.

Connect via network a Click Next and clickServer or Client and type the Port URI.

The URI is the remote end of the serial port to which the virtual machine's
serial port should connect.

b If vSPC is used as an intermediate step to access all virtual machines
through a single IP address, select Use Virtual Serial Port Concentrator
(vSPC) and type the vSPC URI location.

 
5 (Optional) Deselect Connect at power on if you do not want the parallel port device to be connected when

the virtual machine powers on.

6 (Optional) Select Yield on poll.

Select this option only for guest operating systems that use serial ports in polled mode. This option
prevents the guest from consuming excessive CPUs.

7 Review the information on the Ready to Complete page and click Finish.
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Example: Establishing Serial Port Network Connections to a Client or Server
If you do not use vSPC and you configure your virtual machine with a serial port connected as a server with
a telnet://:12345 URI, you can connect to your virtual machine's serial port from your Linux or Windows
operating system.

telnet yourESXiServerIPAddress 12345

Similarly, if you run the Telnet Server on your Linux system on port 23 (telnet://yourLinuxBox:23), you
configure the virtual machine as a client URI.

telnet://yourLinuxBox:23

The virtual machine initiates the connection to your Linux system on port 23.

Change the Parallel Port Configuration in the vSphere Web Client
You can change the output file and schedule the parallel port to connect or disconnect when the virtual machine
powers on.

You can use a parallel port on the virtual machine to send output to a file. You cannot use a physical parallel
port on ESXi hosts.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Locate the parallel port in the device list and expand the menu.

5 Select Output to file and click Browse to navigate to the file location.

6 (Optional) Deselect Connect at power on if you do not want the parallel port device to be connected when
the virtual machine powers on.

7 Click OK.

Change the Parallel Port Configuration in the vSphere Client
You can change the output file and schedule the parallel port to connect or disconnect when the virtual machine
powers on.

You can use a parallel port on the virtual machine to send output to a file. You cannot use a physical parallel
port on ESXi hosts.

Virtual machines can be powered on during the configuration

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the parallel port to change.

3 Select Output to file and click Browse to navigate to the file location.

4 (Optional) Deselect Connect at power on if you do not want the parallel port device to be connected when
the virtual machine powers on.
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5 Click OK to save your changes and close the dialog box.

Add a Parallel Port to a Virtual Machine in the vSphere Web Client
You can add a parallel port to a virtual machine and send output to a file on the host computer.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select Parallel Port and click Add device.

The parallel port appears in the virtual device list above.

5 Select Output to file and browse to the location of the file.

6 (Optional) Select or deselect the Connected check box to connect or disconnect the device.

7 (Optional) Select Connect At Power On to connect the device when the virtual machine powers on.

8 Click OK.

Add a Parallel Port to a Virtual Machine in the vSphere Client
You can use the Add Hardware wizard to add and configure a parallel port to send output to a file on the host
computer.

Prerequisites

n Verify that the virtual machine is powered off.

n Required privilege: Virtual machine.Configuration.Add or remove device

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select Parallel Port and click Next.

4 Select Output to file and browse to the location of the file.

5 (Optional) Select or deselect the Connected check box to connect or disconnect the device.

6 Click Next.

7 Review the information on the Ready to Complete page, and click Finish.

Configure Fibre Channel NPIV Settings in the vSphere Web Client
N-port ID virtualization (NPIV) provides the ability to share a single physical Fibre Channel HBA port among
multiple virtual ports, each with unique identifiers. This capability lets you control virtual machine access to
LUNs on a per-virtual machine basis.

Each virtual port is identified by a pair of world wide names (WWNs): a world wide port name (WWPN) and
a world wide node name (WWNN). These WWNs are assigned by vCenter Server.
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For detailed information on how to configure NPIV for a virtual machine, see vSphere Storage.

NPIV support is subject to the following limitations:

n NPIV must be enabled on the SAN switch. Contact the switch vendor for information about enabling NPIV
on their devices.

n NPIV is supported only for virtual machines with RDM disks. Virtual machines with regular virtual disks
continue to use the WWNs of the host’s physical HBAs.

n The physical HBAs on the ESXi host must have access to a LUN using its WWNs in order for any virtual
machines on that host to have access to that LUN using their NPIV WWNs. Ensure that access is provided
to both the host and the virtual machines.

n The physical HBAs on the ESXi host must support NPIV. If the physical HBAs do not support NPIV, the
virtual machines running on that host will fall back to using the WWNs of the host’s physical HBAs for
LUN access.

n Each virtual machine can have up to 4 virtual ports. NPIV-enabled virtual machines are assigned exactly
4 NPIV-related WWNs, which are used to communicate with physical HBAs through virtual ports.
Therefore, virtual machines can utilize up to 4 physical HBAs for NPIV purposes.

Prerequisites

n To edit the virtual machine’s WWNs, power off the virtual machine.

n Verify that the virtual machine has a datastore containing a LUN that is available to the host.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click VM Options.

4 Click the Fibre Channel NPIV triangle to expand the NPIV options.

5 (Optional) Select the Temporarily Disable NPIV for this virtual machine check box.

6 Select an option for assigning WWNs.

n To leave WWNs unchanged, select Leave unchanged.

n To have vCenter Server or the ESXi host generate new WWNs, select Generate New WWNs.

n To remove the current WWN assignments, select Remove WWN assignment.

7 Click OK.

Configure Fibre Channel NPIV Settings in the vSphere Client
N-port ID virtualization (NPIV) provides the ability to share a single physical Fibre Channel HBA port among
multiple virtual ports, each with unique identifiers. This capability lets you control virtual machine access to
LUNs on a per-virtual machine basis.

Each virtual port is identified by a pair of world wide names (WWNs): a world wide port name (WWPN) and
a world wide node name (WWNN). These WWNs are assigned by vCenter Server.

For detailed information on how to configure NPIV for a virtual machine, see vSphere Storage.

vSphere Virtual Machine Administration

120  VMware, Inc.



NPIV support is subject to the following limitations:

n NPIV must be enabled on the SAN switch. Contact the switch vendor for information about enabling NPIV
on their devices.

n NPIV is supported only for virtual machines with RDM disks. Virtual machines with regular virtual disks
continue to use the WWNs of the host’s physical HBAs.

n The physical HBAs on the ESXi host must have access to a LUN using its WWNs in order for any virtual
machines on that host to have access to that LUN using their NPIV WWNs. Ensure that access is provided
to both the host and the virtual machines.

n The physical HBAs on the ESXi host must support NPIV. If the physical HBAs do not support NPIV, the
virtual machines running on that host will fall back to using the WWNs of the host’s physical HBAs for
LUN access.

n Each virtual machine can have up to 4 virtual ports. NPIV-enabled virtual machines are assigned exactly
4 NPIV-related WWNs, which are used to communicate with physical HBAs through virtual ports.
Therefore, virtual machines can utilize up to 4 physical HBAs for NPIV purposes.

You can view or edit the virtual machines WWNs on the Options tab.

Prerequisites

n To edit the virtual machine’s WWNs, power off the virtual machine.

n Verify that the virtual machine has a datastore containing a LUN that is available to the host.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced select Fibre Channel NPIV.

3 (Optional) Select the Temporarily Disable NPIV for this virtual machine check box.

4 Assigned WWNs appear in the WWN Assignments panel.

n To leave WWNs unchanged, select Leave unchanged.

n To have vCenter Server or the ESXi host generate new WWNs, select Generate New WWNs.

n To remove the current WWN assignments, select Remove WWN assignment.

5 Click OK to save your changes and close the dialog box.

6 Provide the WWN assignments to your SAN administrator.

The administrator needs the assignments to configure virtual machine access to the LUN.

Virtual Disk Configuration
You can add virtual disks and add more space to existing disks, even when the virtual machine is running.
You can set most of the virtual disk parameters during virtual machine creation or after you install the guest
operating system.

You can store virtual machine data in a new virtual disk, an existing virtual disk, or a mapped SAN LUN. A
virtual disk, which appears as a single hard disk to the guest operating system, is composed of one or more
files on the host file system. You can copy or move virtual disks on the same hosts or between hosts.

For virtual machines running on an ESXi host, you can store the virtual machine data directly on a SAN LUN
instead of storing it in a virtual disk file. This ability is useful if you are running applications in your virtual
machines that must detect the physical characteristics of the storage device. Additionally, mapping a SAN
LUN allows you to use existing SAN commands to manage storage for the disk.
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When you map a LUN to a VMFS volume, vCenter Server creates a raw device mapping (RDM) file that points
to the raw LUN. Encapsulating disk information in a file allows vCenter Server to lock the LUN so that only
one virtual machine can write to it. This file has a .vmdk extension, but the file contains only disk information
that describes the mapping to the LUN on the ESXi system. The actual data is stored on the LUN. You cannot
deploy a virtual machine from a template and store its data on a LUN. You can store only its data in a virtual
disk file.

About Virtual Disk Provisioning Policies
When you perform certain virtual machine management operations, such as creating a virtual disk, cloning a
virtual machine to a template, or migrating a virtual machine, you can specify a provisioning policy for the
virtual disk file.

NFS datastores with Hardware Acceleration and VMFS datastores support the following disk provisioning
policies. On NFS datastores that do not support Hardware Acceleration, only thin format is available.

You can use Storage vMotion to transform virtual disks from one format to another.

Thick Provision Lazy
Zeroed

Creates a virtual disk in a default thick format. Space required for the virtual
disk is allocated when the virtual disk is created. Data remaining on the
physical device is not erased during creation, but is zeroed out on demand at
a later time on first write from the virtual machine.

Using the default flat virtual disk format does not zero out or eliminate the
possibility of recovering deleted files or restoring old data that might be present
on this allocated space. You cannot convert a flat disk to a thin disk.

Thick Provision Eager
Zeroed

A type of thick virtual disk that supports clustering features such as Fault
Tolerance. Space required for the virtual disk is allocated at creation time. In
contrast to the flat format, the data remaining on the physical device is zeroed
out when the virtual disk is created. It might take much longer to create disks
in this format than to create other types of disks.

Thin Provision Use this format to save storage space. For the thin disk, you provision as much
datastore space as the disk would require based on the value that you enter for
the disk size. However, the thin disk starts small and at first, uses only as much
datastore space as the disk needs for its initial operations.

NOTE   If a virtual disk supports clustering solutions such as Fault Tolerance,
do not make the disk thin.

If the thin disk needs more space later, it can grow to its maximum capacity
and occupy the entire datastore space provisioned to it. Also, you can manually
convert the thin disk into a thick disk.

Change the Virtual Disk Configuration in the vSphere Web Client
You can change the virtual device node, the size of the disk, and the persistence mode for virtual disk
configuration for a virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.
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3 Click Virtual Hardware.

4 Click the triangle next to a virtual disk to expand the disk options.

5 (Optional) To change the size of the disk, type a new value in the Provisioned Size text box and select the
units from the drop-down menu.

6 (Optional) Select a disk mode.

Option Description

Dependent Dependent disks are included in snapshots.

Independent - Persistent Disks in persistent mode behave like conventional disks on your physical
computer. All data written to a disk in persistent mode are written
permanently to the disk.

Independent - Nonpersistent Changes to disks in nonpersistent mode are discarded when you power off
or reset the virtual machine. With nonpersistent mode, you can restart the
virtual machine with a virtual disk in the same state every time. Changes to
the disk are written to and read from a redo log file that is deleted when you
power off or reset.

 
7 Click OK.

Change the Virtual Disk Configuration in the vSphere Client
You can change the virtual device node, the size of the disk, and the persistence mode for virtual disk
configuration for a virtual machine.

NOTE   The Manage Paths feature for RDM disks is not available for virtual machines on legacy hosts running
versions of ESX Server earlier than 3.0.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the hard disk to modify.

The name of the disk file and the disk type (thick or thin) appear in the upper-right pane.

3 Select a Virtual Device Node type from the drop-down menu.

4 To change the size of the disk, enter a new value in the Provisioned Size text box.

5 (Optional) To change the way disks are affected by snapshots, click Independent and select an option.

Option Description

Independent - Persistent Disks in persistent mode behave like conventional disks on your physical
computer. All data written to a disk in persistent mode are written
permanently to the disk.

Independent - Nonpersistent Changes to disks in nonpersistent mode are discarded when you power off
or reset the virtual machine. With nonpersistent mode, you can restart the
virtual machine with a virtual disk in the same state every time. Changes to
the disk are written to and read from a redo log file that is deleted when you
power off or reset.

 
6 Click OK to save your changes and close the dialog box.
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Add a Hard Disk to a Virtual Machine in the vSphere Web Client
When you add a hard disk to a virtual machine, you can create a new virtual disk, add an existing virtual disk,
or add a mapped SAN LUN.

n Add a New Hard Disk to a Virtual Machine in the vSphere Web Client on page 124
You can create a virtual hard disk and add it to a virtual machine.

n Add an Existing Hard Disk to a Virtual Machine in the vSphere Web Client on page 126
You can add an existing hard disk to a virtual machine.

n Add an RDM Disk to a Virtual Machine in the vSphere Web Client on page 126
You can use a raw device mapping (RDM) to store virtual machine data directly on a SAN LUN, instead
of storing it in a virtual disk file.

Add a New Hard Disk to a Virtual Machine in the vSphere Web Client
You can create a virtual hard disk and add it to a virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select New Hard Disk and click Add device.

The hard disk appears in the virtual devices list.

5 Click the triangle next to the new hard disk to expand the hard disk options.

6 (Optional) Type a value in the Provisioned Size text box and select the units from the drop-down menu.

7 Select the location for the virtual disk.

Option Action

Store the disk with the virtual
machine

Select Store with the virtual machine.
The disk will be stored in the same location as the virtual machine
configuration file.

Store the disk on another datastore
or datastore cluster

a Select Browse.
b Select a datastore or datastore cluster.
c If you selected a datastore cluster and do not want to use Storage DRS

with this disk, select Disable Storage DRS for this virtual machine and
select a datastore within the datastore cluster.

d Click OK.
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8 Select a disk provisioning option.

Option Description

Allocate and commit space on
demand (Thin Provisioning)

Saves storage space. For the thin disk, you provision as much datastore space
as the disk would require based on the value you enter for the disk size.
However, the thin disk starts small and at first, uses only as much datastore
space as the disk actually needs for its initial operations.
NOTE   If a virtual disk supports clustering solutions such as Fault Tolerance,
do not make the disk thin.
If the thin disk needs more space later, it can expand to its maximum capacity
and occupy the entire datastore space provisioned to it. Also, you can
manually convert the thin disk into a thick virtual disk.

Flat pre-initialized A type of thick virtual disk that support clustering features such as Fault
Tolerance. Space required for the virtual disk is allocated at creation time. In
contrast to the flat format, the data remaining on the physical device is
overwritten with zeroes during creation. It might take much longer to create
disks in this format than to create other types of disks.

 
9 In the Shares drop-down menu, select a value for the shares to allocate to the virtual disk.

Shares is a value that represents the relative metric for controlling disk bandwidth. The values Low,
Normal, High, and Custom are compared to the sum of all shares of all virtual machines on the host. Share
allocation symbolic values can be used to configure their conversion into numeric values.

10 If you selected Custom, type a number of shares in the text box.

11 In the Limit - IOPs box, enter the upper limit of storage resources to allocate to the virtual machine, or
select Unlimited.

This value is the upper limit of I/O operations per second allocated to the virtual disk.

12 Accept the default or select a different virtual device node.

In most cases, you can accept the default device node. For a hard disk, a nondefault device node is useful
to control the boot order or to have different SCSI controller types. For example, you might want to boot
from an LSI Logic controller and share a data disk with another virtual machine that is using a Buslogic
controller with bus sharing turned on.

13 (Optional) Select a disk mode.

Option Description

Dependent Dependent disks are included in snapshots.

Independent - Persistent Disks in persistent mode behave like conventional disks on your physical
computer. All data written to a disk in persistent mode are written
permanently to the disk.

Independent - Nonpersistent Changes to disks in nonpersistent mode are discarded when you power off
or reset the virtual machine. With nonpersistent mode, you can restart the
virtual machine with a virtual disk in the same state every time. Changes to
the disk are written to and read from a redo log file that is deleted when you
power off or reset.

 
14 Click OK.

Chapter 8 Configuring Virtual Machines

VMware, Inc.  125



Add an Existing Hard Disk to a Virtual Machine in the vSphere Web Client
You can add an existing hard disk to a virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select Existing Hard Disk and click Add device.

5 Browse for and select the disk file and click OK.

The disk appears in the virtual devices list.

What to do next

n (Optional) Change the virtual disk configuration. See “Change the Virtual Disk Configuration in the
vSphere Web Client,” on page 122.

n (Optional) Use disk shares to prioritize virtual machine access to this disk. See “Use Disk Shares to
Prioritize Virtual Machines in the vSphere Web Client,” on page 128.

Add an RDM Disk to a Virtual Machine in the vSphere Web Client
You can use a raw device mapping (RDM) to store virtual machine data directly on a SAN LUN, instead of
storing it in a virtual disk file.

When you give a virtual machine direct access to an RDM disk, you create a mapping file that resides on a
VMFS datastore and points to the LUN. Although the mapping file has the same .vmdk extension as a regular
virtual disk file, the mapping file contains only mapping information. The virtual disk data is stored directly
on the LUN.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select RDM Disk and click Add device.

5 Select the target LUN for the raw device mapping and click OK.

The disk appears in the virtual device list.

6 Select the location for the mapping file.

n To store the mapping file with the virtual machine configuration file, select Store with the virtual
machine.

n To select a location for the mapping file, select Browse and select the datastore location for the disk.
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7 Select a compatibility mode.

Option Description

Physical Allows the guest operating system to access the hardware directly. Physical
compatibility is useful if you are using SAN-aware applications on the virtual
machine. However, a virtual machine with a physical compatibility RDM
cannot be cloned, made into a template, or migrated if the migration involves
copying the disk.

Virtual Allows the RDM to behave as if it were a virtual disk, so you can use such
features as taking snapshots, cloning, and so on. When you clone the disk or
make a template out of it, the contents of the LUN are copied into a .vmdk
virtual disk file. When you migrate a virtual compatibility mode RDM, you
can migrate the mapping file or copy the contents of the LUN into a virtual
disk.

 
8 Accept the default or select a different virtual device node.

In most cases, you can accept the default device node. For a hard disk, a nondefault device node is useful
to control the boot order or to have different SCSI controller types. For example, you might want to boot
from an LSI Logic controller and share a data disk with another virtual machine using a Buslogic controller
with bus sharing turned on.

9 (Optional) If you selected virtual compatibility mode, select a disk mode.

Disk modes are not available for RDM disks using physical compatibility mode.

Option Description

Dependent Dependent disks are included in snapshots.

Independent - Persistent Disks in persistent mode behave like conventional disks on your physical
computer. All data written to a disk in persistent mode are written
permanently to the disk.

Independent - Nonpersistent Changes to disks in nonpersistent mode are discarded when you power off
or reset the virtual machine. With nonpersistent mode, you can restart the
virtual machine with a virtual disk in the same state every time. Changes to
the disk are written to and read from a redo log file that is deleted when you
power off or reset.

 
10 Click OK.

Add a Hard Disk to a Virtual Machine in the vSphere Client
When you add a hard disk to a virtual machine, you can create a new virtual disk, add an existing virtual disk,
or add a mapped SAN LUN.

In most cases, you can accept the default device node. For a hard disk, a nondefault device node is useful to
control the boot order or to have different SCSI controller types. For example, you might want to boot from an
LSI Logic controller and use a Buslogic controller with bus sharing turned on to share a data disk with another
virtual machine.

NOTE   You cannot use migration with vMotion to migrate virtual machines that use raw disks for clustering
purposes.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select Hard Disk and click Next.
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4 Select the type of disk to use.

Option Action

Create a new virtual disk a Type the disk capacity.
b Select a disk format.

n Thick Provision Lazy Zeroed creates a virtual disk in a default thick
format.

n Thick Provision Eager Zeroed creates a type of thick virtual disk
that supports clustering features such as Fault Tolerance.

n Thin Provision creates a disk in thin format. Use this format to save
storage space.

c Select a location to store the disk. Store with the virtual machine or
Specify a datastore.

d If you selected Specify a datastore, browse for the datastore location,
and click Next.

Use an Existing Virtual Disk Browse for the disk file path and click Next.

Raw Device Mappings Gives your virtual machine direct access to SAN.
a Select the LUN to use for the raw disk, and click Next.
b Select the datastore and click Next.
c Select the compatibility mode.

n Physical allows the guest operating system to access the hardware
directly.

n Virtual allows the virtual machine to use VMware snapshots and
other advanced functions.

d Click Next.
 

5 Accept the default or select a different virtual device node.

In most cases, you can accept the default device node. For a hard disk, a nondefault device node is useful
to control the boot order or to have different SCSI controller types. For example, you might want to boot
from an LSI Logic controller and share a data disk with another virtual machine using a BusLogic controller
with bus sharing turned on.

6 (Optional) To change the way disks are affected by snapshots, click Independent and select an option.

Option Description

Independent - Persistent Disks in persistent mode behave like conventional disks on your physical
computer. All data written to a disk in persistent mode are written
permanently to the disk.

Independent - Nonpersistent Changes to disks in nonpersistent mode are discarded when you power off
or reset the virtual machine. With nonpersistent mode, you can restart the
virtual machine with a virtual disk in the same state every time. Changes to
the disk are written to and read from a redo log file that is deleted when you
power off or reset.

 
7 Click Next.

8 Review the information and click Finish.

9 Click OK to save your changes and close the dialog box.

Use Disk Shares to Prioritize Virtual Machines in the vSphere Web Client
You can change the disk resources for a virtual machine. If multiple virtual machines access the same VMFS
datastore and the same logical unit number (LUN), use disk shares to prioritize the disk accesses from the
virtual machines. Disk shares distinguish high-priority from low-priority virtual machines.

You can allocate the host disk's I/O bandwidth to the virtual hard disks of a virtual machine. Disk I/O is a host-
centric resource so you cannot pool it across a cluster.
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Shares is a value that represents the relative metric for controlling disk bandwidth to all virtual machines. The
values are compared to the sum of all shares of all virtual machines on the server.

Disk shares are relevant only within a given host. The shares assigned to virtual machines on one host have
no effect on virtual machines on other hosts.

You can select an IOP limit, which sets an upper bound for storage resources that are allocated to a virtual
machine. IOPs are the number of I/O operations per second.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle next to a virtual disk to expand the disk options.

5 In the Shares drop-down menu, select a value for the shares to allocate to the virtual machine.

6 If you selected Custom, enter a number of shares in the text box.

7 In the Limit - IOPs box, enter the upper limit of storage resources to allocate to the virtual machine, or
select Unlimited.

8 Click OK.

Use Disk Shares to Prioritize Virtual Machines in the vSphere Client
You can change the disk resources for a virtual machine. If multiple virtual machines access the same VMFS
datastore and the same logical unit number (LUN), use disk shares to prioritize the disk accesses from the
virtual machines. Disk shares distinguish high-priority from low-priority virtual machines.

You can allocate the host disk's I/O bandwidth to the virtual hard disks of a virtual machine. Disk I/O is a host-
centric resource so you cannot pool it across a cluster.

Shares is a value that represents the relative metric for controlling disk bandwidth to all virtual machines. The
values are compared to the sum of all shares of all virtual machines on the server.

Disk shares are relevant only within a given ESXi host. The shares assigned to virtual machines on one host
have no effect on virtual machines on other hosts.

You can select an IOP limit, which sets an upper bound for storage resources that are allocated to a virtual
machine. IOPs are the number of I/O operations per second.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Resources tab and select Disk.

3 In the Resource Allocation panel, select the virtual hard disk to change.

4 Click the Shares column and change the value to allocate a number of shares of its disk bandwidth to the
virtual machine.

n Low (500)

n Normal (1000)

Chapter 8 Configuring Virtual Machines

VMware, Inc.  129



n High (2000)

n Custom
When you select a shares symbolic value, the numeric value appears in the Shares Value column. You
can select Custom to enter a user-defined shares value.

5 Click the Limit - IOPS column and enter the upper limit of storage resources to allocate to the virtual
machine.

6 Click OK to save your changes and close the dialog box.

Converting Virtual Disks from Thin to Thick
You can determine whether your virtual disk is in the thin provision format and, if required, convert it to the
thick provision format.

For more information on thin provisioning and available disk formats, see the vSphere Storage documentation.

Determine the Disk Format of a Virtual Machine in the vSphere Web Client
You can determine whether your virtual disk is in thick or thin format.

If you have thin provisioned disks, you can change them to thick by selecting Flat pre-initialized disk
provisioning. You change thick provisioned disks to thin by selecting Allocate and commit space on
demand.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle next to the virtual disk to expand the disk options.

The disk type is displayed in the Disk Provisioning field.

5 Click OK.

What to do next

If your virtual disk is in the thin format, you can inflate it to its full size using the vSphere Client. See the
vSphere Client online Help.

Determine the Disk Format of a Virtual Machine in the vSphere Client
You can determine whether your virtual disk is in thick or thin format.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the appropriate hard disk in the Hardware list.

The Disk Provisioning section on the right shows the type of your virtual disk.

3 Click OK.
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What to do next

If your virtual disk is in the thin format, you can inflate it to its full size.

Convert a Virtual Disk from Thin to Thick
If you created a virtual disk in the thin provision format, you can convert it to the thick provision format.

The thin provisioned disk starts small and at first, uses just as much storage space as it needs for its initial
operations. After having been converted, the virtual disk grows to its full capacity and occupies the entire
datastore space provisioned to it during the disk’s creation.

Procedure

1 Select the virtual machine in the inventory.

2 Click the Summary tab and, under Resources, double-click the datastore for the virtual machine to open
the Datastore Browser dialog box.

3 Click the virtual machine folder to find the virtual disk file you want to convert. The file has the .vmdk
extension.

4 Right-click the virtual disk file and select Inflate.

The virtual disk in the thick provision format occupies the entire datastore space originally provisioned to it.

Understanding Virtual Machine Storage Profiles
Virtual machine storage profiles list the storage capabilities that virtual machine home files and virtual disks
require to run the applications within the virtual machine.

You can create a list of virtual machine storage profiles to define different levels of storage requirements.

The virtual machine home files (.vmx, .vmsd, .nvram, .log, and so on) and the virtual disks (.vmdk) can have
separate virtual machine storage profiles as shown in the following table.

Table 8-8.  Example Virtual Machine Storage Profiles for a Virtual Machine

Example Virtual Machine Files
Example for a VM Storage
Profile

Example for a Datastore Compliant with the VM
Storage Profile

windows_2008r2_test.vmx

Storage Profile 2 datastore02

windows_2008r2_test.vmxf

windows_2008r2_test.log

windows_2008r2_test.nvram

windows_2008r2_test.vmem

windows_2008r2_test.vmsd

windows_2008r2_test.vmdk Storage Profile 3 datastore05

windows_2008r2_test_1.vmdk Storage Profile 5 datastore10

When you create, clone, or migrate a virtual machine, you can select to associate it with a virtual machine
storage profile. When you select a virtual machine storage profile, vSphere Client shows you the datastores
that are compatible with the capabilities of the profile. You can then select a datastore or a datastore cluster.

If you select a datastore that does not match the virtual machine storage profile, the vSphere Client shows that
the virtual machine is using non-compliant storage.
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Associate a Virtual Machine Storage Profile with a Virtual Machine and Its Virtual
Disks

You can associate a virtual machine storage profile with a virtual machine to define the storage capabilities
that are required by the applications running on the virtual machine.

You can associate a virtual machine storage profile with a powered-off and powered-on virtual machine.

Procedure

1 Open the Profiles tab of a virtual machine.

Option Description

Edit the settings of a virtual machine a Right-click a virtual machine from the inventory and select Edit
Settings.

b In the Virtual Machine Properties window, select the Profiles tab.

Use the virtual machine context
menu

Right-click a virtual machine from the inventory and select VM Storage
Profile > Manage Profiles.

 
2 Associate the virtual machine home files with a virtual machine storage profile from the Home VM

Storage Profile drop-down menu.

NOTE   The virtual machine home files include the file types .vmx, .vmsd, .nvram, and so on.

3 (Optional) Click Propagate to disks to associate all virtual disks with the same virtual machine storage
profile.

4 Under VM storage profiles for virtual disks, associate each virtual disk with a different virtual machine
storage profile from the VM Storage Profile drop-down menu.

5 Click OK.

The virtual machine storage profile name appears in the VM Storage Profiles pane of the Summary tab for the
virtual machine.

NOTE   If you add a new virtual disk and associate it with a virtual machine storage profile at the same time,
the VMware vSphere Profile-Driven Storage Service might take some to associate the virtual machine storage
profile with the new virtual disk.

SCSI Controller Configuration
To access virtual disks, a virtual machine uses virtual SCSI controllers. These virtual controllers appear to a
virtual machine as different types of controllers, including BusLogic Parallel, LSI Logic Parallel, LSI Logic SAS,
and VMware Paravirtual. You can add a SCSI controller, change the SCSI controller type, and select bus sharing
for a virtual machine.

Change the SCSI Bus Sharing Configuration in the vSphere Client
You can set the type of SCSI bus sharing for a virtual machine and indicate whether the SCSI bus is shared.
Depending on the type of sharing, virtual machines can access the same virtual disk simultaneously on the
same server or on any server.

You can change the SCSI controller configuration for a virtual machine on an ESXi host only.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.
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2 Click the Hardware tab and select a SCSI Controller in the hardware list.

3 Select the type of sharing in the SCSI Bus Sharing list.

Option Description

None Virtual disks cannot be shared by other virtual machines.

Virtual Virtual disks can be shared by virtual machines on the same server.

Physical Virtual disks can be shared by virtual machines on any server.
 

4 Click OK to save your changes and close the dialog box.

Change the SCSI Controller Type in the vSphere Web Client
You configure virtual SCSI controllers on your virtual machines to attach virtual disks and RDMs to.

The choice of SCSI controller does not affect whether your virtual disk is an IDE or SCSI disk. The IDE adapter
is always ATAPI. The default for your guest operating system is already selected. Older guest operating
systems default to the BusLogic adapter.

If you create an LSI Logic virtual machine and add a virtual disk that uses BusLogic adapters, the virtual
machine boots from the BusLogic adapters disk. LSI Logic SAS is available only for virtual machines with
hardware version 7 or later. Disks with snapshots might not experience performance gains when used on LSI
Logic SAS, VMware Paravirtual, and LSI Logic Parallel adapters.

CAUTION   Changing the SCSI controller type might result in a virtual machine boot failure.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle next to the SCSI controller to expand the SCSI controller options.

5 Select a SCSI controller type from the Change Type drop-down menu.

The vSphere Web Client displays information about what will happen if you change the controller type.
If you have selected a controller type that is not recommended for the virtual machine's guest operating
system, a warning is displayed.

6 Select whether to change the controller type.

n Click Change Type to change the controller type.

n Click Don't change to cancel the change and keep the original controller type.

7 Click OK.

Change the SCSI Controller Type in the vSphere Client
You configure virtual SCSI controllers on your virtual machines to attach virtual disks and RDMs to.

The choice of SCSI controller does not affect whether your virtual disk is an IDE or SCSI disk. The IDE adapter
is always ATAPI. The default for your guest operating system is already selected. Older guest operating
systems default to the BusLogic adapter.
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If you create an LSI Logic virtual machine and add a virtual disk that uses BusLogic adapters, the virtual
machine boots from the BusLogic adapters disk. LSI Logic SAS is available only for virtual machines with
hardware version 7. Disks with snapshots might not experience performance gains when used on LSI Logic
SAS, VMware Paravirtual, and LSI Logic Parallel adapters.

CAUTION   Changing the SCSI controller type might result in a virtual machine boot failure.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab, select a SCSI controller, and click Change Type.

3 Select a SCSI controller type and click OK.

4 Click OK to save your changes and close the dialog box.

About VMware Paravirtual SCSI Controllers
Paravirtual SCSI (PVSCSI) controllers are high performance storage controllers that can result in greater
throughput and lower CPU use. PVSCSI controllers are best suited for high-performance storage
environments.

PVSCSI controllers are available for virtual machines running hardware version 7 and later.

For platform support for PVSCSI controllers, see the VMware Compatibility Guide.

PVSCSI controllers have the following limitations:

n Hot add or remove requires a bus rescan from within the guest operating system.

n Disks on PVSCSI controllers might not experience performance gains if they have snapshots or if memory
on the ESXi host is over committed.

n If you upgrade your Linux virtual machine to an unsupported kernel, you might not be able to access data
on the disks attached to a PVSCSI controller. To regain access to such disks, you can run vmware-config-
tools.pl with the kernel-version parameter to regain access.

a Upgrade the guest kernel but do not restart the guest.

b Run the VMware Tools configuration with the kernel-version parameter and pass the kernel version
within the guest:

vmware-config-tools.pl --kernel-version kernel_version

To determine the kernel version, search for the directory name that was created in /lib/modules
during the kernel upgrade. Use that directory name, including all dashes, periods, and other
characters as an argument to --kernel-version.

c Restart the guest.

n MSCS clusters are not supported.

n PVSCSI controllers do not support boot disks, the disk that contains the system software, on Red Hat
Linux 5 virtual machines. Attach the boot disk to the virtual machine by using any of the other supported
controller types.

Add a Paravirtual SCSI Controller
You can add a VMware Paravirtual SCSI (PVSCSI) high performance storage controller to provide greater
throughput and lower CPU utilization.

PVSCSI controllers are best suited for environments, especially SAN environments, running I/O-intensive
applications.
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Prerequisites

n Verify that the virtual machine has a guest operating system with VMware Tools installed.

n Verify that the virtual machine has hardware version 7 or later.

n Ensure that you are familiar with PVSCSI limitations. See “About VMware Paravirtual SCSI
Controllers,” on page 134.

n To access boot disk devices attached to a PVSCSI controller, verify that the virtual machine has a Windows
2003 or Windows 2008 guest operating system.

n In some operating systems, before you change the controller type you need to create a virtual machine
with an LSI Logic controller, install VMware Tools, then change to paravirtual mode.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select SCSI Device and click Next.

4 Select a SCSI device in the Connection panel.

5 Select an unused Virtual Device Node and click Next.

For device node SCSI (0:2), 0 is the controller number and 2 is the number of the device that is attached to
the controller. If you select a node on which devices already exist (for example, SCSI 0:3) you will add a
SCSI device to the existing controller. To add a new controller, you must select an unused device node on
an unused SCSI controller (for example 1:0).

6 Review your selections and click Finish.

New SCSI Controller (adding) and New SCSI Device (adding) appear in the Hardware list.

7 Click OK to save your changes and exit the dialog box.

8 Reopen the Virtual Machine Properties Editor.

9 Select the new SCSI controller and click Change Type.

10 Select VMware Paravirtual and click OK.

11 Click OK to save your changes and close the dialog box.
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Other Virtual Machine Device Configuration
In addition to configuring virtual machine CPU and Memory and adding a hard disk and virtual NICs, you
can also add and configure virtual hardware, such as DVD/CD-ROM drives, floppy drives, and SCSI devices.
Not all devices are available to add and configure. For example, you cannot add a video card, but you can
configure available video cards and PCI devices.

Change the CD/DVD Drive Configuration
You can configure DVD or CD devices to connect to client devices, host devices, or Datastore ISO files.

Configure a Client Device Type for the CD/DVD Drive in the vSphere Web Client
You can connect the CD/DVD device to a physical DVD or CD device on the system from which you access
the vSphere Web Client.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle next to the CD/DVD drive to expand the CD/DVD drive options.

5 Select the Client Device under Device Type.

6 Select the mode used for the connection.

n Passthrough IDE (raw). Use mode only for remote client device access.

n Emulate IDE. Use to access a host CD-ROM device.

The host CD device is accessed through emulation mode. Passthrough mode is not functional for local
host CD access. You can write or burn a remote CD only through pass-through mode access, but in
emulation mode you can only read a CD-ROM from a host CD-ROM device.

7 In the drop-down menu under Virtual Device Node, select the node the drive uses in the virtual machine.

8 Click OK.

Configure a Client Device Type for the DVD/CD-ROM Drive in the vSphere Client
You can connect the DVD/CD-ROM device to a physical DVD or CD-ROM device on the system running the
vSphere Client.

Procedure

1 Select the virtual machine in the vSphere Client inventory.

2 Click the CD/DVD Connections icon on the virtual machine toolbar.

3 Select a drive or ISO image from the CD/DVD drive drop-down menu.

Passthrough IDE (raw) mode access is set by default, which lets you write or burn a remote CD.
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Configure a Host Device Type for the CD/DVD Drive in the vSphere Web Client
You can connect the CD/DVD device to a physical DVD or CD device that resides on the host.

You cannot use vMotion to migrate virtual machines that have CD drives that are backed by the physical CD
drive on the host. You must disconnect these devices before you migrate the virtual machine.

When you add a CD/DVD drive that is backed by a USB CD/DVD drive on the host, you must add the drive
as a SCSI device. Hot adding and removing SCSI devices is not supported.

Prerequisites

Ensure that the host is powered off before you add USB CD/DVD devices.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle next to the CD/DVD drive to expand the drive options.

5 In the Device Type drop-down menu, select Host Device.

6 If there is more than one device available on the host, select the device.

7 In the Virtual Device Node drop-down menu, select the node the drive uses in the virtual machine.

8 (Optional) Select or deselect the Connected check box to connect or disconnect the device.

9 (Optional) Select Connect At Power On to connect the device when the virtual machine powers on.

10 Click OK.

Configure a Host Device Type for the DVD/CD-ROM Drive in the vSphere Client
You can connect the DVD/CD-ROM device to a physical DVD or CD-ROM device that resides on the host.

You cannot use vMotion to migrate virtual machines that have CD drives that are backed by the physical CD
drive on the host. You must disconnect these devices before you migrate the virtual machine.

When you add a CD/DVD-ROM drive that is backed by a USB CD/DVD drive on the host, you must add the
drive as a SCSI device. Hot adding or removing SCSI devices from an ESXi host is not supported.

Prerequisites

Ensure that the host is powered off before you add USB CD/DVD-ROM devices.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the DVD/CD-ROM drive.

3 Select or deselect the Connected check box to connect or disconnect the device.

4 If you do not want the CD-ROM drive connected when the virtual machine starts, deselect Connect at
power on.

5 Select Host Device under Device Type and select a device from the drop-down menu.
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6 (Optional) In the drop-down menu under Virtual Device Node, select the node the drive uses in the virtual
machine.

7 Click OK to save your changes and close the dialog box.

Configure a Datastore ISO File for the CD/DVD Drive in the vSphere Web Client
You can connect the CD/DVD device to an ISO file that is stored on a datastore accessible to the host.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle next to the CD/DVD drive to expand the CD/DVD drive options.

5 From the Device Type drop-down menu, Datastore ISO File and click Browse to navigate to the file.

6 In the drop-down menu under Virtual Device Node, select the node the drive uses in the virtual machine.

7 (Optional) Select or deselect the Connected check box to connect or disconnect the device.

8 (Optional) Select Connect At Power On to connect the device when the virtual machine powers on.

9 Click OK.

Configure a Datastore ISO File for the DVD/CD-ROM Drive in the vSphere Client
You can connect the DVD/CD-ROM device to an ISO file that is stored on a datastore accessible to the host.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the DVD/CD-ROM drive.

3 Select or deselect the Connected check box to connect or disconnect the device.

4 If you do not want the CD-ROM drive connected when the virtual machine starts, deselect Connect at
power on.

5 Select Datastore ISO File under Device Type and click Browse to navigate to the file.

6 In the drop-down menu under Virtual Device Node, select the node the drive uses in the virtual machine.

7 Click OK to save your changes and close the dialog box.

Add a CD or DVD Drive to a Virtual Machine in the vSphere Web Client
You can use a physical drive on a client or host or you can use an ISO image to add a CD/DVD drive to a virtual
machine.

If you are adding a CD/DVD drive that is backed by USB CD/DVD drive on the host, you must add the drive
as a SCSI device. Hot adding and removing SCSI devices is not supported.

You cannot use vMotion to migrate virtual machines that have CD drives that are backed by the physical CD
drive on the host. You must disconnect these devices before you migrate the virtual machine.
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Prerequisites

Ensure that the host is powered off before you add USB CD/DVD devices.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select CD/DVD Drive and click Add device.

The new drive appears in the virtual devices list above.

5 Click the triangle next to the new drive to expand the drive options.

6 Select the type of device.

n Select Client Device to connect the CD/DVD device to a physical DVD or CD device on the system
from which you access the vSphere Web Client.

n Select Host Device to connect the CD/DVD device to a physical DVD or CD device on the host.

n Select Datastore ISO File to connect the CD/DVD device to an ISO file that is stored on a datastore
accessible to the host.

7 For client or host devices, select the mode used for the connection.

n Passthrough IDE (raw). Use mode only for remote client device access.

n Emulate IDE. Use to access a host CD-ROM device.

The host CD-ROM device is accessed through emulation mode. Passthrough mode is not functional for
local host CD-ROM access. You can write or burn a remote CD only through pass-through mode access,
but in emulation mode you can only read a CD-ROM from a host CD-ROM device.

8 (Optional) In the drop-down menu under Virtual Device Node, select the node the drive uses in the virtual
machine.

9 (Optional) Select or deselect the Connected check box to connect or disconnect the device.

10 (Optional) Select Connect At Power On to connect the device when the virtual machine powers on.

11 Click OK.

Add a DVD or CD-ROM Drive to a Virtual Machine in the vSphere Client
You can use a physical drive on a client or host or you can use an ISO image to add a DVD/CD-ROM drive to
a virtual machine.

If you are adding a CD/DVD-ROM drive that is backed by USB CD/DVD drive on the host, you must add the
drive as a SCSI device. Hot adding or removing SCSI devices from an ESXi host is not supported.

You cannot use vMotion to migrate virtual machines that have CD drives that are backed by the physical CD
drive on the host. You must disconnect these devices before you migrate the virtual machine.

Prerequisites

Ensure that the host is powered off before you add USB DVD/CD-ROM devices.
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Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Select the Hardware tab and click Add.

3 Select DVD/CD-ROM Drive, and click Next.

4 Select one option.

Option Description

Use physical drive a Select Client or Host as the location.
b Select the drive you want to use from the drop-down menu.
c Select a Pass through (recommended) or ATAPI emulation connection

type.

Use ISO Image Enter the path and filename for the image file, or click Browse to navigate to
the file.

 
5 If you do not want the CD-ROM drive connected when the virtual machine starts, deselect Connect at

power on.

6 Click Next.

7 Select the virtual device node the drive uses in the virtual machine and click Next.

8 Review the information on the Ready to Complete window, and click Finish or clickBack to change the
settings.

9 Click OK to save your changes and close the dialog box.

Change the Floppy Drive Configuration in the vSphere Web Client
You can configure a virtual floppy drive device to connect to a client device or to an existing or new floppy
image.

ESXi does not support floppy drives that are backed by a physical floppy drive on the host.

NOTE   You cannot use vMotion to migrate virtual machines that have floppy drives backed by a physical floppy
drive on ESX 3.5, 4. 0, and 4.x hosts that vCenter Server 5.0 manages. You must disconnect these devices before
you migrate the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle next to the floppy device to expand the drive options.
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5 Select the device type to use for this virtual device.

Option Action

Client Device Select this option to connect the floppy device to a physical floppy device or
a .flp floppy image on the system from which you access the
vSphere Web Client.

Existing File a Select this option to connect the virtual device to an existing floppy image
on a datastore accessible to the host.

b Click Browse and select the floppy image.

Create new floppy image a Select this option to create a floppy image on a datastore accessible to the
host.

b Click Browse and browse to the location for the floppy image.
c Enter a name for the floppy image and click OK.

 
6 (Optional) Select or deselect the Connected check box to connect or disconnect the device.

7 Select Connect At Power On to connect the device when the virtual machine powers on.

8 Click OK.

Change the Floppy Drive Configuration in the vSphere Client
You can configure a virtual floppy drive device to connect to a client device or to an existing or new floppy
image.

ESXi does not support floppy drives that are backed by a physical floppy drive on the host.

NOTE   You cannot use vMotion to migrate virtual machines that have floppy drives backed by a physical floppy
drive on ESX 3.5, 4. 0, and 4.x hosts that vCenter Server 5.0 manages. You must disconnect these devices before
you migrate the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select the Floppy drive.

3 Under Device Status, select Connect at power on to connect this virtual machine to the floppy drive when
the virtual machine is powered on.

4 Select the device type to use for this virtual device.

Option Description

Client Device Select this option to connect the floppy device to a physical floppy device or
a .flp floppy image on the system running the vSphere Client.
To connect the device, click the Floppy Connections button in the toolbar
when you power on the virtual machine.

Use existing floppy image in
datastore

a Select this option to connect the virtual device to an existing floppy image
on a datastore accessible to the host.

b Click Browse and select the floppy image.

Create new floppy image in datastore a Select this option to create a floppy image on a datastore accessible to the
host.

b Click Browse and browse to the location for the floppy image.
c Enter a name for the floppy image and click OK.

 
5 Click OK to save your changes and close the dialog box.
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Add a Floppy Drive to a Virtual Machine in the vSphere Web Client
Use a physical floppy drive or a floppy image to add a floppy drive to a virtual machine.

ESXi does not support floppy drives that are backed by a physical floppy drive on the host.

NOTE   You cannot use vMotion to migrate virtual machines that have floppy drives backed by a physical floppy
drive on ESX 3.5, 4. 0, and 4.x hosts that vCenter Server 5.0 manages. You must disconnect these devices before
you migrate the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select Floppy Drive and click Add device.

The new floppy drive appears in the virtual devices list above.

5 Click the triangle next to the floppy device to expand the drive options.

6 Select the device type to use for this virtual device.

Option Description

Client Device Select this option to connect the floppy device to a physical floppy device or
a .flp floppy image on the system from which you access the
vSphere Web Client.

Existing File a Select this option to connect the virtual device to an existing floppy image
on a datastore accessible to the host.

b Click Browse and select the floppy image.

Create new floppy image a Select this option to create a floppy image on a datastore accessible to the
host.

b Click Browse and browse to the location for the floppy image.
c Enter a name for the floppy image and click OK.

 
7 (Optional) Select or deselect the Connected check box to connect or disconnect the device.

8 Select Connect At Power On to connect the device when the virtual machine powers on.

9 Click OK.

Add a Floppy Drive to a Virtual Machine in the vSphere Client
Use a physical floppy drive or a floppy image to add a floppy drive to a virtual machine.

ESXi does not support floppy drives that are backed by a physical floppy drive on the host.

NOTE   You cannot use vMotion to migrate virtual machines that have floppy drives backed by a physical floppy
drive on ESX 3.5, 4. 0, and 4.x hosts that vCenter Server 5.0 manages. You must disconnect these devices before
you migrate the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.
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2 Select the Hardware tab and click Add.

3 Select Floppy Drive, and click Next.

4 Select the device type to use for this virtual device.

Option Description

Use a physical floppy drive Select this option to connect the floppy device to a physical floppy device or
a .flp floppy image on the system running the vSphere Client.
To connect the device, click the Floppy Connections button in the toolbar
when you power on the virtual machine.

Use a floppy image a Select this option to connect the virtual device to an existing floppy image
on a datastore accessible to the host.

b Click Browse and select the floppy image.

Create a blank floppy image a Select this option to create a floppy image on a datastore accessible to the
host.

b Click Browse and browse to the location for the floppy image.
c Enter a name for the floppy image and click OK.

 
5 To have the floppy drive connected to the virtual machine when you power it on, select Connect at power

on.

6 Click Next.

7 Review the information on the Ready to Complete page, and click Finish.

8 Click OK to save your changes and close the dialog box.

Change the SCSI Device Configuration in the vSphere Web Client
You can change the physical device and configure the virtual device node for a virtual SCSI device.

Power off the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle next to the SCSI device to expand the device options.

5 From the Connection drop-down menu, select the physical SCSI device to connect to.

6 (Optional) From the Virtual Device Node drop-down menu, select the virtual device node.

7 Click OK.

Add a SCSI Device to a Virtual Machine in the vSphere Client
You can add a SCSI device to a virtual machine through the Add Hardware wizard.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select Add.

Chapter 8 Configuring Virtual Machines

VMware, Inc.  143



3 Select SCSI Device and click Next.

4 Under Connection, use the drop-down menu to select a physical device.

5 UnderVirtual Device Node, select the virtual device node where you want this device to appear in the
virtual machine.

6 Review the information in the Ready to Complete page, and click Finish.

7 Click OK to save your changes and close the dialog box.

Change the SCSI Device Configuration in the vSphere Web Client
You can change the physical device and configure the virtual device node for a virtual SCSI device.

Power off the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle next to the SCSI device to expand the device options.

5 From the Connection drop-down menu, select the physical SCSI device to connect to.

6 (Optional) From the Virtual Device Node drop-down menu, select the virtual device node.

7 Click OK.

Change the SCSI Device Configuration in the vSphere Client
You can change the physical device and the virtual device node of the SCSI device connection.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select a SCSI device in the Hardware list.

3 Under Connection, select the physical device you want to use.

Under Virtual device node, select the virtual device node where you want this device to appear in the
virtual machine.

4 Click OK to save your changes and close the dialog box.

Add a PCI Device in the vSphere Web Client
vSphere DirectPath I/O allows a guest operating system on a virtual machine to directly access physical PCI
and PCIe devices connected to a host. Each virtual machine can be connected to up to six PCI devices.

Snapshots are not supported with PCI vSphere DirectPath I/O devices.

Prerequisites

n To use DirectPath, verify that the host has Intel® Virtualization Technology for Directed I/O (VT-d) or
AMD I/O Virtualization Technology (IOMMU) enabled in the BIOS.
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n Verify that the PCI devices are connected to the host and marked as available for passthrough.

n Verify that the virtual machine is using hardware version 7 or later.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select PCI Device and click Add device.

5 Select the passthrough device to connect to the virtual machine from the drop-down list and click Next.

6 Click OK.

Add a PCI Device in the vSphere Client
vSphere DirectPath I/O allows a guest operating system on a virtual machine to directly access physical PCI
and PCIe devices connected to a host. Each virtual machine can be connected to up to six PCI devices.

PCI devices connected to a host can be marked as available for passthrough from the Hardware Advanced
Settings in the Configuration tab for the host.

Snapshots are not supported with PCI vSphere Direct Path I/O devices.

Prerequisites

n To use DirectPath I/O, verify that the host has Intel® Virtualization Technology for Directed I/O (VT-d) or
AMD I/O Virtualization Technology (IOMMU) enabled in the BIOS.

n Verify that the PCI devices are connected to the host and marked as available for passthrough.

n Verify that the virtual machine is using hardware version 7 or later.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 On the Hardware tab, click Add.

3 In the Add Hardware wizard, select PCI Device and click Next.

4 Select the passthrough device to connect to the virtual machine from the drop-down list and click Next.

5 Click Finish.

Configure the Virtual Machine Communication Interface in the
vSphere Web Client

The Virtual Machine Communication Interface (VMCI) provides a high-speed communication channel
between a virtual machine and the ESXi host that it runs on. You can also enable VMCI for communication
between virtual machines that run on the same host.

Prerequisites

Verify that the virtual machine is using hardware version 7 or later.
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Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Select Enable VMCI between VMs.

5 Click OK.

Virtual machine communication is no longer restricted to the host it runs on. Other virtual machines that run
on the same host can now communicate with the unrestricted virtual machine.

Configure the Virtual Machine Communication Interface in the vSphere Client
The Virtual Machine Communication Interface (VMCI) provides a high-speed communication channel
between a virtual machine and the ESXi host that it runs on. You can also enable VMCI for communication
between virtual machines that run on the same host.

Prerequisites

Verify that the virtual machine is using hardware version 7 or later.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 On the Hardware Tab, select Show All Devices and click VMCI device.

3 Select the Enable VMCI Between VMs check box.

4 Click OK to save your changes and close the dialog box.

Virtual machine communication is no longer restricted to the host it runs on. Other virtual machines that run
on the same host can now communicate with the unrestricted virtual machine.

Configure Video Cards in the vSphere Web Client
You can change the number of displays for a virtual machine, allocate memory for the displays, and enable
3D support.

The default setting for total video RAM is adequate for minimal desktop resolution. For more complex
situations, you can change the default memory.

Some 3D applications require a minimum video memory of 64MB. Keep this in mind when you assign video
memory.

Prerequisites

Verify that the virtual machine is powered off.

Procedure

1 In the vSphere Web Client inventory, right-click a virtual machine and select Configuration > Edit
Settings.

2 Select Virtual Hardware and click the Video card triangle to view the options.
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3 Select the display settings type from the Settings drop-down menu and configure the available settings.

Option Description

Auto-detect video settings Applies common video settings to the guest operating system.

Specify custom settings Lets you select the number of displays and the total video memory.
 

4 Select the number of displays from the drop-down menu.

The vSphere Web Client supports setting a number of displays and extending the screen across them. True
multimonitor support is not available with the vSphere Client.

5 Enter the video memory required for the displays.

6 (Optional) Click Video Memory Calculator to calculate the required video memory based on the
maximum number of displays, resolution, and color depth that the guest operating system must support,
and clickOK.

7 (Optional) Click Enable 3D support.

This check box is active only for guest operating systems on which VMware supports 3D.

8 Click OK.

Sufficient memory allocation is set for this virtual machine's video display.

Configure Video Cards in the vSphere Client
You can change the number of displays for a virtual machine, allocate memory for the displays, and enable
3D support.

The default setting for total video RAM is adequate for minimal desktop resolution. For more complex
situations, you can change the default memory.

Some 3D applications require a minimum video memory of 64MB. Keep this in mind when you assign video
memory.

Prerequisites

Verify that the virtual machine is powered off.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select Video card.

3 Select the display settings type and configure the available settings.

Option Description

Auto-detect video settings Applies common video settings to the guest operating system.

Specify custom settings Lets you select the number of displays and the total video memory.
 

4 Select the number of displays from the drop-down menu.

The vSphere Client supports setting a number of displays and extending the screen across them. True
multimonitor support is not available with the vSphere Client.

5 Enter the video memory required for the displays.

6 (Optional) Click Video Memory Calculator to calculate the required video memory based on the
maximum number of displays, resolution, and color depth that the guest operating system must support
and click OK.
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7 (Optional) Click Enable 3D support.

This check box is active only for guest operating systems on which VMware supports 3D.

8 Click OK to save your changes and close the dialog box.

Sufficient memory allocation is set for the virtual machine’s video display.

Configuring vServices
A vService dependency allows a vApp or a virtual machine to request that a vService be available on a specified
platform.

A vService specifies a particular service on which vApps and virtual machines can depend.

The vService configuration tab monitors and manages vService dependencies. This tab displays all the
dependencies that a virtual machine or vApp has and each of their states. Each dependency shows the
dependency name, description, requirement, bound status, and provider name.

Add a vService Dependency
You can add a vService dependency to a virtual machine or vApp. This dependency allows a virtual machine
or vApp to request that a specific vService be available.

Procedure

1 Display the virtual machine or vApp in the inventory.

2 Power off the virtual machine or vApp.

3 Right-click the virtual machine or vApp and select Edit Settings.

4 Click the vServices tab.

5 Click Add.

6 In the Add Dependency wizard, select the provider for this dependency and click Next.

7 Enter the name and description for this dependency.

8 (Optional) If this dependency is required, select the check box and click Next.

Required dependencies must be bound before powering on.

9 (Optional) If this dependency should be bound to the provider immediately, select the Bind to provider
immediately check box, and click Next after the validation is complete.

If you choose to bind this dependency now, the validation result displays. If the validation fails, you cannot
complete adding the dependency. Deselect the check box to proceed.

10 Review the options and click Finish to create the dependency.

Edit a vService Dependency
You can edit a vService dependency name, description, and requirement.

Procedure

1 From the vServices tab in the Edit Settings dialog box, click Edit.

2 In the Dependency Properties dialog box, edit the dependency name and description.

3 Select or deselect the check box to change the required status of the dependency.

The required check box is disabled if the virtual machine or vApp is running.
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4 Select a provider for the dependency.

When you select a provider, the description is entered containing the provider description. The validation
box displays the results of the validation. If validation fails, the OK button is disabled until another
provider or no provider is selected.

5 Click OK.

Remove a vService Dependency
You can remove a vService dependency from a virtual machine or vApp.

Procedure

1 From the vServices tab in the Edit Settings dialog box, click Edit.

2 Select the dependency and click Remove.

The dependency is removed from the list.

USB Configuration from an ESXi Host to a Virtual Machine
You can add multiple USB devices to a virtual machine when the physical devices are connected to an ESXi
host. USB passthrough technology supports adding USB devices, such as security dongles and mass storage
devices to virtual machines that reside on the host to which the devices are connected.

How USB Device Passthrough Technology Works
When you attach a USB device to a physical host, the device is available only to virtual machines that reside
on that host. The device cannot connect to virtual machines that reside on another host in the datacenter.

A USB device is available to only one virtual machine at a time. When a device is connected to a powered-on
virtual machine, it is not available to connect to other virtual machines that run on the host. When you remove
the active connection of a USB device from a virtual machine, it becomes available to connect to other virtual
machines that run on the host.

Connecting a USB passthrough device to a virtual machine that runs on the ESXi host to which the device is
physically attached requires an arbitrator, a controller, and a physical USB device or device hub.

USB Arbitrator Manages connection requests and routes USB device traffic. The arbitrator is
installed and enabled by default on ESXi hosts. It scans the host for USB devices
and manages device connection among virtual machines that reside on the
host. It routes device traffic to the correct virtual machine instance for delivery
to the guest operating system. The arbitrator monitors the USB device and
prevents other virtual machines from using it until you release it from the
virtual machine it is connected to.

USB Controller The USB hardware chip that provides USB function to the USB ports that it
manages. The virtual USB Controller is the software virtualization of the USB
host controller function in the virtual machine.
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USB controller hardware and modules that support USB 2.0 and USB 1.1
devices must exist on the host. Two virtual USB controllers are available to each
virtual machine. A controller must be present before you can add USB devices
to the virtual computer.

The USB arbitrator can monitor a maximum of 15 USB controllers. Devices
connected to controllers numbered 16 or greater are not available to the virtual
machine.

USB Devices You can add up to 20 USB devices to a virtual machine. This is the maximum
number of devices supported for simultaneous connection to one virtual
machine. The maximum number of USB devices supported on a single ESXi
host for simultaneous connection to one or more virtual machines is also 20.
For a list of supported USB devices, see the VMware knowledge base article at
http://kb.vmware.com/kb/1021345.

USB Autoconnect Feature
When you add a USB device connection from an ESXi host to a virtual machine, the autoconnect feature is
enabled for the device connection. It is not disabled until you remove the device connection from the virtual
machine.

With autoconnect enabled, the device connection re-establishes in the following cases:

n The virtual machine is cycling through power operations, such as Power Off/Power On, Reset,
Pause/Resume.

n The device is unplugged from the host then plugged back in to the same USB port.

n The device is power cycled but has not changed its physical connection path.

n The device is mutating identity during usage.

The USB passthrough autoconnect feature identifies the device by using the USB path of the device on the host.
It uses the physical topology and port location, rather than the device identity. This feature can seem confusing
if you expect the autoconnect feature to match the connection target by device ID.

If the same device is plugged back in to the host through a different USB port, it cannot re-establish connection
with the virtual machine. If you unplug the device from the host and plug in a different device to the same
USB path, the new device appears and is connected to the virtual machine by the autoconnect feature that the
previous device connection enabled.

Autoconnect is useful in cases where devices mutate during usage. For example, for iPhones and other such
devices, the device VID:PID changes during software or firmware upgrades. The upgrade process disconnects
and reconnects the devices to the USB port.

The USB port is speed-specific. The autoconnect feature assumes that devices do not transition from USB 1.1
(low-full speed) to USB 2.0 (high speed) or the reverse. You cannot interchange USB 2.0 high-speed devices
with USB 1.1 devices. For example, you might connect a USB 2.0 high-speed device to a port and connect that
device to the virtual machine. If you unplug the device from the host and plug a USB 1.1 device into the same
port, the device does not connect to the virtual machine.

For a list of supported USB devices for passthrough from an ESXi host to a virtual machine, see the VMware
knowledge base article at http://kb.vmware.com/kb/1021345.
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vSphere Features Available with USB Passthrough
Migrations with vMotion and DRS are supported with USB device passthrough from an ESXi host to a virtual
machine.

Table 8-9.  vSphere Features Available for USB Passthrough from an ESXi Host to a Virtual Machine

Feature Supported with USB Device Passthrough

vSphere Distributed Power Management (DPM) No

vSphere Distributed Resource Scheduler (DRS) Yes

vSphere Fault Tolerance No

vSphere vMotion Yes

For details about migration with vMotion, see “Configuring USB Devices for vMotion,” on page 151.

If a host with connected USB devices resides in a DRS cluster with DPM enabled, you must disable DPM for
that host. Otherwise DPM might turn off the host with the device, which disconnects the device from the virtual
machine.

Configuring USB Devices for vMotion
With USB passthrough from a host to a virtual machine, you can migrate a virtual machine to another ESXi
host in the same datacenter and maintain the USB passthrough device connections to the original host.

If a virtual machine has USB devices attached that pass through to an ESXi host, you can migrate that virtual
machine with the devices attached.

For a successful migration, review the following conditions:

n You must configure all USB passthrough devices connected to a virtual machine for vMotion. If one or
more devices is not configured for vMotion, the migration cannot proceed. For troubleshooting details,
see the vSphere Troubleshooting documentation.

n When you migrate a virtual machine with attached USB devices away from the host to which the devices
are connected, the devices remain connected to the virtual machine. However, if you suspend or power
off the virtual machine, the USB devices are disconnected and cannot reconnect when the virtual machine
is resumed. The device connections can be restored only if you move the virtual machine back to the host
to which the devices are attached.

n If you resume a suspended virtual machine that has a Linux guest operating system, the resume process
might mount the USB devices at a different location on the file system.

n If a host with attached USB devices resides in a DRS cluster with distributed power management (DPM)
enabled, disable DPM for that host. Otherwise DPM might turn off the host with the attached device. This
action disconnects the device from the virtual machine because the virtual machine migrated to another
host.

Avoiding Data Loss with USB Devices
Virtual machine functions can affect USB device behavior and connections.

n Before you hot add memory, CPU, or PCI devices, you must remove any USB devices. Hot adding these
resources disconnects USB devices, which might result in data loss.

n Before you suspend a virtual machine, make sure that a data transfer is not in progress. During the suspend
or resume process, USB devices behave as if they have been disconnected, then reconnected. For
information about suspend and resume behavior after migration with vMotion, see “Configuring USB
Devices for vMotion,” on page 151.
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n Before you change the state of the arbitrator, make sure that USB devices residing on the host are not
attached to a virtual machine. If USB devices become unavailable to a virtual machine, a host administrator
might have disabled the arbitrator. When an administrator stops or disconnects the arbitrator for
troubleshooting or other purposes, USB devices attached to that host become unavailable to the virtual
machine. If a data transfer is taking place at this time, you might lose the data. To reestablish the arbitrator,
you must reboot the host.

Connecting USB Devices to an ESXi Host
You can connect and chain multiple USB hubs and devices to an ESXi host. Careful planning and knowledge
of hub behavior and limitations can help ensure that your devices work optimally.

USB physical bus topology defines how USB devices connect to the host. Support for USB device passthrough
to a virtual machine is available if the physical bus topology of the device on the host does not exceed tier
seven. The first tier is the USB host controller and root hub. The last tier is the target USB device. You can
cascade up to five tiers of external or internal hubs between the root hub and the target USB device. An internal
USB hub attached to the root hub or built into a compound device counts as one tier.

The quality of the physical cables, hubs, devices, and power conditions can affect USB device performance. To
ensure the best results, keep the host USB bus topology as simple as possible for the target USB device, and
use caution when you deploy new hubs and cables into the topology. The following conditions can affect USB
behavior:

n Communication delay between the host and virtual machine increases as the number of cascading hubs
increases.

n Connecting or chaining multiple external USB hubs increases device enumeration and response time,
which can make the power support to the connected USB devices uncertain.

n Chaining hubs together also increases the chance of port and hub error, which can cause the device to lose
connection to a virtual machine.

n Certain hubs can cause USB device connections to be unreliable, so use care when you add a new hub to
an existing setup. Connecting certain USB devices directly to the host rather than to a hub or extension
cable might resolve their connection or performance issues.

NOTE   To prevent additional problems, be aware of the physical constraints of long-term deployment in a
machine room environment. Small devices are easily damaged by being stepped on or knocked loose.

In some cases, you must hard reset the device and hub to restore the device to a working state.

For a list of supported USB devices for passthrough from an ESXi host to a virtual machine, see the VMware
knowledge base article at http://kb.vmware.com/kb/1021345.

USB Compound Devices
For compound devices, the virtualization process filters out the USB hub so that it is not visible to the virtual
machine. The remaining USB devices in the compound appear to the virtual machine as separate devices. You
can add each device to the same virtual machine or to different virtual machines if they run on the same host.

For example, the Aladdin HASP HL Drive USB dongle package contains three devices (0529:0001 HASP dongle,
13fe:1a00 Hub, 13fe:1d00 Kingston Drive). The virtualization process filters out the USB hub. The remaining
Aladdin HASP HL Drive USB dongle devices (one Aladdin HASP dongle and one Kingston Drive) appear to
the virtual machine as individual devices. You must add each device separately to make it accessible to the
virtual machine.
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Connect USB Devices to an ESXi Host
You can connect multiple USB devices to ESXi hosts so that virtual machines that run on the hosts can access
the devices. The number of devices that you can connect depends on several factors, such as how the devices
and hubs chain together and the device type.

Each ESXi host has several USB ports. The number of ports on each host depends on the physical setup of the
host. When you calculate the depth of hub chaining, remember that on a typical server the front ports connect
to an internal hub.

The USB arbitrator can monitor a maximum of 15 USB controllers. If your system includes controllers that
exceed the 15 controller limit and you connect USB devices to them, the devices are not available to the virtual
machine.

The host treats USB CD/DVD-ROM devices as SCSI devices. Hot adding and removing these devices is not
supported.

Prerequisites

n If a host has attached USB devices and resides in a DRS cluster with DPM enabled, disable DPM for that
host. See the vSphere Resource Management documentation for instructions about overriding the default
DPM setting for an individual host.

n Verify that you know the virtual machine requirements for USB devices. See “Connecting USB Devices to
an ESXi Host,” on page 152.

n Verify that the ESXi host is powered off before you add USB CD/DVD-ROM devices.

Procedure

u To add a USB device to an ESXi host, connect the device to an available port or hub.

The USB device appears in the virtual machine Add Hardware wizard device list.

What to do next

You can now add the device to the virtual machine.

Add a USB Controller to a Virtual Machine in the vSphere Web Client
USB controllers are available to add to virtual machines to support USB passthrough from an ESXi host or
from a client computer to a virtual machine.

You can add two USB controllers to a virtual machine. The xHCI controller, available for Linux guest operating
systems only, supports USB 3.0 superspeed, 2.0, and 1.1 devices. The EHCI+UHCI controller supports USB 2.0
and 1.1 devices.

The conditions for adding a controller vary, depending on the device version, the type of passthrough (host
or client computer), and the guest operating system.

Table 8-10.  USB Controller Support

Controller type
Supported USB Device
Version

Supported for Passthrough
from ESXi Host to VM

Supported for Passthrough from
Client Computer to VM

EHCI+UHCI 2.0 and 1.1 Yes Yes

xHCI 3.0, 2.0, and 1.1 Yes (USB 2.0 and 1.1 devices
only)

Yes (Linux guests only)

NOTE   Drivers are not available for the xHCI controller on Windows guest operating systems.
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For Mac OS X systems, the EHCI+UHCI controller is enabled by default and is required for USB mouse and
keyboard access.

For virtual machines with Linux guests, you can add one or both controllers, but 3.0 superspeed devices are
not supported for passthrough from an ESXi host to a virtual machine. You cannot add two controllers of the
same type.

For USB passthrough from an ESXi host to a virtual machine, the USB arbitrator can monitor a maximum of
15 USB controllers. If your system includes controllers that exceed the 15 controller limit and you connect USB
devices to them, the devices are not available to the virtual machine.

Prerequisites

n ESXi hosts must have USB controller hardware and modules that support USB 2.0 and 1.1 devices present.

n Client computers must have USB controller hardware and modules that support USB 3.0, 2.0, and 1.1
devices present.

n To use the xHCI controller on a Linux guest, ensure that the Linux kernel version is 2.6.35 or later.

n Verify that the virtual machine is powered on.

n Required Privilege (ESXi host passthrough): Virtual Machine.Configuration.Add or Remove Device

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select USB Controller and click Add device.

The USB controller appears in the virtual device list above.

5 Click the USB controller triangle to expand the USB controller options.

6 Select the type of USB controller.

7 Click OK.

What to do next

Add one or more USB devices to the virtual machine.

Add a USB Controller to a Virtual Machine in the vSphere Client
USB controllers are available to add to virtual machines to support USB passthrough from an ESXi host or
client computer to the virtual machine.

You can add two USB controllers to a virtual machine. The xHCI controller, available for Linux guest operating
systems only, supports USB 3.0 superspeed, 2.0, and 1.1 devices. The EHCI+UHCI controller supports USB 2.0
and 1.1 devices.

The conditions for adding a controller vary, depending on the device version, the type of passthrough (host
or client computer), and the guest operating system.
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Table 8-11.  USB Controller Support

Controller type
Supported USB Device
Version

Supported for Passthrough
from ESXi Host to VM

Supported for Passthrough from
Client Computer to VM

EHCI+UHCI 2.0 and 1.1 Yes Yes

xHCI 3.0, 2.0, and 1.1 Yes (USB 2.0 and 1.1 devices
only)

Yes (Linux guests only)

NOTE   Drivers are not available for the xHCI controller on Windows guest operating systems.

For Mac OS X systems, the EHCI+UHCI controller is enabled by default and is required for USB mouse and
keyboard access.

For virtual machines with Linux guests, you can add one or both controllers, but 3.0 superspeed devices are
not supported for passthrough from an ESXi host to a virtual machine. You cannot add two controllers of the
same type.

For USB passthrough from an ESXi host to a virtual machine, the USB arbitrator can monitor a maximum of
15 USB controllers. If your system includes controllers that exceed the 15 controller limit and you connect USB
devices to them, the devices are not available to the virtual machine.

Prerequisites

n ESXi hosts must have USB controller hardware and modules that support USB 2.0 and 1.1 devices present.

n Client computers must have USB controller hardware and modules that support USB 3.0, 2.0, and 1.1
devices present.

n To use the xHCI controller on a Linux guest, ensure that the Linux kernel version is 2.6.35 or later.

n Verify that the virtual machine is powered on.

n Required Privilege (ESXi host passthrough): Virtual Machine.Configuration.Add or Remove Device

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select the type of USB Controller to add and click Next.

4 Review the device information and click Next.

5 Click Finish.

New USB Controller (adding) appears in the hardware list as Present.

6 Click OK to save your changes and close the dialog box.

When you reopen the Properties Editor, the xHCI controller appears on the Hardware tab as USB xHCI
controller. The EHCI+UHCI controller appears asUSB controller.

What to do next

Add one or more USB devices to the virtual machine.
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Add USB Devices from an ESXi Host to a Virtual Machine in the
vSphere Web Client

You can add one or more USB passthrough devices from an ESXi host to a virtual machine if the physical
devices are connected to the host on which the virtual machine runs.

If a USB device is connected to another virtual machine, you cannot add it until that machine releases it.

NOTE    If you have the Apple Frontpanel Controller device in your environment, you can safely add it to a
virtual machine. However, this device has no documented function and no known use. ESXi hosts do not use
it and do not provide Xserver functionality for USB passthrough

Prerequisites

n Verify that the virtual machine is using hardware version 7 or later.

n Verify that a USB controller is present. See “Add a USB Controller to a Virtual Machine in the vSphere
Web Client,” on page 153.

n To use vMotion to migrate a virtual machine with multiple USB devices, you must enable all attached
USB devices for vMotion. You cannot migrate individual USB devices. For vMotion limitations, see 
“Configuring USB Devices for vMotion,” on page 151.

n When you add a CD/DVD-ROM drive that is backed by a USB CD/DVD drive on the host, you must add
the drive as a SCSI device. Hot adding and removing SCSI devices is not supported.

n Verify that you know the virtual machine requirements for USB devices. See “USB Configuration from an
ESXi Host to a Virtual Machine,” on page 149.

n Required privileges: Virtual Machine.Configuration.HostUSBDevice

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select USB Device and click Add device.

The USB device appears in the virtual device list above.

5 Click the USB device triangle to expand the USB device options.

6 Select the device to add.

You can add multiple USB devices, but only one device at a time.

7 If you do not plan to migrate a virtual machine with USB devices attached, deselect the Support
vMotion option.

This reduces migration complexity, which results in better performance and stability.

8 Click OK.
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Add USB Devices from an ESXi Host to a Virtual Machine in the vSphere Client
You can add one or more USB passthrough devices from an ESXi host to a virtual machine if the physical device
is connected to the host on which the virtual machine runs.

If a USB device is connected to another virtual machine, you cannot add it until that machine releases it.

NOTE    If you have the Apple Frontpanel Controller device in your environment, you can safely add it to a
virtual machine. However, this device has no documented function and no known use. ESXi hosts do not use
it and do not provide Xserver functionality for USB passthrough

Prerequisites

n Verify that the virtual machine is using hardware version 7 or later.

n Verify that a USB controller is present. See “Add a USB Controller to a Virtual Machine in the vSphere
Client,” on page 154.

n To use vMotion to migrate a virtual machine with multiple USB devices, you must enable all attached
USB devices for vMotion. You cannot migrate individual USB devices. For vMotion limitations, see 
“Configuring USB Devices for vMotion,” on page 151.

n When you add a CD/DVD-ROM drive that is backed by a USB CD/DVD drive on the host, you must add
the drive as a SCSI device. Hot adding and removing SCSI devices is not supported.

n Verify that you know the virtual machine requirements for USB devices. See “USB Configuration from an
ESXi Host to a Virtual Machine,” on page 149.

n Required privileges: Virtual Machine.Configuration.HostUSBDevice

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select USB Device and click Next.

4 (Optional) Select Support vMotion while device is connected.

5 If you do not plan to migrate a virtual machine with USB devices attached, deselect the Support
vMotion option.

This reduces migration complexity, which results in better performance and stability.

6 Select a device to add.

You can add multiple USB devices, but only one device at a time.

7 Click Finish.

New USB Device (adding) appears in the hardware list as Present.

8 Click OK to save your changes and close the dialog box.

When you reopen the Properties editor, the USB device appears on the Hardware tab of the Properties Editor.
The device type and ID appear in the right pane.
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Remove USB Devices That Are Connected Through an ESXi Host
When you remove USB devices from a virtual machine, devices that use passthrough technology from a host
to the virtual machine revert to the host. The devices become available to other virtual machines that run on
that host.

Prerequisites

n Verify that the devices are not in use.

n To minimize the risk of data loss, follow the instructions to safely unmount or eject hardware for your
operating system. Safely removing hardware allows accumulated data to be transmitted to a file. Windows
operating systems typically include a Remove Hardware icon located in the System Tray. Linux operating
systems use the umount command.

NOTE   You might need to use the sync command instead of or in addition to the umount command, for
example after you issue a dd command on Linux or other UNIX operating systems.

Procedure

1 Unmount or eject the USB device from the guest operating system.

2 Right-click the virtual machine and select Edit Settings.

3 Click the Hardware tab and select the USB device.

4 Click Remove and click OK to save your changes and close the dialog box.

Remove a USB Controller from a Virtual Machine in the vSphere Client
You can remove a USB controller from a virtual machine if you do not want to connect to USB devices.

Prerequisites

n Verify that all USB devices are disconnected from the virtual machine.

n Required Privilege: Virtual Machine.Configuration.Add or Remove Device

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select USB controller.

3 Click Remove.

4 Click OK to save your changes and close the dialog box.

The controller is no longer connected to the virtual machine, but remains available to add at a later time.

Remove USB Devices from an ESXi Host
You can remove USB devices from the host if you must shut down the host for maintenance or if you do not
want those devices to be available to virtual machines that run on the host. When you detach a USB device
from the host, the device disconnects from the virtual machine.

CAUTION   If data transfer is taking place when you remove USB devices from a host, you can lose data.

Prerequisites

Verify that the USB devices are not in use.
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Procedure

u Follow the device manufacturers instructions to safely remove the device.

When you remove the device from the host, it is no longer available to the virtual machines that run on
the host.

USB Configuration from a Client Computer to a Virtual Machine in the
vSphere Web Client

You can add multiple USB devices to a virtual machine when the physical devices connect to a client computer
on which the vSphere Web Client is running. The vSphere Web Client must be logged in to an instance of
vCenter Server that manages the ESXi host where the virtual machines reside. USB passthrough technology
supports adding multiple USB devices, such as security dongles, mass storage devices, and smartcard readers
to virtual machines.

How USB Device Passthrough Technology Works
The USB controller is the USB hardware chip that provides USB function to the USB ports that it manages. USB
controller hardware and modules that support USB 3.0, 2.0, and USB 1.1 devices must exist in the virtual
machine. Two USB controllers are available for each virtual machine. The controllers support multiple USB
3.0, 2.0, and 1.1 devices. The controller must be present before you can add USB devices to the virtual machine.

You can add up to 20 USB devices to a virtual machine. This is the maximum number of devices supported
for simultaneous connection to one virtual machine.

You can add multiple devices to a virtual machine, but only one at a time. The virtual machine retains its
connection to the device while in S1 standby. USB device connections are preserved when you migrate virtual
machines to another host in the datacenter.

A USB device is available to only one powered-on virtual machine at a time. When a virtual machine connects
to a device, that device is no longer available to other virtual machines or to the client computer. When you
disconnect the device from the virtual machine or shut the virtual machine down, the device returns to the
client computer and becomes available to other virtual machines that the client computer manages.

For example, when you connect a USB mass storage device to a virtual machine, it is removed from the client
computer and does not appear as a drive with a removable device. When you disconnect the device from the
virtual machine, it reconnects to the client computer's operating system and is listed as a removable device.

USB 3.0 Device Limitations
USB 3.0 devices have the following requirements and limitations:

n The virtual machine that you connect the USB 3.0 device to must be configured with an xHCI controller
and have a Linux guest operating system with a 2.6.35 or later kernel.

n You can connect only one USB 3.0 device operating at superspeed to a virtual machine at a time.

n USB 3.0 devices are available only for passthrough from a client computer to a virtual machine. They are
not available for passthrough from an ESXi host to a virtual machine.

Avoiding Data Loss
Before you connect a device to a virtual machine, make sure the device is not in use on the client computer.

If the vSphere Client disconnects from the vCenter Server or host, or if you restart or shut down the client
computer, the device connection breaks. It is best to have a dedicated client computer for USB device use or
to reserve USB devices connected to a client computer for short-term use, such as updating software or adding
patches to virtual machines. To maintain USB device connections to a virtual machine for an extended time,
use USB passthrough from an ESXi host to the virtual machine.
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Connecting USB Devices to a Client Computer
You can connect and chain any multiple low, full, and high- or super-speed USB hubs and devices to a client
computer. Careful planning and knowledge of hub behavior and limitations can help ensure that your devices
work optimally.

USB physical bus topology defines how USB devices connect to the client computer. Support for USB device
passthrough to a virtual machine is available if the physical bus topology of the device on the client computer
does not exceed tier seven. The first tier is the USB host controller and root hub. The last tier is the target USB
device. You can cascade up to five tiers of external or internal hubs between the root hub and the target USB
device. An internal USB hub attached to the root hub or built into a compound device counts as one tier.

The quality of the physical cables, hubs, devices, and power conditions can affect USB device performance. To
ensure the best results, keep the client computer USB bus topology as simple as possible for the target USB
device, and use caution when you deploy new hubs and cables into the topology. The following conditions
can affect USB behavior:

n Connecting or chaining multiple external USB hubs increases device enumeration and response time,
which can make the power support to the connected USB devices uncertain.

n Chaining hubs together increases the chance of port and hub error, which can cause the device to lose
connection to a virtual machine.

n Certain hubs can cause USB device connections to be unreliable, so use care when you add a new hub to
an existing setup. Connecting certain USB devices directly to the client computer rather than to a hub or
extension cable might resolve their connection or performance issues. In some cases, you must remove
and reattach the device and hub to restore the device to a working state.

USB Compound Devices
For compound devices, the virtualization process filters out the USB hub so that it is not visible to the virtual
machine. The remaining USB devices in the compound appear to the virtual machine as separate devices. You
can add each device to the same virtual machine or to different virtual machines if they run on the same host.

For example, the Aladdin HASP HL Drive USB dongle package contains three devices (0529:0001 HASP dongle,
13fe:1a00 Hub, 13fe:1d00 Kingston Drive). The virtualization process filters out the USB hub. The remaining
Aladdin HASP HL Drive USB dongle devices (one Aladdin HASP dongle and one Kingston Drive) appear to
the virtual machine as individual devices. You must add each device separately to make it accessible to the
virtual machine.

Connect USB Devices to a Client Computer
You can connect multiple USB devices to a client computer so that virtual machines can access the devices.
The number of devices that you can add depends on several factors, such as how the devices and hubs chain
together and the device type.

The number of ports on each client computer depends on the physical setup of the client. When you calculate
the depth of hub chaining, remember that on a typical server the front ports connect to an internal hub.

The USB arbitrator can monitor a maximum of 15 USB controllers. If your system includes controllers that
exceed the 15 controller limit and you connect USB devices to them, the devices are not available to the virtual
machine.

Prerequisites

Verify that you know the requirements for configuring USB devices from a remote computer to a virtual
machine.
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Procedure

u To add a USB device to a client computer, connect the device to an available port or hub.

The USB device appears in the virtual machine toolbar menu.

What to do next

You can now add the USB device to the virtual machine.

Add a USB Controller to a Virtual Machine in the vSphere Web Client
USB controllers are available to add to virtual machines to support USB passthrough from an ESXi host or
from a client computer to a virtual machine.

You can add two USB controllers to a virtual machine. The xHCI controller, available for Linux guest operating
systems only, supports USB 3.0 superspeed, 2.0, and 1.1 devices. The EHCI+UHCI controller supports USB 2.0
and 1.1 devices.

The conditions for adding a controller vary, depending on the device version, the type of passthrough (host
or client computer), and the guest operating system.

Table 8-12.  USB Controller Support

Controller type
Supported USB Device
Version

Supported for Passthrough
from ESXi Host to VM

Supported for Passthrough from
Client Computer to VM

EHCI+UHCI 2.0 and 1.1 Yes Yes

xHCI 3.0, 2.0, and 1.1 Yes (USB 2.0 and 1.1 devices
only)

Yes (Linux guests only)

NOTE   Drivers are not available for the xHCI controller on Windows guest operating systems.

For Mac OS X systems, the EHCI+UHCI controller is enabled by default and is required for USB mouse and
keyboard access.

For virtual machines with Linux guests, you can add one or both controllers, but 3.0 superspeed devices are
not supported for passthrough from an ESXi host to a virtual machine. You cannot add two controllers of the
same type.

For USB passthrough from an ESXi host to a virtual machine, the USB arbitrator can monitor a maximum of
15 USB controllers. If your system includes controllers that exceed the 15 controller limit and you connect USB
devices to them, the devices are not available to the virtual machine.

Prerequisites

n ESXi hosts must have USB controller hardware and modules that support USB 2.0 and 1.1 devices present.

n Client computers must have USB controller hardware and modules that support USB 3.0, 2.0, and 1.1
devices present.

n To use the xHCI controller on a Linux guest, ensure that the Linux kernel version is 2.6.35 or later.

n Verify that the virtual machine is powered on.

n Required Privilege (ESXi host passthrough): Virtual Machine.Configuration.Add or Remove Device
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Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 From the Add a device drop-down menu, select USB Controller and click Add device.

The USB controller appears in the virtual device list above.

5 Click the USB controller triangle to expand the USB controller options.

6 Select the type of USB controller.

7 Click OK.

What to do next

Add one or more USB devices to the virtual machine.

Add USB Devices From a Client Computer to a Virtual Machine in the
vSphere Web Client

You can add one or more USB passthrough devices from a client computer to a virtual machine on the virtual
machine Summary page in the vSphere Web Client. The devices must be connected to a client computer that
connects to the ESXi host on which the virtual machine resides.

The devices maintain their virtual machine connections in S1 standby, if the vSphere Web Client is running
and connected. After you add the USB device to the virtual machine, an information message appears on the
client computer stating that the device is disconnected. The device remains disconnected from the client
computer until the virtual machine releases it.

FT is not supported with USB passthrough from a client computer to a virtual machine.

Prerequisites

n Verify that the Client Integration Plug-in is installed.

n Verify that a USB Controller is present.

n Verify that the vSphere Web Client has access to the ESXi host on which the virtual machines are running.

n Required Privilege: Virtual Machine.Interaction.Add or Remove Device

Procedure

1 Select a virtual machine in the inventory and click the Summary tab.

2 Click the USB icon to the right of USB Devices under VM Hardware and select an available device from
the drop-down menu.

A Connecting label and a spinner appear, which indicates that a connection is in progress. When the
device has successfully connected and the Summary tab refreshes, the device is connected and the device
name appears next to USB Devices.
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Remove USB Devices That Are Connected Through a Client Computer in the
vSphere Web Client

You can remove USB devices from a virtual machine if the devices are no longer needed. When you disconnect
a USB device from a virtual machine, the device is released from the virtual machine and is given back to the
client computer, which starts using it.

Prerequisites

n To minimize the risk of data loss, follow the instructions to safely unmount or eject hardware for your
operating system. Safely removing hardware allows accumulated data to be transmitted to a file. Windows
operating systems typically include a Remove Hardware icon located in the System Tray. Linux operating
systems use the umount command.

NOTE   You might need to use the sync command instead of or in addition to the umount command, for
example after you run a dd command on Linux or other UNIX operating systems.

n Required Privilege: Virtual Machine.Interaction.Add or Remove Device

Procedure

1 Unmount or eject the USB device from the guest operating system.

2 On the virtual machine Summary tab, click the disconnect icon on the right side of the USB device entry.

3 Select a device to disconnect from the drop-down menu.

A Disconnecting label and a spinner appear, indicating that a disconnection is in progress. When the
device is disconnected, after a slight delay, the Summary tab refreshes and the device is removed from
the virtual machine configuration.

The device reconnects to the client computer and is available to add to another virtual machine. In some cases,
Windows Explorer detects the device and opens a dialog box on the client computer. You can close this dialog
box.

Remove a USB Controller from a Virtual Machine in the vSphere Web Client
You can remove a USB controller from the virtual machine if you do not want to connect to USB devices.

Prerequisites

n Verify that all USB devices are disconnected from the virtual machine.

n Required Privilege: Virtual Machine.Configuration.Add or Remove Device

Procedure

1 Right-click a virtual machine in the inventory and select Configuration > Edit Settings.

2 Select Virtual Hardware and expand the USB controller menu.

3 Click Remove.

4 Click OK to save your changes and close the dialog box.

The controller is no longer connected to the virtual machine, but remains available to add at a later time.
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Remove USB Devices from a Client Computer
You can remove USB devices from a client computer if you do not want those devices to be available to virtual
machines.

When you detach a USB device from the remote client, the device disconnects from the virtual machine. Ensure
that data transfer is not taking place before you remove the device.

Prerequisites

Verify that the devices are not in use.

Procedure

u To minimize the risk of data loss, follow the instructions to safely unmount or eject hardware for your
operating system. Safely removing hardware allows accumulated data to be transmitted to a file. Windows
operating systems typically include a Remove Hardware icon located in the System Tray. Linux operating
systems use the umount command.

You might need to use the sync command instead of or in addition to the umount command, for example
after you issue a dd command on Linux or other UNIX operating systems.

When you remove the device from the client computer, it is no longer available to virtual machines.

USB Configuration from a Client Computer to a Virtual Machine in the
vSphere Client

You can add multiple USB devices to a virtual machine when the physical devices connect to a client computer
on which the vSphere Client is running. The vSphere Client must be logged in to an instance of vCenter Server
that manages the ESXi host where the virtual machines reside. USB passthrough technology supports adding
multiple USB devices, such as security dongles, mass storage devices, and smartcard readers to virtual
machines.

How USB Device Passthrough Technology Works
The USB controller is the USB hardware chip that provides USB function to the USB ports that it manages. USB
controller hardware and modules that support USB 3.0, 2.0, and USB 1.1 devices must exist in the virtual
machine. Two USB controllers are available for each virtual machine. The controllers support multiple USB
3.0, 2.0, and 1.1 devices. The controller must be present before you can add USB devices to the virtual machine.

You can add up to 20 USB devices to a virtual machine. This is the maximum number of devices supported
for simultaneous connection to one virtual machine.

You can add multiple devices to a virtual machine, but only one at a time. The virtual machine retains its
connection to the device while in S1 standby. USB device connections are preserved when you migrate virtual
machines to another host in the datacenter.

A USB device is available to only one powered-on virtual machine at a time. When a virtual machine connects
to a device, that device is no longer available to other virtual machines or to the client computer. When you
disconnect the device from the virtual machine or shut the virtual machine down, the device returns to the
client computer and becomes available to other virtual machines that the client computer manages.

For example, when you connect a USB mass storage device to a virtual machine, it is removed from the client
computer and does not appear as a drive with a removable device. When you disconnect the device from the
virtual machine, it reconnects to the client computer's operating system and is listed as a removable device.
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USB 3.0 Device Limitations
USB 3.0 devices have the following requirements and limitations:

n The virtual machine that you connect the USB 3.0 device to must be configured with an xHCI controller
and have a Linux guest operating system with a 2.6.35 or later kernel.

n You can connect only one USB 3.0 device operating at superspeed to a virtual machine at a time.

n USB 3.0 devices are available only for passthrough from a client computer to a virtual machine. They are
not available for passthrough from an ESXi host to a virtual machine.

Avoiding Data Loss
Before you connect a device to a virtual machine, make sure the device is not in use on the client computer.

If the vSphere Client disconnects from the vCenter Server or host, or if you restart or shut down the client
computer, the device connection breaks. It is best to have a dedicated client computer for USB device use or
to reserve USB devices connected to a client computer for short-term use, such as updating software or adding
patches to virtual machines. To maintain USB device connections to a virtual machine for an extended time,
use USB passthrough from an ESXi host to the virtual machine.

vSphere Features Available with USB Passthrough from a Client Computer
Migration with vMotion, DRS, and DPM are supported with USB device passthrough from a client computer
to a virtual machine.

Table 8-13.  Features Available for USB Passthrough from a Remote Computer to a Virtual Machine

Feature Supported with USB Device Passthrough

vSphere Distributed Power Management (DPM) Yes

vSphere Distributed Resource Scheduler (DRS) Yes

vSphere HA No

vSphere Fault Tolerance No

vSPhere vMotion Yes

Connecting USB Devices to a Client Computer
You can connect and chain any multiple low, full, and high- or super-speed USB hubs and devices to a client
computer. Careful planning and knowledge of hub behavior and limitations can help ensure that your devices
work optimally.

USB physical bus topology defines how USB devices connect to the client computer. Support for USB device
passthrough to a virtual machine is available if the physical bus topology of the device on the client computer
does not exceed tier seven. The first tier is the USB host controller and root hub. The last tier is the target USB
device. You can cascade up to five tiers of external or internal hubs between the root hub and the target USB
device. An internal USB hub attached to the root hub or built into a compound device counts as one tier.

The quality of the physical cables, hubs, devices, and power conditions can affect USB device performance. To
ensure the best results, keep the client computer USB bus topology as simple as possible for the target USB
device, and use caution when you deploy new hubs and cables into the topology. The following conditions
can affect USB behavior:

n Connecting or chaining multiple external USB hubs increases device enumeration and response time,
which can make the power support to the connected USB devices uncertain.
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n Chaining hubs together increases the chance of port and hub error, which can cause the device to lose
connection to a virtual machine.

n Certain hubs can cause USB device connections to be unreliable, so use care when you add a new hub to
an existing setup. Connecting certain USB devices directly to the client computer rather than to a hub or
extension cable might resolve their connection or performance issues. In some cases, you must remove
and reattach the device and hub to restore the device to a working state.

USB Compound Devices
For compound devices, the virtualization process filters out the USB hub so that it is not visible to the virtual
machine. The remaining USB devices in the compound appear to the virtual machine as separate devices. You
can add each device to the same virtual machine or to different virtual machines if they run on the same host.

For example, the Aladdin HASP HL Drive USB dongle package contains three devices (0529:0001 HASP dongle,
13fe:1a00 Hub, 13fe:1d00 Kingston Drive). The virtualization process filters out the USB hub. The remaining
Aladdin HASP HL Drive USB dongle devices (one Aladdin HASP dongle and one Kingston Drive) appear to
the virtual machine as individual devices. You must add each device separately to make it accessible to the
virtual machine.

Connect USB Devices to a Client Computer
You can connect multiple USB devices to a client computer so that virtual machines can access the devices.
The number of devices that you can add depends on several factors, such as how the devices and hubs chain
together and the device type.

The number of ports on each client computer depends on the physical setup of the client. When you calculate
the depth of hub chaining, remember that on a typical server the front ports connect to an internal hub.

The USB arbitrator can monitor a maximum of 15 USB controllers. If your system includes controllers that
exceed the 15 controller limit and you connect USB devices to them, the devices are not available to the virtual
machine.

Prerequisites

Verify that you know the requirements for configuring USB devices from a remote computer to a virtual
machine.

Procedure

u To add a USB device to a client computer, connect the device to an available port or hub.

The USB device appears in the virtual machine toolbar menu.

What to do next

You can now add the USB device to the virtual machine.

Add a USB Controller to a Virtual Machine in the vSphere Client
USB controllers are available to add to virtual machines to support USB passthrough from an ESXi host or
client computer to the virtual machine.

You can add two USB controllers to a virtual machine. The xHCI controller, available for Linux guest operating
systems only, supports USB 3.0 superspeed, 2.0, and 1.1 devices. The EHCI+UHCI controller supports USB 2.0
and 1.1 devices.

The conditions for adding a controller vary, depending on the device version, the type of passthrough (host
or client computer), and the guest operating system.
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Table 8-14.  USB Controller Support

Controller type
Supported USB Device
Version

Supported for Passthrough
from ESXi Host to VM

Supported for Passthrough from
Client Computer to VM

EHCI+UHCI 2.0 and 1.1 Yes Yes

xHCI 3.0, 2.0, and 1.1 Yes (USB 2.0 and 1.1 devices
only)

Yes (Linux guests only)

NOTE   Drivers are not available for the xHCI controller on Windows guest operating systems.

For Mac OS X systems, the EHCI+UHCI controller is enabled by default and is required for USB mouse and
keyboard access.

For virtual machines with Linux guests, you can add one or both controllers, but 3.0 superspeed devices are
not supported for passthrough from an ESXi host to a virtual machine. You cannot add two controllers of the
same type.

For USB passthrough from an ESXi host to a virtual machine, the USB arbitrator can monitor a maximum of
15 USB controllers. If your system includes controllers that exceed the 15 controller limit and you connect USB
devices to them, the devices are not available to the virtual machine.

Prerequisites

n ESXi hosts must have USB controller hardware and modules that support USB 2.0 and 1.1 devices present.

n Client computers must have USB controller hardware and modules that support USB 3.0, 2.0, and 1.1
devices present.

n To use the xHCI controller on a Linux guest, ensure that the Linux kernel version is 2.6.35 or later.

n Verify that the virtual machine is powered on.

n Required Privilege (ESXi host passthrough): Virtual Machine.Configuration.Add or Remove Device

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and click Add.

3 Select the type of USB Controller to add and click Next.

4 Review the device information and click Next.

5 Click Finish.

New USB Controller (adding) appears in the hardware list as Present.

6 Click OK to save your changes and close the dialog box.

When you reopen the Properties Editor, the xHCI controller appears on the Hardware tab as USB xHCI
controller. The EHCI+UHCI controller appears asUSB controller.

What to do next

Add one or more USB devices to the virtual machine.
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Add USB Devices From a Client Computer to a Virtual Machine in the vSphere
Client

You can add one or more USB passthrough devices from a client computer to a virtual machine in the vSphere
Client. The devices must be connected to a client computer that connects to the ESXi host on which the virtual
machines reside.

The devices maintain their virtual machine connections in S1 standby, if the vSphere Client is running and
connected. After you add the USB device to the virtual machine, an information message appears on the client
computer stating that the device is disconnected. The device remains disconnected from the client computer
until the virtual machine releases it.

FT is not supported with USB passthrough from a client computer to a virtual machine.

Prerequisites

n Verify that a USB controller is installed.

n Verify that the vSphere Client is connected to the ESXi host on which the virtual machines are running.

n Required Privilege: Virtual Machine.Interaction.Add or Remove Device

Procedure

1 Select the virtual machine in the vSphere Client inventory.

2 Click the USB icon on the virtual machine toolbar.

3 Select an available device from the Connect to USB Devices drop-down menu.

The status of the device appears as Connecting.

The device appears in the USB Connections drop-down menu and is ready to use. The device remains
connected until you power off the virtual machine or disconnect the vSphere Client from the ESXi host.

Remove USB Devices That Are Connected Through a Client Computer in the
vSphere Client

You can remove USB devices from a virtual machine if the devices are no longer needed. When you disconnect
a USB device from a virtual machine, the device is released from the virtual machine and is given back to the
client computer, which starts using it.

Prerequisites

To minimize the risk of data loss, follow the instructions to safely unmount or eject hardware for your operating
system. Safely removing hardware allows accumulated data to be transmitted to a file. Windows operating
systems typically include a "Remove Hardware" icon located in the System Tray. Linux operating systems use
the umount command.

NOTE   You might need to use the sync command instead of or in addition to the umount command, for example
after you run a dd command on Linux or other UNIX operating systems.

Procedure

1 Unmount or eject the USB device from the guest operating system.

2 Select the virtual machine in the vSphere Client inventory.

3 Click USB Connections on the virtual machine toolbar.
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4 Select the device to remove from the drop-down menu.

For example, select USB Device 1 > Disconnect fromdevice name.

The menu shows the device status as Disconnecting.

The device reconnects to the client computer and is available to add to another virtual machine. In some cases,
Windows Explorer detects the device and opens a dialog box on the client computer. You can close this dialog
box.

Remove a USB Controller from a Virtual Machine in the vSphere Client
You can remove a USB controller from a virtual machine if you do not want to connect to USB devices.

Prerequisites

n Verify that all USB devices are disconnected from the virtual machine.

n Required Privilege: Virtual Machine.Configuration.Add or Remove Device

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Hardware tab and select USB controller.

3 Click Remove.

4 Click OK to save your changes and close the dialog box.

The controller is no longer connected to the virtual machine, but remains available to add at a later time.

Remove USB Devices from a Client Computer
You can remove USB devices from a client computer if you do not want those devices to be available to virtual
machines.

When you detach a USB device from the remote client, the device disconnects from the virtual machine. Ensure
that data transfer is not taking place before you remove the device.

Prerequisites

Verify that the devices are not in use.

Procedure

u To minimize the risk of data loss, follow the instructions to safely unmount or eject hardware for your
operating system. Safely removing hardware allows accumulated data to be transmitted to a file. Windows
operating systems typically include a Remove Hardware icon located in the System Tray. Linux operating
systems use the umount command.

You might need to use the sync command instead of or in addition to the umount command, for example
after you issue a dd command on Linux or other UNIX operating systems.

When you remove the device from the client computer, it is no longer available to virtual machines.
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Cannot Copy Data From an ESXi Host to a USB Device That Is
Connected to the Host

You can connect a USB device to an ESXi host and copy data to the device from the host. For example, you
might want to gather the vm-support bundle from the host after the host loses network connectivity. To perform
this task, you must stop the USB arbitrator.

Problem

If the USB arbitrator is being used for USB passthrough from an ESXi host to a virtual machine, or if the USB
device is formatted with a FAT16 partition and is the maximum size of 2GB, the USB device appears under
lsusb but does not mount correctly.

Cause

This problem occurs because the usbarbitrator service has claimed the device to make it available for
passthrough from the host to virtual machines.

Solution

1 Stop the usbarbitrator service:/etc/init.d/usbarbitrator stop

2 Disconnect and reconnect the USB device.

By default, the device location is /vmfs/devices/disks/mpx.vmhbaXX:C0:T0:L0.

After using the device, restart the usbarbitrator service:/etc/init.d/usbarbitrator start

Add a Shared Smart Card Reader to Virtual Machines in the vSphere
Client

You can configure multiple virtual machines to use a virtual shared smart card reader for smart card
authentication. The smart card reader must be connected to a client computer on which the vSphere Client
runs. All smart card readers are treated as USB devices.

A license is required for the shared smart card feature. See the vCenter Server and Host Management
documentation.

When you log out of Windows XP guest operating systems, to log back in, you must remove the smart card
from the smart card reader and re-add it. You can also disconnect the shared smart card reader and reconnect
it.

If the vSphere Client disconnects from the vCenter Server or host, or if the client computer is restarted or shut
down, the smart card connection breaks. For this reason, it is best to have a dedicated client computer for smart
card use.

To connect a USB smart card reader that is not shared, see “USB Configuration from a Client Computer to a
Virtual Machine in the vSphere Client,” on page 164.

Prerequisites

n Verify that the smart card reader is connected to the client computer.

n Verify that the virtual machine is powered on.

n Verify that a USB controller is present.

Procedure

1 Select the virtual machine in the vSphere Client inventory.

2 Click the USB icon on the virtual machine toolbar.
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3 Select the shared smart card reader from the Connect to USB Devices drop-down menu.

The smart card device appears in the menu as a USB device and as a virtual shared device.

4 Select Sharedthe model name of your smart card reader followed by a number.

The device status appears as Connecting, then the device connects.

You can now use smart card authentication to log in to virtual machines in the vSphere Client inventory.

Add a Shared Smart Card Reader to Virtual Machines in the
vSphere Web Client

You can configure multiple virtual machines to use a virtual shared smart card reader for smart card
authentication. The smart card reader must be connected to a client computer on which the
vSphere Web Client runs. All smart card readers are treated as USB devices.

A license is required for the shared smart card feature. See vCenter Server and Host Management.

When you log out of Windows XP guest operating systems, to log back in, you must remove the smart card
from the smart card reader and re-add it. You can also disconnect the shared smart card reader and reconnect
it.

If the vSphere Web Client disconnects from the vCenter Server or host, or if the client computer is restarted or
shut down, the smart card connection breaks. For this reason, it is best to have a dedicated client computer for
smart card use.

To connect a USB smart card reader that is not shared, see “USB Configuration from a Client Computer to a
Virtual Machine in the vSphere Web Client,” on page 159.

Prerequisites

n Verify that the smart card reader is connected to the client computer.

n Verify that the virtual machine is powered on.

n Verify that a USB controller is present.

n Required Privilege: Virtual Machine.Interaction.Add or Remove Device

Procedure

1 Select a virtual machine in the inventory and click the Summary tab.

2 Click the USB icon on the right side of USB Devices under VM Hardware, and select an available shared
smart card reader from the drop down menu.

Select a device that appears as Sharedthe model name of your smart card reader followed by a number.

A Connecting label and a spinner appear showing that a connection is in progress. When the device has
successfully connected and the Summary tab refreshes, the device is connected and the device name
appears next to USB Devices.

You can now use smart card authentication to log in to virtual machines in the vSphere Client inventory.

Manage Power Management Settings for a Virtual Machine
You can set the power options so that a virtual machine is suspended or remains powered on when the guest
operating system is placed on standby.

Power Management options are not available on every guest operating system. Wake on LAN supports only
Windows guest operating systems and is not available on Vlance NICs, or when a Flexible NIC is operating
in Vlance mode (that is, the current VMware Tools are not installed on the guest operating system).
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Wake on LAN can resume virtual machines that are in an S1 sleep state only. It cannot resume suspended,
hibernated, or powered off virtual machines.

The following NICs support Wake on LAN:

n Flexible (VMware Tools required).

n vmxnet

n Enhanced vmxnet

n vmxnet 3

Prerequisites

You must power off the virtual machine.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and select Power Management.

3 In the Guest Power Management panel, select a power option.

n Suspend the virtual machine

n Put the guest operating system in standby mode and leave the virtual machine powered on

4 (Optional) Select Wake on LAN for virtual machine traffic on and select the virtual NICs to trigger this
action.

Unsupported NICs might be listed, but are unavailable to connect.

5 Click OK to save your changes and close the dialog box.

Configure the Virtual Machine Power States
Changing virtual machine power states is useful when you do maintenance on the host. You can use the system
default settings for the toolbar power controls or you can configure the controls to interact with the guest
operating system. For example, you can configure the stop button on the toolbar to power off the virtual
machine or shut down the guest operating system.

You can modify many virtual machine configurations while the virtual machine is running, but you might
need to change the virtual machine power state for some configurations.

Table 8-15 lists available power buttons and describes their behavior.

Table 8-15.  Virtual Machine Power Button Settings

Power Button Description

Shuts down the guest operating system or powers off the virtual machine. A
power off operation displays a confirmation dialog box indicating that the guest
operating system might not shut down properly. Use this power off option only
when necessary.

Suspends the virtual machine without running a script when VMware Tools is
not installed. When VMware Tools is installed and available, a suspend action
runs a script, and suspends the virtual machine.
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Table 8-15.  Virtual Machine Power Button Settings (Continued)

Power Button Description

Powers on a virtual machine when a virtual machine is stopped, or resumes the
virtual machine and runs a script when it is suspended and VMware Tools is
installed and available. Resumes the virtual machine and does not run a script
when VMware Tools is not installed.

Resets the virtual machine when VMware Tools is not installed. Restarts the guest
operating system when VMware Tools is installed and available. A reset
operation displays a confirmation dialog box indicating that the guest operating
system is not shut down properly.

Prerequisites

n Verify that the vSphere Client is logged in to a vCenter Server.

n Verify that you have access to at least one virtual machine in the inventory.

n Verify that you have privileges to perform the intended power operation on the virtual machine.

n To set optional power functions, you must install VMWare Tools in the virtual machine.

n Power off the virtual machine before editing the VMware Tools options.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and select VMware Tools.

3 In the right panel, select the Power Controls for the virtual machine.

4 Select an option for the Power Off button.

Option Description

Shut Down Guest Uses VMware Tools to initiate an orderly system shut down of the virtual
machine. This type of powering off is known as a "soft" power operation. Soft
power operations are possible only if the tools are installed in the guest
operating system.

Power Off Immediately stops the virtual machine. This type of powering off is known
as a "hard" power operation.

System Default Follows system settings. The current value of the system settings is shown
in parentheses.

 
5 Select an option for the Suspend button.

Option Description

Suspend Pauses all virtual machine activity.

System Default Follows system settings. The current value of the system setting is shown in
parentheses.
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6 Select an option for the Reset button.

Option Description

Restart Guest Uses VMware Tools to initiate an orderly reboot. (This type of reset is known
as a "soft" power operation. Soft power operations are possible only if the
tools are installed in the guest operating system.)

Reset Shuts down and restarts the guest operating system without powering off
the virtual machine. (This type of reset is known as a "hard" power
operation.)

System Default Follows system settings; the current value of the system setting is shown in
parentheses.

 
7 Click OK to save your changes and close the dialog box.

What to do next

Configure VMware Tools scripts to run before or after power operations.

Delay the Boot Sequence in the vSphere Web Client
Delaying the boot operation is useful for changing BIOS or EFI settings such as the boot order. For example,
you can change the BIOS or EFI settings to force a virtual machine to boot from a CD-ROM.

Prerequisites

n vSphere Web Client logged in to a vCenter Server

n Access to at least one virtual machine in the inventory

n Privileges to edit boot options for the virtual machine

Procedure

1 In the VM Hardware panel, click Edit Settings.

2 Click VM Options.

3 Click the Boot Options triangle to expand the options.

4 Select the time in milliseconds to delay the boot operation.

5 (Optional) Select whether to force entry into the BIOS or EFI setup screen the next time the virtual machine
boots.

6 (Optional) Select whether to try to reboot after a boot failure.

7 Click OK.

Delay the Boot Sequence in the vSphere Client
The time between when you power on the virtual machine and when it exits the BIOS or EFI and launches the
guest operating system software can be short. You can change the boot delay or force the virtual machine to
enter the BIOS or EFI setup screen after power on.

Delaying the boot operation is useful for changing BIOS or EFI settings such as the boot order. For example,
you can change the BIOS or EFI settings to force a virtual machine to boot from a CD-ROM.

Prerequisites

Required Privilege: Virtual machine.Configuration.Settings
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Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and under Advanced select Boot Options.

3 In the Power on Boot Delay panel, select the time in milliseconds to delay the boot operation.

4 (Optional) Select whether to force entry into the BIOS or EFI setup screen the next time the virtual machine
boots.

5 (Optional) Select whether to try to reboot after a boot failure.

6 Click OK to save your changes and close the dialog box.

Enable Virtual Machine Logging in the vSphere Web Client
You can enable logging to collect log files to help troubleshoot issues with your virtual machine.

Prerequisites

Required privilege: Virtual machine.Configuration.Settings

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click VM Options.

4 Click the Advanced triangle to expand the advanced virtual machine options.

5 Select Enable logging.

6 Click OK.

Enable Logging in the vSphere Client
You can enable logging to collect log files to help troubleshoot issues with your virtual machine.

Required privilege: Virtual machine.Configuration.Settings

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Edit Settings.

2 Click the Options tab and select AdvancedGeneral.

3 In the Settings pane, select Enable logging.

4 Click OK.

Disable Virtual Machine Acceleration in the vSphere Web Client
You can temporarily disable acceleration to allow a virtual machine to successfully run or install software.

In rare instances, you might find that when you install or run software in a virtual machine, the virtual machine
appears to stop responding. Generally, the problem occurs early in the program’s execution. Often, you can
get past the problem by temporarily disabling acceleration in the virtual machine.
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This setting slows down virtual machine performance, so only use it for getting past the problem with running
the program. After the program stops encountering problems, deselect Disable acceleration. Then you might
be able to run the program with acceleration.

You can enable and disable acceleration when the virtual machine is running.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click VM Options.

4 Click the Advanced triangle to expand the advanced virtual machine options.

5 Select Disable acceleration.

6 Click OK.

Disable Acceleration in the vSphere Client
You can temporarily disable acceleration to allow a virtual machine to successfully run or install software.

In rare instances, you might find that when you install or run software in a virtual machine, the virtual machine
appears to stop responding. Generally, the problem occurs early in the program’s execution. Often, you can
get past the problem by temporarily disabling acceleration in the virtual machine.

This setting slows down virtual machine performance, so only use it for getting past the problem with running
the program. After the program stops encountering problems, deselect Disable acceleration. Then you might
be able to run the program with acceleration.

You can enable and disable acceleration when the virtual machine is running.

Procedure

1 Click the Options tab.

2 Select Advanced > General in the Settings list.

3 To disable acceleration, select the Disable acceleration check box.

Configure Virtual Machine Debugging and Statistics in the
vSphere Web Client

You can run a virtual machine so that it collects additional debugging information that is helpful to VMware
technical support in resolving issues.

Prerequisites

Power off the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.
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2 In the VM Hardware panel, click Edit Settings.

3 Click VM Options.

4 Click the Advanced triangle to expand the advanced virtual machine options.

5 Select a debugging and statistics option.

n Run normally

n Record Debugging Information

n Record Statistics

n Record Statistics and Debugging Information

The number of debugging and statistics options available depends on the host software type and version.
On some hosts, some options are not available.

6 Click OK.

Configure Debugging and Statistics in the vSphere Client
You can run a virtual machine so that it collects debugging information and statistics that are helpful to VMware
technical support in resolving issues.

Procedure

1 Click the Options tab and click Advanced > General.

2 To enable debugging mode, select an option from the Debugging and Statistics section.

Option Description

Run normally Collects debugging information.

Record debugging information Collects debugging and performance information. Use this option to aid
troubleshooting when the guest operating system crashes or is not behaving
properly.
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Managing Multi-Tiered Applications
with vSphere vApp 9

You can use VMware vSphere as a platform for running applications, in addition to using it as a platform for
running virtual machines. The applications can be packaged to run directly on top of VMware vSphere. The
format of how the applications are packaged and managed is called vSphere vApp.

A vApp is a container, like a resource pool and can contain one or more virtual machines. A vApp also shares
some functionality with virtual machines. A vApp can power on and power off, and can also be cloned.

In the vSphere Client, a vApp is represented in both the Host and Clusters view and the VM and Template
view. Each view has a specific summary page with the current status of the service and relevant summary
information, as well as operations on the service.

The distribution format for vApp is OVF.

NOTE   The vApp metadata resides in the vCenter Server's database, so a vApp can be distributed across multiple
ESXi hosts. This information can be lost if the vCenter Server database is cleared or if a standalone ESXi host
that contains a vApp is removed from vCenter Server. You should back up vApps to an OVF package to avoid
losing any metadata.

vApp metadata for virtual machines within vApps do not follow the snapshots semantics for virtual machine
configuration. So, vApp properties that are deleted, modified, or defined after a snapshot is taken remain intact
(deleted, modified, or defined) after the virtual machine reverts to that snapshot or any prior snapshots.

You can use VMware Studio to automate the creation of ready-to-deploy vApps with pre-populated
application software and operating systems. VMware Studio adds a network agent to the guest so that vApps
bootstrap with minimal effort. Configuration parameters specified for vApps appear as OVF properties in the
vCenter Server deployment wizard. For information about VMware Studio and for download, see the VMware
Studio developer page on the VMware web site.

This chapter includes the following topics:

n “Create a vApp in the vSphere Web Client,” on page 180

n “Create a vApp in the vSphere Client,” on page 182

n “Populate the vApp,” on page 183

n “Edit vApp Settings in the vSphere Web Client,” on page 185

n “Edit vApp Settings in the vSphere Client,” on page 188

n “Configuring IP Pools,” on page 193

n “Clone a vApp,” on page 195

n “Power on a vApp in the vSphere Web Client,” on page 195

n “Power On a vApp in the vSphere Client,” on page 196
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n “Power Off a vApp in the vSphere Web Client,” on page 196

n “Power Off a vApp in the vSphere Client,” on page 196

n “Suspend a vApp in the vSphere Web Client,” on page 196

n “Suspend a vApp in the vSphere Client,” on page 197

n “Resume a vApp in the vSphere Web Client,” on page 197

n “Resume a vApp in the vSphere Client,” on page 197

n “Edit vApp Annotation in the vSphere Web Client,” on page 197

n “Edit vApp Annotation in the vSphere Client,” on page 197

Create a vApp in the vSphere Web Client
After you create a datacenter and add a clustered host enabled with DRS or a standalone host to your
vCenter Server system, you can create a vApp.

You can create a vApp under the following conditions.

n A standalone host is selected in the inventory that is running ESX 3.0 or greater.

n A cluster enabled with DRS is selected in the inventory.

You can create vApps on folders, standalone hosts, resource pools, clusters enabled with DRS, and within other
vApps.

Procedure

1 Select vApp Name and Location on page 180
The name that you enter is the vApp display name that appears in the inventory.

2 Allocate vApp Resources on page 181
You can allocate CPU and memory resources for the new vApp using shares, reservations, and limits.

3 Complete the vApp Creation on page 181
Before you deploy the vApp, you can review the vApp settings.

Select vApp Name and Location
The name that you enter is the vApp display name that appears in the inventory.

Procedure

1 Right-click any inventory object that is a valid parent of a vApp and select Inventory > New vApp.

Valid parents of a vApp include clusters, resource pools, hosts, or other vApps.

2 In the vApp Name text box, type a name for the vApp.

3 Select the datacenter or folder in which to deploy the vApp.

4 Click Next.
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Allocate vApp Resources
You can allocate CPU and memory resources for the new vApp using shares, reservations, and limits.

Procedure

1 Allocate CPU capacity for this vApp.

Option Description

Shares CPU shares for this vApp with respect to the parent’s total. Sibling vApps
share resources according to their relative share values bounded by the
reservation and limit. Select Low, Normal, or High, which specify share
values respectively in a 1:2:4 ratio. Select Custom to give each vApp a specific
number of shares, which express a proportional weight.

Reservation Guaranteed CPU allocation for this vApp.

Reservation Type Select the Expandable check box to make the reservation expandable. When
the vApp is powered on, if the combined reservations of its virtual machines
are larger than the reservation of the vApp, the vApp can use resources from
its parent or ancestors.

Limit Upper limit for this vApp's CPU allocation. Select Unlimited to specify no
upper limit.

 
2 Allocate memory capacity for this vApp.

Option Description

Shares Memory shares for this vApp with respect to the parent’s total. Sibling vApps
share resources according to their relative share values bounded by the
reservation and limit. Select Low, Normal, or High, which specify share
values respectively in a 1:2:4 ratio. Select Custom to give each vApp a specific
number of shares, which express a proportional weight.

Reservation Guaranteed memory allocation for this vApp.

Reservation Type Select the Expandable check box to make the reservation expandable. When
the vApp is powered on, if the combined reservations of its virtual machines
are larger than the reservation of the vApp, the vApp can use resources from
its parent or ancestors.

Limit Upper limit for this vApp's memory allocation. Select Unlimited to specify
no upper limit.

 
3 Click Next.

Complete the vApp Creation
Before you deploy the vApp, you can review the vApp settings.

Procedure

1 Review the vApp settings and make any necessary changes by clicking Previous to back to the relevant
page.

2 Click Finish.
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Create a vApp in the vSphere Client
After you create a datacenter and add a clustered host enabled with DRS or a standalone host to your
vCenter Server system, you can create a vApp.

You can create a vApp under the following conditions.

n A standalone host is selected in the inventory that is running ESX 3.0 or greater.

n A cluster enabled with DRS is selected in the inventory.

You can create vApps on folders, standalone hosts, resource pools, clusters enabled with DRS, and within other
vApps.

Procedure

1 Start the New vApp Wizard on page 182
The New vApp wizard allows you to create a vApp.

2 Name the vApp on page 182
The name that you enter is the vApp display name that appears in the inventory.

3 Select the vApp Destination on page 183
The destination is the standalone host, cluster, resource pool, or another vApp on which the vApp will
run.

4 Allocate vApp Resources on page 183
Determine how CPU and memory should be allocated for the vApp.

5 Complete the vApp Creation on page 183
The Ready to Complete page lets you review the vApp configuration.

Start the New vApp Wizard
The New vApp wizard allows you to create a vApp.

Procedure

u Select File > New > vApp to open the New vApp wizard.

Name the vApp
The name that you enter is the vApp display name that appears in the inventory.

The vApp name can be up to 80 characters long. This name must be unique within the folder.

Procedure

1 On the Name and Folder page, enter a name for the vApp.

2 Select a folder location in the inventory for the vApp.

If you are creating a vApp from within another vApp, the vApp Inventory Location selection is
unavailable.

3 Click Next.
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Select the vApp Destination
The destination is the standalone host, cluster, resource pool, or another vApp on which the vApp will run.

NOTE   This step, selecting a vApp destination, does not appear if you create a vApp from a standalone host,
cluster, resource pool, or another vApp within the inventory.

Procedure

1 On the Destination page, select a standalone host, cluster, or resource pool where this vApp will run and
click Next.

If you selected a cluster enabled with DRS and the cluster is in DRS manual mode, select the host as the
destination for the vApp.

The message in the Compatibility panel indicates whether the validation for this destination succeeded
or whether a specific requirement was not met.

2 Click Next.

Allocate vApp Resources
Determine how CPU and memory should be allocated for the vApp.

Procedure

1 In the Resource Allocation page, allocate CPU and memory resources for this vApp.

2 Click Next.

Complete the vApp Creation
The Ready to Complete page lets you review the vApp configuration.

Procedure

1 Review the new vApp settings on the Ready to Complete page.

2 (Optional) Click Back to edit or change any settings.

3 Click Finish to create the vApp.

Populate the vApp
Virtual machines and other vApps can be added to and removed from a vApp.

After you create a vApp, you can populate it with virtual machines or other vApps.

Create an Object Inside a vApp in the vSphere Web Client
Within a vApp, you can create a new virtual machine, resource pool, or another vApp.

Procedure

1 In the inventory, select the vApp in which you want to create the object machine.
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2 Select the menu option to create a specific object.

Menu Option Description

Click the Create Virtual Machine

( ) icon.

Creates a new virtual machine inside the vApp. Complete the Create New
Virtual Machine wizard.

Click the Create Resource Pool ( )
icon.

Adds a resource pool inside the vApp. Complete the Create Resource Pool
dialog box.

Click the All Actions icon ( )
and select Inventory > New vApp.

Creates a new vApp inside the currently selected vApp. Complete the New
vApp wizard.

 

The new object appears as part of the vApp in the inventory.

Create an Object Inside the vApp in the vSphere Client
Within a vApp, you can create a new virtual machine, resource pool, or another vApp.

Procedure

1 In the inventory, select the vApp in which you want to create the object machine.

2 Select the menu option to create a specific object.

Menu Option Description

Inventory > vApp > New Virtual
Machine

Creates a new virtual machine inside the vApp. Complete the Create New
Virtual Machine wizard. See Chapter 4, “Creating a Virtual Machine in the
vSphere Client,” on page 29 for instructions on creating a new virtual
machine.

Inventory > vApp > New Resource
Pool

Adds a resource pool inside the vApp. Complete the Create Resource Pool
window.

Inventory > vApp > New vApp Creates a new vApp inside the currently selected vApp. Complete the New
vApp wizard. See “Create a vApp in the vSphere Client,” on page 182 for
instructions on creating a new vApp.

 

The new object appears as part of the vApp in the inventory.

Add an Object to a vApp in the vSphere Web Client
You can add an object, such as a virtual machine or another vApp, to an existing vApp.

An existing virtual machine or another vApp that is not already contained inside the vApp can be moved into
the currently selected vApp.

Procedure

1 Display the object in the inventory.

2 Click and drag the object to the target object.

If the move is not permitted, red x icon appears, and the object is not moved.

3 Release the mouse button.
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Add an Object to a vApp in the vSphere Client
You can add an object, such as a virtual machine or another vApp, to an existing vApp.

An existing virtual machine or another vApp that is not already contained inside the vApp can be moved into
the currently selected vApp.

Procedure

1 Display the object in the inventory.

2 Click and drag the object to the target object.

n If the move is permitted, a box appears around the target-object, indicating it is selected.

n If the move is not permitted, a naught sign (zero with a slash) appears, and the object is not moved.

3 Release the mouse button.

Either the object moves to the new location or an error message indicates what needs to be done to permit
the move.

Edit vApp Settings in the vSphere Web Client
You can edit and configure several vApp settings, including startup order, resources, and custom properties.

Configure vApp Resources in the vSphere Web Client
You can configure the CPU and memory resource allocation for the vApp.

Reservations on vApps and all their child resource pools, child vApps, and child virtual machines count against
the parent resources only when they are powered on.

Prerequisites

Required privilege: vApp resource configuration on the vApp.

Procedure

1 Right-click the vApp in the inventory and select Configuration > Edit Settings.

2 Allocate CPU capacity for this vApp.

Option Description

Shares CPU shares for this vApp with respect to the parent’s total. Sibling vApps
share resources according to their relative share values bounded by the
reservation and limit. Select Low, Normal, or High, which specify share
values respectively in a 1:2:4 ratio. Select Custom to give each vApp a specific
number of shares, which express a proportional weight.

Reservation Guaranteed CPU allocation for this vApp.

Reservation Type Select the Expandable check box to make the reservation expandable. When
the vApp is powered on, if the combined reservations of its virtual machines
are larger than the reservation of the vApp, the vApp can use resources from
its parent or ancestors.

Limit Upper limit for this vApp's CPU allocation. Select Unlimited to specify no
upper limit.
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3 Allocate memory capacity for this vApp.

Option Description

Shares Memory shares for this vApp with respect to the parent’s total. Sibling vApps
share resources according to their relative share values bounded by the
reservation and limit. Select Low, Normal, or High, which specify share
values respectively in a 1:2:4 ratio. Select Custom to give each vApp a specific
number of shares, which express a proportional weight.

Reservation Guaranteed memory allocation for this vApp.

Reservation Type Select the Expandable check box to make the reservation expandable. When
the vApp is powered on, if the combined reservations of its virtual machines
are larger than the reservation of the vApp, the vApp can use resources from
its parent or ancestors.

Limit Upper limit for this vApp's memory allocation. Select Unlimited to specify
no upper limit.

 
4 Click OK.

Configure vApp Properties in the vSphere Web Client
You can edit any vApp property that is defined in Advanced Property Configuration.

Prerequisites

Required privilege: vApp.vApp application configuration on the vApp.

Procedure

1 Right-click the vApp in the inventory and select Configuration > Edit Settings.

2 Click the Properties triangle to expand the vApp properties.

3 Edit the vApp properties.

4 Click OK.

Configure vApp IP Allocation Policy in the vSphere Web Client
You can edit how IP addresses are allocated for the vApp.

Prerequisites

Required privilege: vApp.vApp instance configuration

Procedure

1 Right-click the vApp in the inventory and select Configuration > Edit Settings.

2 Click the IP Allocation triangle to expand the IP allocation options.

3 Select an IP allocation option.

Option Description

Fixed IP addresses are manually configured. No automatic allocation is performed.

Transient IP addresses are automatically allocated using IP pools from a specified
range when the vApp is powered on. The IP addresses are released when the
appliance is powered off.

DHCP A DHCP server is used to allocate the IP addresses. The addresses assigned
by the DHCP server are visible in the OVF environments of virtual machines
started in the vApp.

 

vSphere Virtual Machine Administration

186  VMware, Inc.



4 Click OK.

Configure vApp Startup and Shutdown Options in the vSphere Web Client
You can change the order in which virtual machines and nested vApps within a vApp start up and shut down.
You can also specify delays and actions performed at startup and shutdown.

Prerequisites

Required privilege: vApp.vApp application configuration on the vApp.

Procedure

1 Right-click the vApp in the inventory and select Configuration > Edit Settings.

2 Click the Start Order triangle to expand the start order options.

3 Select a virtual machine and click the up or down arrow to move the virtual machine in the startup order.

Virtual machines and vApps in the same group will start concurrently with each other. The reverse order
will be used for shutdown.

4 For each virtual machine, select the startup action for the virtual machine.

5 (Optional) Set the delay for the startup action.

n Enter a time delay in seconds for the startup action.

n Select VMware Tools are ready to perform the startup action when VMware Tools has started.

6 For each virtual machine, select the shutdown action for the virtual machine.

7 (Optional) Enter a time delay in seconds for the shutdown action.

8 Click OK.

Configure vApp Product Properties in the vSphere Web Client
You can configure product and vendor information for a vApp.

Prerequisites

Required privilege: vApp.vApp application configuration on the vApp.

Procedure

1 Right-click the vApp in the inventory and select Configuration > Edit Settings.

2 Click the Product triangle to expand the product options.

3 Set and configure the settings that appear on the summary page of the virtual machine.

vApp Setting Description

Product Name Product Name.

Version vApp version.

Full Version Full version of the vApp.

Product URL If you enter a product URL, a user can click the product name on the virtual
machine summary page and go to the product's web page.

Chapter 9 Managing Multi-Tiered Applications with vSphere vApp

VMware, Inc.  187



vApp Setting Description

Vendor URL If you enter a vendor URL, a user can click the vendor name on the virtual
machine summary page and go to the vendor's web page.

Application URL If you use properties to specify the virtual machine IP address, you can enter
a dynamic application URL that points to a web page exposed by running
the virtual machine. If you enter a valid application URL, the state of the
virtual machine changes to the Available link when the virtual machine
begins running.

 
If you configure the virtual machine to use the property called webserver_ip and the virtual machine has a
web server, you can enter http://${webserver_ip}/ as the Application URL.

4 (Optional) Click View to test the Product URL and Vendor URL.

5 Click OK.

Edit vApp Settings in the vSphere Client
You can edit and configure several vApp settings, including startup order, resources, and custom properties.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click the Options tab to edit or view vApp properties.

NOTE   The deployer typically edits the IP allocation policy and properties. The vApp author typically edits
the other, more advanced settings.

3 Click the Start Order tab to edit vApp startup and shutdown options.

4 Click OK.

Edit vApp Startup and Shutdown Options
You can change the order in which virtual machines and nested vApps within a vApp start up and shut down.
You can also specify delays and actions performed at startup and shutdown.

Required privilege: vApp.vApp application configuration

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 In the Start Order tab of the Edit vApp Settings window, select a virtual machine and use the arrow keys
to change the startup order.

Virtual Machines and vApps with the same start order (or within the same grouping) will start
concurrently with each other.

The reverse order will be used for shutdown.

3 Select the startup and shutdown action for each virtual machine.

4 (Optional) Use the arrow keys to change the time delay for startup and shutdown for each virtual machine.

5 Click OK.

Edit vApp Resources
You can edit the CPU and memory resource allocation for the vApp.

Required privilege: vApp.vApp application configuration
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Reservations on vApps and all their child resource pools, child vApps, and child virtual machines count against
the parent resources only when they are powered on.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click Resources in the Options list.

3 Edit the CPU and memory resource allocation.

4 Click OK.

Edit vApp Properties
You can edit any vApp property that is defined in Advanced Property Configuration.

Required privilege: vApp.vApp application configuration

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click Properties in the Options list.

3 Edit the vApp properties.

4 Click OK.

View vApp License Agreement
You can view the license agreement for the vApp that you are editing.

NOTE   This option is available only if the vApp was imported and contains a license agreement.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click View License Agreement in the Options list.

3 Click OK.

Edit IP Allocation Policy
You can edit how IP addresses are allocated for the vApp.

Prerequisites

n For automatic (transient) IP allocation to work, you must use the vSphere Client and configure an IP pool.
See “Configuring IP Pools,” on page 193.

Required privilege: vApp.vApp instance configuration.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click IP Allocation Policy in the Options list.
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3 Select an IP allocation option.

Option Description

Fixed IP addresses are manually configured. No automatic allocation is performed.

Transient IP addresses are automatically allocated using IP pools from a specified
range when the vApp is powered on. The IP addresses are released when the
appliance is powered off.

DHCP A DHCP server is used to allocate the IP addresses. The addresses assigned
by the DHCP server are visible in the OVF environments of virtual machines
started in the vApp.

 
4 Click OK.

View Additional OVF Sections
View OVF sections that are not recognized by vCenter Server.

These additional OVF sections originate from the OVF deployment process that created this vApp. Most of
the OVF sections that vCenter Server did not recognize during deployment are accessible here for reference.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click View Additional OVF Sections in the Options list.

3 Click OK.

Add a vService Dependency
You can add a vService dependency to a virtual machine or vApp. This dependency allows a virtual machine
or vApp to request that a specific vService be available.

Procedure

1 Display the virtual machine or vApp in the inventory.

2 Power off the virtual machine or vApp.

3 Right-click the virtual machine or vApp and select Edit Settings.

4 Click the vServices tab.

5 Click Add.

6 In the Add Dependency wizard, select the provider for this dependency and click Next.

7 Enter the name and description for this dependency.

8 (Optional) If this dependency is required, select the check box and click Next.

Required dependencies must be bound before powering on.

9 (Optional) If this dependency should be bound to the provider immediately, select the Bind to provider
immediately check box, and click Next after the validation is complete.

If you choose to bind this dependency now, the validation result displays. If the validation fails, you cannot
complete adding the dependency. Deselect the check box to proceed.

10 Review the options and click Finish to create the dependency.
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Edit a vService Dependency
You can edit a vService dependency name, description, and requirement.

Procedure

1 From the vServices tab in the Edit Settings dialog box, click Edit.

2 In the Dependency Properties dialog box, edit the dependency name and description.

3 Select or deselect the check box to change the required status of the dependency.

The required check box is disabled if the virtual machine or vApp is running.

4 Select a provider for the dependency.

When you select a provider, the description is entered containing the provider description. The validation
box displays the results of the validation. If validation fails, the OK button is disabled until another
provider or no provider is selected.

5 Click OK.

Remove a vService Dependency
You can remove a vService dependency from a virtual machine or vApp.

Procedure

1 From the vServices tab in the Edit Settings dialog box, click Edit.

2 Select the dependency and click Remove.

The dependency is removed from the list.

Configure Advanced vApp Properties
You can edit and configure advanced settings, such as product and vendor information, custom properties,
and IP allocation.

Required privilege: vApp.vApp application configuration

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click Advanced in the Options list.

3 Set and configure the settings that appear on the summary page of the virtual machine.

vApp Setting Description

Product Name Product Name.

Version vApp version.

Full Version Full version of the vApp.

Product URL If you enter a product URL, a user can click the product name on the virtual
machine summary page and go to the product's web page.
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vApp Setting Description

Vendor URL If you enter a vendor URL, a user can click the vendor name on the virtual
machine summary page and go to the vendor's web page.

Application URL If you use properties to specify the virtual machine IP address, you can enter
a dynamic application URL that points to a web page exposed by running
the virtual machine. If you enter a valid application URL, the state of the
virtual machine changes to the Available link when the virtual machine
begins running.

 
If you configure the virtual machine to use the property called webserver_ip and the virtual machine has a
web server, you can enter http://${webserver_ip}/ as the Application URL.

4 (Optional) Click View to test the Product URL and Vendor URL.

5 Click Properties to edit the custom vApp properties.

6 Click IP Allocation to edit the supported IP allocation schemes of this vApp.

7 Click OK.

Define OVF Environment Properties
You can view or modify the OVF environment properties for the vApp.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click Advanced in the Options list.

3 Click Properties.

4 In Advanced Property Configuration, you can perform the following actions.

n ClickNew to add a new custom property.

n Select the property and click Edit to edit a property.

n Click Delete to delete a property.

5 Click OK.

Edit Advanced IP Allocation Properties
You can edit the IP allocation scheme for the vApp.

Procedure

1 On the Summary page of the vApp, click Edit Settings.

2 Click Advanced in the Options list.

3 Click IP Allocation.

4 In the Advanced IP Allocation dialog box, you can perform the following actions.

n Select an IP allocation scheme.

n Select the IP protocols supported by the vApp: IPv4, IPv6, or both.

5 Click OK.
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Configuring IP Pools
IP pools provide a network identity to vApps. An IP pool is a network configuration that is assigned to a
network used by a vApp. The vApp can then leverage vCenter Server to automatically provide an IP
configuration to its virtual machines.

Specify an IP Address Range
You can set up an IP address range by specifying a host address range within a network.

IP pool ranges are configured with IPv4 and IPv6. vCenter Server uses these ranges to dynamically allocate IP
addresses to virtual machines when a vApp is set up to use transient IP allocation.

Procedure

1 In the inventory, select the datacenter that contains the vApp.

2 In the IP Pools tab, right-click the IP pool that you want to edit and select Properties.

If no IP pools appear, click Add to add a new IP pool.

3 In the Properties dialog box, select the IPv4 or the IPv6 tab, depending on your IP protocol.

4 Enter the IP Subnet and Gateway in their respective fields.

5 (Optional) Select the Enable IP Pool check box.

Enable this setting to specify an IP address range.

6 (Optional) Enter a comma-separated list of host address ranges in the Ranges field.

A range consists of an IP address, a pound sign (#), and a number indicating the length of the range.

The gateway and the ranges must be within the subnet, but must exclude the gateway address.

For example, 10.20.60.4#10, 10.20.61.0#2  indicates that the IPv4 addresses can range from 10.20.60.4
to 10.209.60.13 and 10.20.61.0 to 10.20.61.1.

7 Click OK.

Select DHCP
You can specify that an IPv4 or IPv6 DHCP server is available on the network.

Procedure

1 In the inventory, select the datacenter that contains the vApp you are configuring.

2 In the IP Pools tab, right-click the IP pool that you want to edit and select Properties.

If no IP pools appear, click Add to add a new IP pool.

3 In the Properties dialog box, select theDHCP tab.

4 Select either the IPv4 DHCP Present or IPv6 DHCP Present check box to indicate that one of the DHCP
servers is available on this network.

5 Click OK.
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Specify DNS Settings
Enter the DNS settings for the vApp.

Procedure

1 In the inventory, select the datacenter that contains the vApp you are configuring.

2 In the IP Pools tab, right-click the IP pool that you want to edit and select Properties.

If no IP pools appear, click Add to add a new IP pool.

3 In the Properties dialog box, select the DNS tab.

4 Enter the DNS server information.

Specify the servers by IP addresses separated by a comma, semicolon, or space.

You can enter the following types of DNS information:

n DNS Domain

n Host Prefix

n DNS Search Path

n IPv4 DNS Servers

n IPv6 DNS Servers

5 Click OK.

Specify a Proxy Server
Specify a HTTP proxy server for the vApp.

Procedure

1 In the inventory, select the datacenter that contains the vApp.

2 In the IP Pools tab, right-click the IP pool that you want to edit and select Properties.

If no IP pools appear, click Add to add a new IP pool.

3 In the Properties dialog box, select the Proxy tab.

4 Enter the server name and port number for the proxy server.

The server name can optionally include a colon and a port number.

For example, web-proxy:3912 is a valid proxy server.

5 Click OK.

Select Network Associations
You can associate one or more networks with an IP pool.

Procedure

1 In the inventory, select the datacenter that contains the vApp.

2 In the IP Pools tab, right-click the IP pool that you want to edit and select Properties.

If no IP pools appear, click Add to add a new IP pool.

3 In the Properties dialog box, select the Associationstab.
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4 Select the networks that use this IP pool.

A network can be associated with one IP pool at a time.

5 Click OK.

Clone a vApp
Cloning a vApp is similar to cloning a virtual machine.

Prerequisites

To clone a vApp, the vSphere Client must be connected to the vCenter Server system.

A host must be selected in the inventory that is running ESX 3.0 or greater, or a cluster enabled with DRS.

Procedure

1 Select the vApp in the inventory.

2 Select Inventory > vApp > Clone.

Complete each page in Clone vApp the wizard.

3 Select the vApp destination and click Next.

4 Specify a Host and click Next.

NOTE   This step is available only if you select a cluster that is in DRS manual mode.

5 Name the vApp and click Next.

6 Select a datastore and click Next.

7 (Optional) Select a network and click Next.

8 Complete the vApp clone.

Power on a vApp in the vSphere Web Client
Each virtual machine within the vApp is powered on according to the startup order configuration.

When powering on a vApp within a DRS cluster in manual mode, no DRS recommendations are generated
for virtual machine placements. The power-on operation performs as if DRS is run in a semiautomatic or
automatic mode for the initial placements of the virtual machines. This does not affect vMotion
recommendations. Recommendations for individual powering on and powering off of virtual machines are
also generated for vApps that are running.

Prerequisites

Required privilege: vApp.Power On on the vApp.

Procedure

u Right-click the vApp and select Power > Power On.

If a delay is set in the startup settings, the vApp waits for the set length of time before powering up that
virtual machine.

In the Summary tab, the Status portlet indicates when the vApp has started and is available.
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Power On a vApp in the vSphere Client
Each virtual machine within the vApp is powered on according to the startup order configuration.

When powering on a vApp within a DRS cluster in manual mode, no DRS recommendations are generated
for virtual machine placements. The power-on operation performs as if DRS is run in a semiautomatic or
automatic mode for the initial placements of the virtual machines. This does not affect vMotion
recommendations. Recommendations for individual powering on and powering off of virtual machines are
also generated for vApps that are running.

Procedure

u In the Summary page for the service, click Power On.

If a delay is set in the startup settings, the vApp waits for the set length of time before powering up that
virtual machine.

In the Summary tab, the status indicates when the vApp has started and is available. Links to the product and
vendor Web sites are also found under the General section.

Power Off a vApp in the vSphere Web Client
Each virtual machine within the vApp is powered off in reverse order to how they are configured for startup.

Prerequisites

Required privilege: vApp.Power Off on the vApp.

Procedure

u Right-click the vApp and select Power > Power Off.

If a delay is set in the shutdown settings, the vApp waits for the set length of time before powering down
that virtual machine.

Power Off a vApp in the vSphere Client
Each virtual machine within the vApp is powered off in reverse order to how they are configured for startup.

Procedure

u In the Summary page for the service, click Power Off.

If a delay is set in the shutdown settings, the vApp waits for the set length of time before powering down
that virtual machine.

Suspend a vApp in the vSphere Web Client
A suspended vApp pauses all its running virtual machines until you resume the vApp.

The virtual machines within a vApp are suspended based on their stop order. All virtual machines are
suspended regardless of stop action.

Prerequisites

Required privilege: vApp.Suspend on the vApp.

Procedure

u Right-click the vApp and select Power > Suspend.
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Suspend a vApp in the vSphere Client
A suspended vApp pauses all its running virtual machines until you resume the vApp.

The virtual machines within a vApp are suspended based on their stop order. All virtual machines are
suspended regardless of stop action.

Procedure

1 From the vSphere Client select the vApp you want to place in suspended state.

2 Right-click the vApp and select Suspend.

Resume a vApp in the vSphere Web Client
You can continue the activity of the virtual machines within a vApp that is in a suspended state.

The suspended virtual machines within the vApp are resumed in reverse order to the order in which they were
suspended.

Procedure

u Right-click the vApp and select Power > Power On.

Resume a vApp in the vSphere Client
You can continue the activity of the virtual machines within a vApp that is in a suspended state.

The suspended virtual machines within the vApp are resumed in reverse order to the order in which they were
suspended.

Procedure

1 From the vSphere Client, select the vApp.

2 Right-click the vApp and select Power On.

Edit vApp Annotation in the vSphere Web Client
You can add or edit notes for a particular vApp.

Procedure

1 Select the vApp in the inventory.

2 Click the Summary tab for the vApp.

3 In the Annotation panel, click Edit.

4 Type your comments in the Edit vApp Annotation window.

5 Click OK.

Your comments appear in the Annotation panel.

Edit vApp Annotation in the vSphere Client
You can add or edit notes for a particular vApp.

Procedure

1 Select the vApp in the inventory.
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2 Click the Summary tab for the vApp.

3 In the Annotation section, click Edit.

4 Type your comments in the Edit Service Annotation window.

5 Click OK.

Your comments appear under Annotation.
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Monitoring Solutions with the vCenter
Solutions Manager 10

A vSphere administrator uses the vCenter Solutions Manager to view the installalled solutions, view detailed
information about the solutions, and monitor the solution health status.

You can monitor and manage vSphere solutions from the vSphere Client that displays an inventory of vSphere
solutions and details about each solution.

A solution is an extension of the vCenter Server that adds new functions to a vCenter Server instance. For
example, vSphere ESX Agent Manager is a standard vCenter solution provided by VMware that allows you
to manage ESX host agents that add new capabilities to ESX hosts. Another standard solution that vSphere
provides is vService Manager. VMware products that integrate with vCenter Sever are also considered
solutions. You can install a solution to add functionality from third-party technologies to the standard functions
of vCenter Server. Solutions typically are delivered as OVF packages. You can install and deploy solutions
from vSphere Client. Solutions can be integrated into the vCenter Solutions Manager.

If a virtual machine or vApp is running a solution, a custom icon appears next to it in the inventory view of
the vSphere Client. When you power on or power off a virtual machine or vApp, you are notified that you are
performing this operation on an entity that is managed by the solution manager.

Each solution registers a unique icon to identify that the virtual machine or vApp is being managed by that
solution. The icons show the power states (powered on, paused, powered off).

The solutions display more than one type of icon if they manage more than one type of virtual machine or
vApp.

When you attempt an operation on a virtual machine or a vApp that is managed by a solution, an informational
warning message appears.

For more information, see the Developing and Deploying vSphere Solutions, vServices, and ESX Agents
documentation.

This chapter includes the following topics:

n “Viewing Solutions,” on page 199

n “Monitoring Agents,” on page 200

n “Monitoring vServices,” on page 201

Viewing Solutions
You can deploy, monitor, and interact with solutions that are installed in a vCenter Server instance with the
vCenter Solutions Manager. The Solutions Manager displays information about the health of a solution.

You can navigate to the Solutions Manager from the home page of the vSphere Client. The Solutions Manager
view displays information about the solution:

n Solution name
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n Solution health

n vService providers

Procedure

1 Click the Solutions Manager icon from vSphere Client home.

2 Navigate through the tabs in the Solutions Manager.

n Summary tab. Lists the number of installed solutions and a brief health overview for each of the
solutions.

n Solutions tab. Lists each managed solution.

n Health tab. Provides the health status of the vCenter services. It also shows alerts or warnings for
each of the services.

3 In the Solutions Manager inventory, click one of the solutions.

n Summary tab. Lists information about the solution, including a link to the product and vendor Web
sites, a link to launch the management UI in a separate window, and a link to the virtual machine or
vApp running this solution.

Selecting the vendor Web site link takes you to the Summary page of the virtual machine or vApp.
A link under "Managed by" returns you to the solution.

n Virtual Machines tab. Lists all the virtual machines belonging to the solution

n vServices Providers tab.

n Management tab or any other tabs the solution specified.

Monitoring Agents
The vCenter Solutions Manager displays the vSphere ESX Agent Manager agents that you use to deploy and
manage related agents on ESX hosts.

An administrator uses the solutions manager to keep track of whether a solution's agents are working as
expected. Outstanding issues are reflected by the solution's ESX Agent Manager status and a list of issues.

When a solution's state changes, the solutions manager updates the ESX Agent Manager's summary status and
state. Administrators use this status to track whether the goal state is reached.

The agency's health status is indicated by a specific color:

n Red. The solution must intervene for the ESX Agent Manager to proceed. For example, if a virtual machine
agent is powered off manually on a compute resource and the ESX Agent Manager does not attempt to
power on the agent. The ESX Agent Manager reports this action to the solution. The solution alerts the
administrator to power on the agent.

n Yellow. The ESX Agent Manager is actively working to reach a goal state. The goal state can be enabled,
disabled, or uninstalled. For example, when a solution is registered, its status is yellow until the ESX Agent
Manager deploys the solutions agents to all the specified compute resources. A solution does not need to
intervene when the ESX Agent Manager reports its ESX Agent Manager health status as yellow.

n Green. A solution and all its agents reached the goal state.
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Monitoring vServices
A vService is a service or function that a solution provides to virtual machines and vApps. A solution can
provide one or more vServices. These vServices integrate with the platform and are able to change the
environment in which the vApp or virtual machine runs.

A vService is a type of service for a virtual machine and a vApp provided by a vCenter extension. Virtual
machines and vApps can have dependencies on vServices. Each dependency is associated with a vService type.
The vService type must be bound to a particular vCenter extension that implements that vService type. This
vService type is similar to a virtual hardware device. For example, a virtual machine can have a networking
device that at deployment must be connected to a particular network.

The vService Manager allows a solution to connect to operations related to OVF templates:

n Importing OVF templates. Receive a callback when OVF templates with a vService dependancy of a certain
type is imported.

n Exporting OVF templates. Inserts OVF sections when a virtual machine is exported.

n OVF environment generation. Inserts OVF sections into the OVF environment at the power-on instance.

The vService Provider tab in the solution manager provides details for each vCenter extension. This
information allows you to monitor vService providers and list the virtual machines or vApps to which they
are bound.
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Managing Virtual Machines 11
You use the vSphere Client to manage virtual machines. With the vSphere Client, you can open a console to
the desktop of managed virtual machines. From the console, you can change operating system settings, use
applications, browse the file system, monitor system performance, and so on, as if you were operating a
physical system. You can also use snapshots to capture the entire state of the virtual machine at the time you
take the snapshot.

You can connect the vSphere Client directly to an ESXi host and work with only the virtual machines and the
physical resources available on that host. Connect your vSphere Client to a vCenter Server to manage virtual
machines and pooled physical resources across multiple hosts. Multiple vCenter Server systems can be joined
together in a vCenter Server Connected Group to allow them to be managed with a single vSphere Client
connection.

This chapter includes the following topics:

n “Edit Virtual Machine Startup and Shutdown Settings,” on page 203

n “Install the Client Integration Plug-In in the vSphere Web Client,” on page 204

n “Open a Virtual Machine Console in the vSphere Web Client,” on page 205

n “Open a Console to a Virtual Machine,” on page 206

n “Adding and Removing Virtual Machines,” on page 206

n “Using Snapshots To Manage Virtual Machines,” on page 207

n “Migrating Virtual Machines,” on page 221

Edit Virtual Machine Startup and Shutdown Settings
You can configure virtual machines running on an ESXi host to start up and shut down with the host. You can
also set the default timing and startup order for selected virtual machines. This ability allows the operating
system to save data when the host enters maintenance mode or is being powered off for another reason.

The Virtual Machine Startup and Shutdown (automatic startup) feature is disabled for all virtual machines
residing on hosts that are in (or moved into) a vSphere HA cluster. Automatic startup is not supported when
used with vSphere HA.

NOTE   You can also create a scheduled task to change the power settings of a virtual machine. Information
about scheduling tasks is included in vCenter Server and Host Management.

Procedure

1 In the vSphere Client inventory, select the host where the virtual machine is located and click the
Configuration tab.
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2 Under Software, click Virtual Machine Startup/Shutdown and click Properties.

The Virtual Machine Startup and Shutdown dialog box opens.

3 Select Allow virtual machines to start and stop automatically with the system.

4 (Optional) Configure the startup and shutdown behavior.

Option Action

Default Startup Delay Select the amount of time to delay starting the operating system.
This delay allows time for VMware Tools or the booting system to run scripts.

Continue immediately if the VMware
Tools starts

Select to start the operating system immediately after VMware Tools starts.

Default Shutdown Delay Select the amount of time to delay shutdown for each virtual machine.
The shutdown delay applies only if the virtual machine does not shut down
before the delay period elapses. If the virtual machine shuts down before the
delay time is reached, the next virtual machine starts shutting down.

Shutdown Action Select a shutdown option from the drop-down menu.
n Power Off
n Suspend
n Guest Shutdown

Move Up and Move Down Select a virtual machine in the Manual Startup category and use the Move
Up button to move it up to Automatic Startup or Any Oder.
When virtual machines are in the Automatic Startup category, you can use
Move Up and Move Down to order them so that they start in a preferred
sequence. During shutdown, the virtual machines are stopped in the
opposite order.

Edit Click Edit to configure user-specified autostartup and shutdown behavior
for virtual machines in the Automatic Startup or Any Order category.

 
5 Click OK to close the dialog box and save your settings.

Install the Client Integration Plug-In in the vSphere Web Client
To access a virtual machine's console in the vSphere Web Client, you must install the Client Integration Plug-
in. You can also use the Client Integration Plug-in to connect virtual devices that reside on a client computer
to a virtual machine.

You install the Client Integration Plug-in only once to connect virtual devices to virtual machines that you
access through an instance of the vSphere Web Client.

The following guest operating systems and browsers support Client Integration Plug-In installation:

Operating system Browser

Windows 32 bit and 64 bit n Internet Explorer 7 and 8
n Mozilla Firefox 3.5 and 3.6

Linux 32 bit Mozilla Firefox 3.5 and 3.6

vSphere Virtual Machine Administration

204  VMware, Inc.



Procedure

1 Click the Download the client integration plug-in link.

Option Description

vSphere Web Client login page a Open a Web browser and enter the URL for the vSphere Web Client.
b At the bottom of the vSphere Web Clientlogin page, click Download

Client Integration Plug-in.

Guest OS Details panel a Select a virtual machine in the inventory and click the Summary tab.
b In the Guest OS Details panel, click Install client integration plug-in

to view VM console.
 

2 (Optional) If the browser blocks the installation, either by issuing certificate errors or with pop-up
blocking, follow the Help instructions for your browser to resolve the problem.

What to do next

You can now open the virtual machine console to configure operating system settings, run applications,
monitor performance, and so on.

Open a Virtual Machine Console in the vSphere Web Client
With the vSphere Web Client, you can access a virtual machine's desktop by launching a console to the virtual
machine. From the console, you can perform activities in the virtual machine such as configure operating
system settings, run applications, monitor performance, and so on.

Prerequisites

n Ensure that the Client Integration Plug-in is installed in your Web browser.

n Verify that the virtual machine has a guest operating system and that VMware Tools are installed.

n Verify that the virtual machine is powered on.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the Guest OS Details pane on the Summary tab, click Launch console.

The virtual machine console opens in a new tab of the Web browser.

3 Click anywhere inside the console window to enable your mouse, keyboard, and other input devices to
work in the console.

4 (Optional) Press Ctrl+Alt to release the cursor from the console window and work outside the console
window.

5 (Optional) Click Full Screen to display the console in full screen mode.

6 (Optional) Press Ctrl+Alt+Enter to exit full screen mode.

7 (Optional) Click Send Ctrl-Alt-Delete to send a Ctrl+Alt+Delete to the guest operating system.
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Open a Console to a Virtual Machine
With the vSphere Client, you can access a virtual machine's desktop by launching a console to the virtual
machine. From the console, you can perform activities within the virtual machine such as configure operating
system settings, run applications, monitor performance, and so on.

Procedure

1 In the vSphere Client inventory, right-click the virtual machine and select Open Console .

2 Click anywhere inside the console window to enable your mouse, keyboard, and other input devices to
work in the console.

Adding and Removing Virtual Machines
You add virtual machines to the vCenter Server inventory through their managed hosts. You can remove
virtual machines from vCenter Server, from their managed host’s storage, or from both.

Adding Existing Virtual Machines to vCenter Server
When you add a host to vCenter Server, it discovers all the virtual machines on that managed host and adds
them to the vCenter Server inventory.

If a managed host is disconnected, the already discovered virtual machines continue to be listed in the
inventory.

If a managed host is disconnected and reconnected, any changes to the virtual machines on that managed host
are identified, and the vSphere Client updates the list of virtual machines. For example, if node3 is removed
and node4 is added, the new list of virtual machines adds node4 and shows node3 as orphaned.

Remove Virtual Machines from vCenter Server
Removing a virtual machine from the inventory unregisters it from the host and vCenter Server, but does not
delete it from the datastore. Virtual machine files remain at the same storage location and the virtual machine
can be re-registered by using the datastore browser.

Prerequisites

Power off the virtual machine.

Procedure

1 Display the virtual machine in the inventory.

2 Right-click the virtual machine and select Remove from Inventory.

3 To confirm that you want to remove the virtual machine from the inventory, click OK.

vCenter Server removes references to the virtual machine and no longer tracks its condition.

Remove Virtual Machines from the Datastore
You use the Delete from Disk option to remove a virtual machine from vCenter Server and delete all virtual
machine files, including the configuration file and virtual disk files, from the datastore.

Prerequisites

Power off the virtual machine.
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Procedure

1 Display the virtual machine in the inventory.

2 Right-click the virtual machine and select Delete from Disk.

3 Click OK in the confirmation dialog box.

vCenter Server deletes the virtual machine from its datastore. Disks that are shared with other virtual machines
are not deleted.

Return a Virtual Machine or Template to vCenter Server
If you remove a virtual machine or template from vCenter Server, but do not remove it from the managed
host’s datastore, you can return it to vCenter Server by using the Datastore Browser.

Procedure

1 Display the datastore in the inventory.

2 Right-click the datastore and select Browse Datastore.

3 Navigate to the virtual machine or template to add to the inventory.

4 Right-click the virtual machine or template and select Add to Inventory.

5 Complete the Add to Inventory wizard to add the virtual machine or template.

Using Snapshots To Manage Virtual Machines
Snapshots preserve the state and data of a virtual machine at the time you take the snapshot. Snapshots are
useful when you must revert repeatedly to the same virtual machine state, but you do not want to create
multiple virtual machines.

You can take multiple snapshots of a virtual machine to create restoration positions in a linear process. With
multiple snapshots, you can save many positions to accommodate many kinds of work processes. Snapshots
operate on individual virtual machines. Taking snapshots of multiple virtual machines, for example, taking
snapshots for all members of a team, requires that you take a separate snapshot of each team member's virtual
machine.

Snapshots are useful as a short term solution for testing software with unknown or potentially harmful effects.
For example, you can use a snapshot as a restoration point during a linear or iterative process, such as installing
update packages, or during a branching process, such as installing different versions of a program. Using
snapshots ensures that each installation begins from an identical baseline.

With snapshots, you can preserve a baseline before diverging a virtual machine in the snapshot tree.

The Snapshot Manager in the vSphere Web Client and the vSphere Client provide several operations for
creating and managing virtual machine snapshots and snapshot trees. These operations let you create
snapshots, restore any snapshot in the snapshot hierarchy, delete snapshots, and more. You can create extensive
snapshot trees that you can use to save the virtual machine state at any specific time and restore the virtual
machine state later. Each branch in a snapshot tree can have up to 32 snapshots.

A snapshot preserves the following information:

n Virtual machine settings. The virtual machine directory, which includes disks that were added or changed
after you took the snapshot.

n Power state. The virtual machine can be powered on, powered off, or suspended.

n Disk state. State of all the virtual machine's virtual disks.

n (Optional) Memory state. The contents of the virtual machine's memory.
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The Snapshot Hierarchy
The Snapshot Manager presents the snapshot hierarchy as a tree with one or more branches. The relationship
between snapshots is like that of a parent to a child. In the linear process, each snapshot has one parent snapshot
and one child snapshot, except for the last snapshot, which has no child snapshots. Each parent snapshot can
have more than one child. You can revert to the current parent snapshot or restore any parent or child snapshot
in the snapshot tree and create more snapshots from that snapshot. Each time you restore a snapshot and take
another snapshot, a branch, or child snapshot, is created.

Parent Snapshots The first virtual machine snapshot that you create is the base parent snapshot.
The parent snapshot is the most recently saved version of the current state of
the virtual machine. Taking a snapshot creates a delta disk file for each disk
attached to the virtual machine and optionally, a memory file. The delta disk
files and memory file are stored with the virtual machine's files. The parent
snapshot is always the snapshot that appears immediately above the You are
here icon in the Snapshot Manager. If you revert or restore a snapshot, that
snapshot becomes the parent of the You are here current state.

NOTE   The parent snapshot is not always the snapshot that you took most
recently.

Child Snapshots A snapshot that is taken of the same virtual machine after the parent snapshot.
Each child constitutes delta files for each attached virtual disk, and optionally
a memory file that points from the present state of the virtual disk (You are
here). Each child snapshot's delta files merge with each previous child snapshot
until reaching the parent disks. A child disk can later be a parent disk for future
child disks.

The relationship of parent and child snapshots can change if you have multiple branches in the snapshot tree.
A parent snapshot can have more than one child. Many snapshots have no children.

IMPORTANT   Do not manually manipulate individual child disks or any of the snapshot configuration files
because doing so can compromise the snapshot tree and result in data loss. This restriction includes disk
resizing and making modifications to the base parent disk using vmkfstools.

Snapshot Behavior
Taking a snapshot preserves the disk state at a specific time by creating a series of delta disks for each attached
virtual disk or virtual RDM and optionally preserves the memory and power state by creating a memory file.
Taking a snapshot creates a snapshot object in the Snapshot Manager that represents the virtual machine state
and settings.

Each snapshot creates an additional delta .vmdk disk file. When you take a snapshot, the snapshot mechanism
prevents the guest operating system from writing to the base .vmdk file and instead directs all writes to the
delta disk file. The delta disk represents the difference between the current state of the virtual disk and the
state that existed at the time that you took the previous snapshot. If more than one snapshot exists, delta disks
can represent the difference between each snapshot. Delta disk files can expand quickly and become as large
as the entire virtual disk if the guest operating system writes to every block of the virtual disk.
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Snapshot Files
When you take a snapshot, you capture the state of the virtual machine settings and the virtual disk. If you are
taking a memory snapshot, you also capture the memory state of the virtual machine. These states are saved
to files that reside with the virtual machine's base files.

Snapshot Files
A snapshot consists of files that are stored on a supported storage device. A Take Snapshot operation
creates .vmdk, -delta.vmdk, .vmsd, and .vmsn files. By default, the first and all delta disks are stored with the
base .vmdk file. The .vmsd and .vmsn files are stored in the virtual machine directory.

Delta disk files A .vmdk file to which the guest operating system can write. The delta disk
represents the difference between the current state of the virtual disk and the
state that existed at the time that the previous snapshot was taken. When you
take a snapshot, the state of the virtual disk is preserved, which prevents the
guest operating system from writing to it, and a delta or child disk is created.

A delta disk has two files, including a descriptor file that is small and contains
information about the virtual disk, such as geometry and child-parent
relationship information, and a corresponding file that contains the raw data.

NOTE   If you are looking at a datastore with the Datastore Browser in the
vSphere Client, you see only one entry to represent both files.

The files that make up the delta disk are referred to as child disks or redo logs.
A child disk is a sparse disk. Sparse disks use the copy-on-write mechanism,
in which the virtual disk contains no data in places, until copied there by a write
operation. This optimization saves storage space. A grain is the unit of measure
in which the sparse disk uses the copy-on-write mechanism. Each grain is a
block of sectors that contain virtual disk data. The default size is 128 sectors or
64KB.

Flat file A -flat.vmdk file that is one of two files that comprises the base disk. The flat
disk contains the raw data for the base disk. This file does not appear as a
separate file in the Datastore Browser.

Database file A .vmsd file that contains the virtual machine's snapshot information and is the
primary source of information for the Snapshot Manager. This file contains line
entries, which define the relationships between snapshots and between child
disks for each snapshot.

Memory file A .vmsn file that includes the active state of the virtual machine. Capturing the
memory state of the virtual machine lets you revert to a turned on virtual
machine state. With nonmemory snapshots, you can only revert to a turned off
virtual machine state. Memory snapshots take longer to create than
nonmemory snapshots. The time the ESX host takes to write the memory onto
the disk is relative to the amount of memory the virtual machine is configured
to use.

A Take Snapshot operation creates .vmdk, -delta.vmdk, vmsd, and vmsn files.
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File Description

vmname-number.vmdk and vmname-
number-delta.vmdk

Snapshot file that represents the difference between the current state of the virtual
disk and the state that existed at the time the previous snapshot was taken.
The filename uses the following syntax, S1vm-000001.vmdk where S1vm is the name
of the virtual machine and the six-digit number, 000001, is based on the files that
already exist in the directory. The number does not consider the number of disks that
are attached to the virtual machine.

vmname.vmsd Database of the virtual machine's snapshot information and the primary source of
information for the Snapshot Manager.

vmname.Snapshotnumber.vmsn Memory state of the virtual machine at the time you take the snapshot. The file name
uses the following syntax, S1vm.snapshot1.vmsn, where S1vm is the virtual
machine name, and snapshot1 is the first snapshot.
NOTE   A .vmsn file is created each time you take a snapshot, regardless of the memory
selection. A .vmsn file without memory is much smaller than one with memory.

Snapshot Limitations
Snapshots can affect virtual machine performance and do not support some disk types or virtual machines
configured with bus sharing. Snapshots are useful as short-term solutions for capturing point-in-time virtual
machine states and are not appropriate for long-term virtual machine backups.

n VMware does not support snapshots of raw disks, RDM physical mode disks, or guest operating systems
that use an iSCSI initiator in the guest.

n Virtual machines with independent disks must be powered off before you take a snapshot. Snapshots of
powered-on or suspended virtual machines with independent disks are not supported.

n Snapshots are not supported with PCI vSphere Direct Path I/O devices.

n VMware does not support snapshots of virtual machines configured for bus sharing. If you require bus
sharing, consider running backup software in your guest operating system as an alternative solution. If
your virtual machine currently has snapshots that prevent you from configuring bus sharing, delete
(consolidate) the snapshots.

n Snapshots provide a point-in-time image of the disk that backup solutions can use, but Snapshots are not
meant to be a robust method of backup and recovery. If the files containing a virtual machine are lost, its
snapshot files are also lost. Also, large numbers of snapshots are difficult to manage, consume large
amounts of disk space, and are not protected in the case of hardware failure.

Backup solutions, such as VMware Data Recovery, use the snapshot mechanism to freeze the state of the
virtual machine. The Data Recovery backup method has additional capabilities that mitigate the
limitations of snapshots.

n Snapshots can negatively affect the performance of a virtual machine. Performance degradation is based
on how long the snapshot or snapshot tree is in place, the depth of the tree, and how much the virtual
machine and its guest operating system have changed from the time you took the snapshot. Also, you
might see a delay in the amount of time it takes the virtual machine to power-on. Do not run production
virtual machines from snapshots on a permanent basis.

Managing Snapshots
You can review all snapshots for the active virtual machine and act on them by using the Snapshot Manager.

After you take a snapshot, you can use the Revert to current snapshot command from the virtual machine’s
right-click menu to restore that snapshot at any time. If you have a series of snapshots, you can use the Go
to command in the Snapshot Manager to restore any parent or child snapshot. Subsequent child snapshots that
you take from the restored snapshot create a branch in the snapshot tree. You can delete a snapshot from the
tree in the Snapshot Manager.
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The Snapshot Manager window contains the following areas: Snapshot tree, Details region, command buttons,
Navigation region, and a You are here icon.

Snapshot tree Displays all snapshots for the virtual machine.

You are here icon Represents the current and active state of the virtual machine. The You are
here icon is always selected and visible when you open the Snapshot Manager.

You can select the You are here state to see how much space the node is using.
Go to, Delete, and Delete all are disabled for the You are here state.

Go to, Delete, and Delete
All

Snapshot options.

Details Displays the name and description of the selected snapshot. These text boxes
are blank if you do not select a snapshot.

Navigation Contains buttons for navigating out of the dialog box.

n Close the Snapshot Manager.

n Help opens the help system.

Taking Snapshots
You can take one or more snapshots of a virtual machine to capture the settings state, disk state, and memory
state at different specific times. When you take a snapshot, you can also quiesce the virtual machine files and
exclude the virtual machine disks from snapshots.

When you quiesce a virtual machine, VMware Tools quiesces the file system of the virtual machine. A quiesce
operation ensures that a snapshot disk represents a consistent state of the guest file systems. If the virtual
machine is powered off or VMware Tools are not available, the Quiesce parameter is ignored.

When you capture the virtual machine's memory state, the snapshot retains the live state of the virtual machine.
The virtual machine's files might not require quiescing. If you do not capture the memory state, the snapshot
does not save the live state of the virtual machine and the disks are crash-consistent unless you quiesce them.

When you take a snapshot, other activity that is occurring in the virtual machine might affect the snapshot
process when you revert to that snapshot. The best time to take a snapshot from a storage perspective, is when
you are not incurring a large I/O load. The best time to take a snapshot from a service perspective is when no
applications in the virtual machine are communicating with other computers. The potential for problems is
greatest if the virtual machine is communicating with another computer, especially in a production
environment. For example, if you take a snapshot while the virtual machine is downloading a file from a server
on the network, the virtual machine continues downloading the file and communicating its progress to the
server. If you revert to the snapshot, communications between the virtual machine and the server are confused
and the file transfer fails.

Change Disk Mode to Exclude Virtual Disks from Snapshots in the vSphere Web
Client
You can set a virtual disk to independent mode to exclude the disk from any snapshots taken of its virtual
machine.

Prerequisites

Power off the virtual machine and delete any existing snapshots before you change the disk mode. Deleting a
snapshot involves committing the existing data on the snapshot disk to the parent disk.

Required privileges:

n Virtual machine.State.Remove Snapshot
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n Virtual machine.Configuration.Modify device settings

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 In the VM Hardware panel, click Edit Settings.

3 Click Virtual Hardware.

4 Click the triangle to display the settings for the disk to exclude from snapshots.

5 Select one of the independent disk mode options.

Option Description

Independent - Persistent Disks in persistent mode behave like conventional disks on your physical
computer. All data written to a disk in persistent mode are written
permanently to the disk.

Independent - Nonpersistent Changes to disks in nonpersistent mode are discarded when you power off
or reset the virtual machine. With nonpersistent mode, you can restart the
virtual machine with a virtual disk in the same state every time. Changes to
the disk are written to and read from a redo log file that is deleted when you
power off or reset.

 
6 Click OK.

Change Disk Mode to Exclude Virtual Disks from Snapshots in the vSphere Client
You can set a virtual disk to independent mode to exclude the disk from any snapshots taken of its virtual
machine.

Prerequisites

Power off the virtual machine and delete any existing snapshots before you change the disk mode. Deleting a
snapshot involves committing the existing data on the snapshot disk to the parent disk.

Required privileges:

n Virtual machine.State.Remove Snapshot

n Virtual machine.Configuration.Modify device settings

Procedure

1 Select Inventory > Virtual Machine > Edit Settings.

2 Click the Hardware tab and select the hard disk to exclude.

3 Under Mode, select Independent.

Snapshots do not affect the state of an independent disk.

NOTE   Any disk, regardless of its type, that is created after you take a snapshot does not appear if you
revert to that snapshot.
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4 Select an independent disk mode option.

Option Description

Independent - Persistent Disks in persistent mode behave like conventional disks on your physical
computer. All data written to a disk in persistent mode are written
permanently to the disk.

Independent - Nonpersistent Changes to disks in nonpersistent mode are discarded when you power off
or reset the virtual machine. With nonpersistent mode, you can restart the
virtual machine with a virtual disk in the same state every time. Changes to
the disk are written to and read from a redo log file that is deleted when you
power off or reset.

 
5 Click OK.

Take a Snapshot in the vSphere Web Client
Snapshots capture the entire state of the virtual machine at the time you take the snapshot. You can take a
snapshot when a virtual machine is powered on, powered off, or suspended. If you are suspending a virtual
machine, wait until the suspend operation finishes before you take a snapshot.

When you create a memory snapshot, the snapshot captures the state of the virtual machine's memory and the
virtual machine power settings. When you capture the virtual machine's memory state, the snapshot operation
takes longer to complete. You might also see a momentary lapse in response over the network.

When you quiesce a virtual machine, VMware Tools quiesces the file system in the virtual machine. The quiesce
operation pauses or alters the state of running processes on the virtual machine, especially processes that might
modify information stored on the disk during a restore operation.

NOTE   You cannot revert to a snapshot with dynamic disks, so quiesced snapshots are not used when you
restore dynamic disks. Snapshot technology has no visibility into Dynamic Disks. Dynamic Disks are
commonly known as Microsoft specific file systems.

Prerequisites

n If you are taking a memory snapshot of a virtual machine that has multiple disks in different disk modes,
verify that the virtual machine is powered off. For example, if you have a special purpose configuration
that requires you to use an independent disk, you must power off the virtual machine before taking a
snapshot.

n To capture the memory state of the virtual machine, verify that the virtual machine is powered on.

n To quiesce the virtual machine files, verify that the virtual machine is powered on and that VMware Tools
is installed.

n Required privilege: Virtual machine.State. Create snapshot on the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 Right-click the virtual machine and select Snapshot > Take Snapshot.

3 Type a name for the snapshot.

4 (Optional) Type a description for the snapshot.

5 (Optional) Select the Snapshot the virtual machine’s memory check box to capture the memory of the
virtual machine.
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6 (Optional) Select the Quiesce guest file system (Needs VMware Tools installed) check box to pause
running processes on the guest operating system so that file system contents are in a known consistent
state when you take the snapshot.

7 Click OK.

Take a Snapshot in the vSphere Client
Snapshots capture the entire state of the virtual machine at the time you take the snapshot. You can take a
snapshot when a virtual machine is powered on, powered off, or suspended. If you are suspending a virtual
machine, wait until the suspend operation finishes before you take a snapshot.

When you create a memory snapshot, the snapshot captures the state of the virtual machine's memory and the
virtual machine power settings. When you capture the virtual machine's memory state, the snapshot operation
takes longer to complete. You might also see a momentary lapse in response over the network.

When you quiesce a virtual machine, VMware Tools quiesces the file system in the virtual machine. The quiesce
operation pauses or alters the state of running processes on the virtual machine, especially processes that might
modify information stored on the disk during a restore operation.

NOTE   You cannot revert to a snapshot with dynamic disks, so quiesced snapshots are not used when you
restore dynamic disks. Snapshot technology has no visibility into Dynamic Disks. Dynamic Disks are
commonly known as Microsoft specific file systems.

Prerequisites

n If you are taking a memory snapshot of a virtual machine that has multiple disks in different disk modes,
verify that the virtual machine is powered off. For example, if you have a special purpose configuration
that requires you to use an independent disk, you must power off the virtual machine before taking a
snapshot.

n To capture the memory state of the virtual machine, verify that the virtual machine is powered on.

n To quiesce the virtual machine files, verify that the virtual machine is powered on and that VMware Tools
is installed.

n Required privilege: Virtual machine.State. Create snapshot on the virtual machine.

Procedure

1 Select Inventory > Virtual Machine > Snapshot > Take Snapshot.

2 Type a name for the snapshot.

3 Type a description for the snapshot.

Adding a date and time or a description, for example, "Snapshot before applying XYZ patch," can help
you determine which snapshot to restore or delete.

4 (Optional) Select the Snapshot the virtual machine’s memory check box to capture the memory of the
virtual machine.

5 (Optional) Select the Quiesce guest file system (Needs VMware Tools installed) check box to pause
running processes on the guest operating system so that file system contents are in a known consistent
state when you take the snapshot.

6 Click OK.

After you take the snapshot, you can view its status in the Recent Tasks field at the bottom of the vSphere
Client.
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Restoring Snapshots
To return a virtual machine to its original state, or to return to another snapshot in the snapshot hierarchy, you
can restore a snapshot.

When you restore a snapshot, you return the virtual machine's memory, settings, and the state of the virtual
machine disks to the state they were in at the time you took the snapshot. If you want the virtual machine to
be suspended, powered on, or powered off when you start it, make sure that it is in the correct state when you
take the snapshot.

You can restore snapshots in the following ways:

Revert to Current
Snapshot

Restores the parent snapshot, one level up in the hierarchy from the You are
Here position. Revert to Current Snapshot activates the parent snapshot of the
current state of the virtual machine.

Go To Lets you restore any snapshot in the snapshot tree and makes that snapshot the
parent snapshot of the current state of the virtual machine. Subsequent
snapshots from this point create a new branch of the snapshot tree.

Restoring snapshots has the following effects:

n The current disk and memory states are discarded, and the virtual machine reverts to the disk and memory
states of the parent snapshot.

n Existing snapshots are not removed. You can restore those snapshots at any time.

n If the snapshot includes the memory state, the virtual machine will be in the same power state as when
you created the snapshot.

Table 11-1.  Virtual Machine Power State After Restoring a Snapshot

Virtual Machine State When Parent Snapshot Is
Taken Virtual Machine State After Restoration

Powered on (includes memory) Reverts to the parent snapshot, and the virtual machine is
powered on and running.

Powered on (does not include memory) Reverts to the parent snapshot and the virtual machine is
powered off.

Powered off (does not include memory) Reverts to the parent snapshot and the virtual machine is
powered off.

Virtual machines running certain kinds of workloads can take several minutes to resume responsiveness after
reverting from a snapshot.
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Figure 11-1.  Revert to Snapshot
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NOTE   vApp metadata for virtual machines in vApps does not follow the snapshot semantics for virtual
machine configuration. vApp properties that are deleted, modified, or defined after a snapshot is taken remain
intact (deleted, modified, or defined) after the virtual machine reverts to that snapshot or any previous
snapshots.

Revert to a Snapshot in the vSphere Web Client
The Revert to Current Snapshot option immediately restores the parent snapshot of the virtual machine.

Prerequisites

Required privilege: Virtual machine.State.Revert to snapshot on the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 Right-click the virtual machine and select Revert to Current Snapshot.
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Revert to a Snapshot in the vSphere Client
You can restore the parent snapshot of the current state of the virtual machine.

When you revert to a snapshot, disks that you added or changed after the snapshot was taken are reverted to
the snapshot point. For example, when you take a snapshot of a virtual machine, add a disk, and revert the
snapshot, the added disk is removed.

Prerequisites

Required privilege: Virtual machine.State.Revert to snapshot on the virtual machine.

Procedure

u Right-click a virtual machine in the vSphere Client inventory and select Revert to Current Snapshot.

The virtual machine power and data states are returned to the states they were in at the time you took the
parent snapshot. If the parent snapshot is a memory snapshot, the virtual machine is restored to an on power
state.

Go to a Snapshot in the vSphere Web Client
Go to a snapshot to restore the virtual machine to the state of that snapshot.

Prerequisites

Required privilege: Virtual machine.State.Revert to snapshot on the virtual machine

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 Right-click the virtual machine and select Snapshot > Snapshot Manager.

3 In the Snapshot Manager, click a snapshot to select it.

4 Click Go to to restore the virtual machine to the snapshot.

The Go to command lets you restore the state of any snapshot.

5 Click Yes in the confirmation dialog box.

6 Click Close to exit the Snapshot Manager.

Go To a Snapshot in the vSphere Client
You can go to any snapshot in the snapshot tree to restore the virtual machine to the state of that snapshot.

NOTE   Virtual machines running certain kinds of workloads might take several minutes to resume
responsiveness after reverting from a snapshot.

Prerequisites

Required privilege: Virtual machine.State.Revert to snapshot on the virtual machine

Procedure

1 Right-click a virtual machine in the vSphere Client inventory and select Snapshot Manager.

2 In the Snapshot Manager, click a snapshot to select it.
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3 Click Go to to restore the virtual machine to the snapshot.

4 Click Yes in the confirmation dialog box.

Subsequent child snapshots from this point create a new branch of the snapshot tree. The delta disks for
snapshots that you took after you restored the current snapshot are not removed and you can restore those
snapshots at any time.

Deleting Snapshots
Deleting a snapshot removes the snapshot from the Snapshot Manager. The snapshot files are consolidated
and written to the parent snapshot disk and merge with the virtual machine base disk.

Deleting a snapshot leaves the current state of the virtual machine or any other snapshot untouched. Deleting
a snapshot consolidates the changes between snapshots and previous disk states and writes to the parent disk
all data from the delta disk that contains the information about the deleted snapshot. When you delete the base
parent snapshot, all changes merge with the base virtual machine disk.

Deleting snapshots involves large amounts of disk reads and writes, which can reduce virtual machine
performance until consolidation is complete. Consolidating snapshots removes redundant disks, which
improves virtual machine performance and saves storage space. The time it takes to delete snapshots and
consolidate the snapshot files depends on the volume of data that the guest operating system wrote to the
virtual disks after you took the last snapshot. The required time is proportional to the amount of data the virtual
machine is writing during consolidation if the virtual machine is powered on.

If disk consolidation fails when you delete a snapshot or delete all snapshots and you notice a degradation in
virtual machine performance, you can view a list of virtual machines to determine if any files require
consolidation, and if so, run a separate consolidation operation. For information about locating and viewing
the consolidation state of multiple virtual machines and running a separate consolidation operation, see 
“Consolidate Snapshots in the vSphere Client,” on page 220

Delete Use the Delete option to remove a single parent or child snapshot from the
snapshot tree. Delete writes disk changes between the snapshot and the
previous delta disk state to the parent snapshot.

You can also use the Delete option to remove a corrupt snapshot and its files
from an abandoned branch of the snapshot tree without merging them with
the parent snapshot.

Delete All Use the Delete All option to delete all snapshots from the Snapshot Manager.
Delete all consolidates and writes changes between snapshots and previous
delta disk states to the base parent disk and merges them with the base virtual
machine disk.

To prevent snapshot files from merging with the parent snapshot, for example in cases of failed updates or
installations, first use the Go to command to restore to a previous snapshot. This action invalidates the snapshot
delta disks and deletes the memory file. You can then use the Delete option to remove the snapshot and any
associated files.

Delete a Snapshot in the vSphere Web Client
You can use the Snapshot Manager to delete a single snapshot or all snapshots in a snapshot tree.

Use care when you delete snapshots. You cannot restore a deleted snapshot. For example, you might want to
install several browsers, a, b, and c, and capture the virtual machine state after you install each browser. The
first, or base snapshot, captures the virtual machine with browser a and the second snapshot captures browser
b. If you restore the base snapshot that includes browser a and take a third snapshot to capture browser c and
delete the snapshot that contains browser b, you cannot return to the virtual machine state that includes
browser b.
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Prerequisites

n Ensure that you are familiar with the Delete and Delete all actions and how they might affect virtual
machine performance. See “Deleting Snapshots,” on page 218.

n Required Privilege: Virtual machine.State.Remove Snapshot on the virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 Right-click the virtual machine and select Snapshot > Snapshot Manager.

3 In the Snapshot Manager, click a snapshot to select it.

4 Select whether to delete a single snapshot or all snapshots.

Option Description

Delete Consolidates the snapshot data to the parent snapshot and removes the
selected snapshot from the Snapshot Manager and virtual machine.

Delete All Consolidates all of the immediate snapshots before the You are here current
state to the base parent disk and removes all existing snapshots from the
Snapshot Manager and virtual machine.

 
5 Click Yes in the confirmation dialog box.

6 Click Close to exit the Snapshot Manager.

Delete a Snapshot in the vSphere Client
You can use the Snapshot Manager to delete a single snapshot or all snapshots in a snapshot tree.

Use care when you delete snapshots. You cannot restore a deleted snapshot. For example, you might want to
install several browsers, a, b, and c, and capture the virtual machine state after you install each browser. The
first, or base snapshot, captures the virtual machine with browser a and the second snapshot captures browser
b. If you restore the base snapshot that includes browser a and take a third snapshot to capture browser c and
delete the snapshot that contains browser b, you cannot return to the virtual machine state that includes
browser b.

Prerequisites

n Ensure that you are familiar with the Delete and Delete all actions and how they might affect virtual
machine performance. See “Deleting Snapshots,” on page 218.

n Required Privilege: Virtual machine.State.Remove Snapshot on the virtual machine.

Procedure

1 Select Inventory > Virtual Machine > Snapshot > Snapshot Manager.

2 In the Snapshot Manager, click a snapshot to select it.
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3 Select a delete option.

Option Description

Delete Consolidates the snapshot data to the parent snapshot and removes the
selected snapshot from the Snapshot Manager and virtual machine.

Delete All Consolidates all of the immediate snapshots before the You are here current
state to the base parent disk and removes all existing snapshots from the
Snapshot Manager and virtual machine.

 
4 Click Yes.

Consolidate Snapshots in the vSphere Client
The snapshot Consolidation command searches for hierarchies or delta disks to combine without violating
data dependency. After consolidation, redundant disks are removed, which improves virtual machine
performance and saves storage space.

Snapshot consolidation is useful when snapshot disks fail to compact after a Delete or Delete all operation or
if the disk did not consolidate. This might happen, for example, if you delete a snapshot but its associated disk
does not commit back to the base disk.

The Needs Consolidation column in the vSphere Client shows the virtual machines that need to be consolidated
and the virtual machine's Summary tab shows a Configuration Issues consolidation message if the virtual
machine needs to be consolidated. If you see errors for failed conditions, such as running out of disk space,
correct them and run the consolidation task.

Prerequisites

Required privilege: Virtual machine.State.Remove Snapshot

Procedure

1 Display the Need Consolidation column in the vSphere Client.

a Select a vCenter Server, host, or cluster and click the Virtual Machines tab.

b Right-click the menu bar for any virtual machine column and select Needs Consolidation from the
menu.

The Needs Consolidation column appears. A Yes status indicates that the snapshot files for the virtual
machine should be consolidated and that the virtual machine's Tasks and Events tab shows a
configuration problem. A No status indicates that the files are OK.

2 To consolidate the files, right-click the virtual machine and select Snapshot > Consolidate.

3 Check the Need Consolidation column to verify that the task succeeded.

If the task succeeded, the Configuration Issues message should be cleared and the Needs Consolidation
value should be No.
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Migrating Virtual Machines
Migration is the process of moving a virtual machine from one host or storage location to another. Copying a
virtual machine creates a new virtual machine. It is not a form of migration.

In vCenter Server, you have the following migration options:

Cold Migration Moving a powered-off virtual machine to a new host. Optionally, you can
relocate configuration and disk files to new storage locations. You can use cold
migration to move virtual machines from one datacenter to another.

Migrating a Suspended
Virtual Machine

Moving a suspended virtual machine to a new host. Optionally, you can
relocate configuration and disk files to new storage location. You can migrate
suspended virtual machines from one datacenter to another.

Migration with vMotion Moving a powered-on virtual machine to a new host. Migration with vMotion
allows you to move a virtual machine to a new host without any interruption
in the availability of the virtual machine. You cannot use vMotion to move
virtual machines from one datacenter to another. Some configurations include
Metro vMotion, a feature that enables reliable migrations between hosts
separated by high network round-trip latency times. Metro vMotion is
automatically enabled when the appropriate license is installed. No user
configuration is necessary.

Migration with Storage
vMotion

Moving the virtual disks or configuration file of a powered-on virtual machine
to a new datastore. Migration with Storage vMotion allows you to move a
virtual machine’s storage without any interruption in the availability of the
virtual machine.

Both migration of a suspended virtual machine and migration with vMotion are sometimes referred to as “hot
migration”, because they allow migration of a virtual machine without powering it off. Migration with vMotion
is sometimes referred to as "live migration".

You can move virtual machines manually or set up a scheduled task to perform the cold migration.

Cloning a virtual machine or copying its disks and configuration file creates a new virtual machine. Cloning
is not a form of migration.

Virtual Machine Configuration Requirements for vMotion
A number of specific virtual machine configurations can prevent migration of a virtual machine with vMotion.

The following virtual machine configurations can prevent migration with vMotion:

n You cannot use migration with vMotion to migrate virtual machines using raw disks for clustering
purposes.

n You cannot use migration with vMotion to migrate a virtual machine that uses a virtual device backed by
a device that is not accessible on the destination host. (For example, you cannot migrate a virtual machine
with a CD drive backed by the physical CD drive on the source host.) Disconnect these devices before
migrating the virtual machine.

Virtual machines with USB passthrough devices can be migrated with vMotion as long as the devices are
enabled for vMotion.

n You cannot use migration with vMotion to migrate a virtual machine that uses a virtual device backed by
a device on the client computer. Disconnect these devices before migrating the virtual machine.
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Host Configuration for vMotion
In order to successfully use vMotion, you must first configure your hosts correctly.

Ensure that you have correctly configured your hosts in each of the following areas:

n Each host must be correctly licensed for vMotion.

n Each host must meet shared storage requirements for vMotion.

n Each host must meet the networking requirements for vMotion.

IMPORTANT   The ESXi firewall in ESXi 5.0 does not allow per-network filtering of vMotion traffic. Therefore,
you must install rules on your external firewall to ensure that no incoming connections can be made to
the vMotion socket.

Migrate a Powered-Off or Suspended Virtual Machine in the vSphere Web Client
You can use the Migration wizard to migrate a powered-off virtual machine or suspended virtual machine.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 Right-click the virtual machine and select Inventory > Migrate.

3 Select the migration type.

Option Description

Change host Move the virtual machine to another host.

Change datastore Move the virtual machine’s configuration file and virtual disks.

Change both host and datastore Move the virtual machine to another host and move its configuration file and
virtual disks. (This option is not available for a powered-on virtual machine.)

 
4 Select the destination resource pool for the virtual machine migration and click Next.

5 In the Host Name column, select the destination host or cluster for this virtual machine migration and
click Next.

Any compatibility problem appears in the Compatibility panel. Fix the problem, or select another host or
cluster.

Possible targets include hosts and DRS clusters with any level of automation. If a cluster has no DRS
enabled, select a specific host in the cluster rather than selecting the cluster itself.
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6 Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the
same location on a datastore.

Select a datastore and click Next.

Store all virtual machine files in the
same Storage DRS cluster.

a Select a Storage DRS cluster.
b (Optional) If you do not want to use Storage DRS with this virtual

machine, select Disable Storage DRS for this virtual machine and select
a datastore within the Storage DRS cluster.

c Click Next.

Store virtual machine configuration
files and disks in separate locations.

a Click Advanced.
b For the virtual machine configuration file and for each virtual disk, click

the datastore name, select Browse, and select a datastore or Storage DRS
cluster.

c (Optional) If you selected a Storage DRS cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the Storage DRS
cluster.

d Click Next.
 

7 If you chose to move the virtual machine’s configuration file and virtual disks, select a disk format.

Option Description

Same as Source Use the format of the original virtual disk.
If you select this option for an RDM disk in physical compatibility mode,
only the mapping file is migrated. If you select this option for an RDM disk
in virtual compatibility mode, the RDM is converted to a virtual disk.

Thin provisioned Use the thin format to save storage space. The thin virtual disk uses just as
much storage space as it needs for its initial operations. When the virtual disk
requires more space, it can grow in size up to its maximum allocated capacity.
This option is not available for RDMs in physical compatibility mode. If you
select this option for a virtual compatibility mode RDM, the RDM is
converted to a thin virtual disk. RDMs converted to virtual disks cannot be
converted back to RDMs.

Thick Allocate a fixed amount of hard disk space to the virtual disk. The virtual
disk in the thick format does not change its size and from the beginning
occupies the entire datastore space provisioned to it.
This option is not available for RDMs in physical compatibility mode. If you
select this option for a virtual compatibility mode RDM, the RDM is
converted to a virtual disk. RDMs converted to virtual disks cannot be
converted back to RDMs.

 
Disks are converted from thin to thick format or thick to thin format only when they are copied from one
datastore to another. If you leave a disk in its original location, the disk format is not converted, regardless
of the selection made here.

8 Review the information on the Review Selections page and click Finish.

vCenter Server moves the virtual machine to the new host. Event messages appear in the Events tab. The data
displayed on the Summary tab shows the status and state throughout the migration. If errors occur during
migration, the virtual machines revert to their original states and locations.

Migrate a Powered-Off or Suspended Virtual Machine in the vSphere Client
You can use the Migration wizard to migrate a powered-off virtual machine or suspended virtual machine.

Procedure

1 Select the virtual machine that you want to migrate in the inventory.
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2 Right-click on the virtual machine and select Migrate from the pop-up menu.

3 Select the migration type.

Option Description

Change host Move the virtual machine to another host.

Change datastore Move the virtual machine’s configuration file and virtual disks.

Change both host and datastore Move the virtual machine to another host and move its configuration file and
virtual disks. (This option is not available for a powered-on virtual machine.)

 
4 To move the virtual machine to another host, select the destination host or cluster for this virtual machine

migration and click Next.

Any compatibility problem appears in the Compatibility panel. Fix the problem, or select another host or
cluster.

Possible targets include hosts and DRS clusters with any level of automation. If a cluster has no DRS
enabled, select a specific host in the cluster rather than selecting the cluster itself.

5 Select the destination resource pool for the virtual machine migration and click Next.

6 If you chose to move the virtual machine’s configuration file and virtual disks, select a disk format.

Option Description

Same as Source Use the format of the original virtual disk.
If you select this option for an RDM disk in physical compatibility mode,
only the mapping file is migrated. If you select this option for an RDM disk
in virtual compatibility mode, the RDM is converted to a virtual disk.

Thin provisioned Use the thin format to save storage space. The thin virtual disk uses just as
much storage space as it needs for its initial operations. When the virtual disk
requires more space, it can grow in size up to its maximum allocated capacity.
This option is not available for RDMs in physical compatibility mode. If you
select this option for a virtual compatibility mode RDM, the RDM is
converted to a thin virtual disk. RDMs converted to virtual disks cannot be
converted back to RDMs.

Thick Allocate a fixed amount of hard disk space to the virtual disk. The virtual
disk in the thick format does not change its size and from the beginning
occupies the entire datastore space provisioned to it.
This option is not available for RDMs in physical compatibility mode. If you
select this option for a virtual compatibility mode RDM, the RDM is
converted to a virtual disk. RDMs converted to virtual disks cannot be
converted back to RDMs.

 
Disks are converted from thin to thick format or thick to thin format only when they are copied from one
datastore to another. If you leave a disk in its original location, the disk format is not converted, regardless
of the selection made here.
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7 Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the
same location on a datastore.

a (Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

b Select a datastore and click Next.

Store all virtual machine files in the
same datastore cluster.

a (Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

b Select a datastore cluster.
c (Optional) If you do not want to use Storage DRS with this virtual

machine, select Disable Storage DRS for this virtual machine and select
a datastore within the datastore cluster.

d Click Next.

Store virtual machine configuration
files and disks in separate locations.

a Click Advanced.
b For the virtual machine configuration file and for each virtual disk, click

Browse and select a datastore or datastore cluster.
c (Optional) Apply a virtual machine storage profile from the VM Storage

Profile drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

d (Optional) If you selected a datastore cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the datastore cluster.

e Click Next.
 

8 Review the page and click Finish.

vCenter Server moves the virtual machine to the new host. Event messages appear in the Events tab. The data
displayed on the Summary tab shows the status and state throughout the migration. If errors occur during
migration, the virtual machines revert to their original states and locations.

Migrate a Powered-On Virtual Machine with vMotion in the vSphere Web Client
You can use the Migration wizard to migrate a powered-on virtual machine from one host to another using
vMotion technology. To relocate the disks of a powered-on virtual machine, migrate the virtual machine using
Storage vMotion.

Prerequisites

Before migrating a virtual machine with vMotion, ensure that your hosts and virtual machines meet the
requirements for migration with vMotion.

n “Host Configuration for vMotion,” on page 222

n “Virtual Machine Configuration Requirements for vMotion,” on page 221
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Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 Right-click the virtual machine and select Inventory > Migrate.

3 Select Change host and click Next.

4 Select the destination resource pool for the virtual machine migration and click Next.

5 Select a destination host or cluster for the virtual machine.

Any compatibility problem appears in the Compatibility panel. Fix the problem, or select another host or
cluster.

Possible targets include hosts and fully automated DRS clusters. You can select a non-automated cluster
as a target. You are prompted to select a host within the non-automated cluster.

6 Select the migration priority level and click Next.

Option Description

Reserve CPU for optimal VMotion
performance

vCenter Server attempts to reserve resources on both the source and
destination hosts to be shared among all concurrent migrations with
vMotion. vCenter Server grants a larger share of host CPU resources. if
sufficient CPU resources are not immediately available, vMotion is not
initiated.

Perform with available CPU
resources

vCenter Server reserves resources on both the source and destination hosts
to be shared among all concurrent migration with vMotion. vCenter Server
grants a smaller share of host CPU resources. If there is a lack of CPU
resources, the duration of vMotion can be extended.

 
7 Review the page and click Finish.

Migrate a Powered-On Virtual Machine with vMotion in the vSphere Client
You can use the Migration wizard to migrate a powered-on virtual machine from one host to another using
vMotion technology. To relocate the disks of a powered-on virtual machine, migrate the virtual machine using
Storage vMotion.

Prerequisites

Before migrating a virtual machine with vMotion, ensure that your hosts and virtual machines meet the
requirements for migration with vMotion.

n “Host Configuration for vMotion,” on page 222

n “Virtual Machine Configuration Requirements for vMotion,” on page 221

Procedure

1 Select the virtual machine that you want to migrate in the inventory.

2 Right-click on the virtual machine and select Migrate from the pop-up menu.

3 Select Change host and click Next.
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4 Select a destination host or cluster for the virtual machine.

Any compatibility problem appears in the Compatibility panel. Fix the problem, or select another host or
cluster.

Possible targets include hosts and fully automated DRS clusters. You can select a non-automated cluster
as a target. You are prompted to select a host within the non-automated cluster.

5 Select a resource pool and click Next.

6 Select the migration priority level and click Next.

Option Description

High Priority On hosts running ESX/ESXi version 4.1 or later, vCenter Server attempts to
reserve resources on both the source and destination hosts to be shared
among all concurrent migrations with vMotion. vCenter Server grants a
larger share of host CPU resources to high priority migrations than to
standard priority migrations. Migrations always proceed regardless of the
resources that have been reserved.
On hosts running ESX/ESXi version 4.0 or earlier, vCenter Server attempts
to reserve a fixed amount of resources on both the source and destination
hosts for each individual migration. High priority migrations do not proceed
if resources are unavailable.

Standard Priority On hosts running ESX/ESXi version 4.1 or later, vCenter Server reserves
resources on both the source and destination hosts to be shared among all
concurrent migration with vMotion. vCenter Server grants a smaller share
of host CPU resources to standard priority migrations than to high priority
migrations. Migrations always proceed regardless of the resources that have
been reserved.
On hosts running ESX/ESXi version 4.0 or earlier, vCenter Server attempts
to reserve a fixed amount resources on the source and destination hosts for
each migration. Standard priority migrations always proceed. However, the
migration might proceed more slowly or fail to complete if sufficient
resources are not available.

 
7 Review the page and click Finish.

A task is created that begins the virtual machine migration process.

Migrate a Virtual Machine with Storage vMotion in the vSphere Web Client
Use migration with Storage vMotion to relocate a virtual machine’s configuration file and virtual disks while
the virtual machine is powered on.

You cannot change the virtual machine’s execution host during a migration with Storage vMotion.

Procedure

1 Select a virtual machine.

n In the virtual machines and templates inventory tree, select a group of virtual machines and select a
virtual machine from the list on the right.

n Search for a virtual machine and select it from the search results list.

2 Right-click the virtual machine and select Inventory > Migrate.

3 Select Change datastore and click Next.
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4 Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the
same location on a datastore.

Select a datastore and click Next.

Store all virtual machine files in the
same Storage DRS cluster.

a Select a Storage DRS cluster.
b (Optional) If you do not want to use Storage DRS with this virtual

machine, select Disable Storage DRS for this virtual machine and select
a datastore within the Storage DRS cluster.

c Click Next.

Store virtual machine configuration
files and disks in separate locations.

a Click Advanced.
b For the virtual machine configuration file and for each virtual disk, click

the datastore name, select Browse, and select a datastore or Storage DRS
cluster.

c (Optional) If you selected a Storage DRS cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the Storage DRS
cluster.

d Click Next.
 

5 Review the page and click Finish.

Migrate a Virtual Machine with Storage vMotion in the vSphere Client
Use migration with Storage vMotion to relocate a virtual machine’s configuration file and virtual disks while
the virtual machine is powered on.

You cannot change the virtual machine’s execution host during a migration with Storage vMotion.

Procedure

1 Select the virtual machine that you want to migrate in the inventory.

2 Right-click on the virtual machine and select Migrate from the pop-up menu.

3 Select Change datastore and click Next.

4 Select a disk format.

Option Description

Same as Source Use the format of the original virtual disk.
If you select this option for an RDM disk in physical compatibility mode,
only the mapping file is migrated. If you select this option for an RDM disk
in virtual compatibility mode, the RDM is converted to a virtual disk.

Thin provisioned Use the thin format to save storage space. The thin virtual disk uses just as
much storage space as it needs for its initial operations. When the virtual disk
requires more space, it can grow in size up to its maximum allocated capacity.
This option is not available for RDMs in physical compatibility mode. If you
select this option for a virtual compatibility mode RDM, the RDM is
converted to a thin virtual disk. RDMs converted to virtual disks cannot be
converted back to RDMs.

Thick Allocate a fixed amount of hard disk space to the virtual disk. The virtual
disk in the thick format does not change its size and from the beginning
occupies the entire datastore space provisioned to it.
This option is not available for RDMs in physical compatibility mode. If you
select this option for a virtual compatibility mode RDM, the RDM is
converted to a virtual disk. RDMs converted to virtual disks cannot be
converted back to RDMs.
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5 Select the datastore location where you want to store the virtual machine files.

Option Action

Store all virtual machine files in the
same location on a datastore.

a (Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

b Select a datastore and click Next.

Store all virtual machine files in the
same datastore cluster.

a (Optional) Apply a virtual machine storage profile for the virtual
machine home files and the virtual disks from the VM Storage Profile
drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

b Select a datastore cluster.
c (Optional) If you do not want to use Storage DRS with this virtual

machine, select Disable Storage DRS for this virtual machine and select
a datastore within the datastore cluster.

d Click Next.

Store virtual machine configuration
files and disks in separate locations.

a Click Advanced.
b For the virtual machine configuration file and for each virtual disk, click

Browse and select a datastore or datastore cluster.
c (Optional) Apply a virtual machine storage profile from the VM Storage

Profile drop-down menu.

The list of datastores shows which datastores are compatible and which
are incompatible with the selected virtual machine storage profile.

d (Optional) If you selected a datastore cluster and do not want to use
Storage DRS with this virtual machine, select Disable Storage DRS for
this virtual machine and select a datastore within the datastore cluster.

e Click Next.
 

6 Review the page and click Finish.
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Required Privileges for Common
Tasks 12

Many tasks require permissions on more than one object in the inventory. You can review the privileges
required to perform the tasks and, where applicable, the appropriate sample roles.

The following table lists common tasks that require more than one privilege. You can use the Applicable Roles
on the inventory objects to grant permission to perform these tasks, or you can create your own roles with the
equivalent required privileges.

Table 12-1.  Required Privileges for Common Tasks

Task Required Privileges Applicable Role

Create a virtual machine On the destination folder or datacenter:
n Virtual machine.Inventory.Create new
n Virtual Machine.Configuration.Add New Disk (if creating a new

virtual disk)
n Virtual Machine .Configuration.Add Existing Disk (if using an

existing virtual disk)
n Virtual Machine.Configuration.Raw Device (if using a RDM or

SCSI pass-through device)

Virtual Machine
Administrator

On the destination host, cluster, or resource pool:
Resource.Assign Virtual Machine to Resource Pool

Virtual Machine
Administrator

On the destination datastore or folder containing a datastore:
Datastore.Allocate Space

Datastore
Consumer or
Virtual Machine
Administrator

On the network that the virtual machine will be assigned to:
Network.Assign Network

Network
Consumer or
Virtual Machine
Administrator

Deploy a virtual machine
from a template

On the destination folder or datacenter:
n Virtual machine .Inventory.Create from existing
n Virtual Machine .Configuration.Add Add New Disk

Virtual Machine
Administrator

On a template or folder of templates:
Virtual Machine.Provisioning.Deploy Template

Virtual Machine
Administrator

On the destination host, cluster or resource pool:
Resource.Assign Virtual.Machine to Resource Pool

Virtual Machine
Administrator

On the destination datastore or folder of datastores:
Datastore.Allocate Spaces

Datastore
Consumer or
Virtual Machine
Administrator
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Table 12-1.  Required Privileges for Common Tasks (Continued)

Task Required Privileges Applicable Role

On the network that the virtual machine will be assigned to:
Network.Assign Network

Network
Consumer or
Virtual Machine
Administrator

Take a virtual machine
snapshot

On the virtual machine or a folder of virtual machines:
Virtual Machine.State.Create Snapshots

Virtual Machine
Power User or
Virtual Machine
Administrator

On the destination datastore or folder of datastores:
Datastore.Allocate Space

Datastore
Consumer or
Virtual Machine
Administrator

Move a virtual machine into a
resource pool

On the virtual machine or folder of virtual machines:
n Resource.Assign Virtual Machine to Resource Pool
n Virtual Machine.Inventory Move

Virtual Machine
Administrator

On the destination resource pool:
Resource.Assign Virtual Machine to Resource Pools

Virtual Machine
Administrator

Install a guest operating
system on a virtual machine

On the virtual machine or folder of virtual machines:
n Virtual Machine.Interaction.Answer Question
n Virtual Machine.Interaction.Console Interaction
n Virtual Machine.Interaction.Device Connection
n Virtual Machine.Interaction.Power Offs
n Virtual Machine.Interaction.Power On
n Virtual Machine.Interaction.Reset
n Virtual Machine.Interaction.Configure CD Media (if installing

from a CD)
n Virtual Machine.Interaction.Configure Floppy Media (if

installing from a floppy disk)
n Virtual Machine.Interaction.Tools Install

Virtual Machine
Power User or
Virtual Machine
Administrator

On a datastore containing the installation media ISO image:
Datastore.Browse Datastore (if installing from an ISO image on a
datastore)

Virtual Machine
Power User or
Virtual Machine
Administrator

Migrate a virtual machine
with vMotion

On the virtual machine or folder of virtual machines:
n Resource.Migrate
n Resource.Assign Virtual Machine to Resource Pool (if destination

is a different resource pool from the source)

Datacenter
Administrator or
Resource Pool
Administrator or
Virtual Machine
Administrator

On the destination host, cluster, or resource pool (if different from the
source):
Resource.Assign Virtual Machine to Resource Pool

Datacenter
Administrator or
Resource Pool
Administrator or
Virtual Machine
Administrator

Cold migrate (relocate) a
virtual machine

On the virtual machine or folder of virtual machines:
n Resource.Relocate
n Resource.Assign Virtual Machine to Resource Pool (if destination

is a different resource pool from the source)

Datacenter
Administrator or
Resource Pool
Administrator or
Virtual Machine
Administrator
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Table 12-1.  Required Privileges for Common Tasks (Continued)

Task Required Privileges Applicable Role

On the destination host, cluster, or resource pool (if different from the
source):
Resource.Assign Virtual Machine to Resource Pool

Datacenter
Administrator or
Resource Pool
Administrator or
Virtual Machine
Administrator

On the destination datastore (if different from the source):
Datastore.Allocate Space

Datastore
Consumer or
Virtual Machine
Administrator

Migrate a Virtual Machine
with Storage vMotion

On the virtual machine or folder of virtual machines:
Resource.Migrate

Datacenter
Administrator or
Resource Pool
Administrator or
Virtual Machine
Administrator

On the destination datastore:
Datastore.Allocate Space

Datastore
Consumer or
Virtual Machine
Administrator

Move a host into a cluster On the host:
Host.Inventory.Add Host to Cluster

Datacenter
Administrator or
Virtual Machine
Administrator

On the destination cluster:
Host.Inventory.Add Host to Cluster

Datacenter
Administrator or
Virtual Machine
Administrator
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Linux  55
Windows  55

customization specifications  60

D
datacenters  10
datastores

ISO file  138
roll in datacenter  10
selecting  19, 22, 26, 32
VMFS  35

debugging and statistics  177
debugging mode, for virtual machine  176
delaying, boot sequence  174
deleting

snapshots  218
templates  54

deploying, OVF templates  67, 68
DHCP settings  193
disabling, acceleration  175
disk formats

thick provisioned  122
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virtual machines  130

disks
format  130, 131
independent  212
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See also virtual disks
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E
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Extensible Firmware Interface, See EFI
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G
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Linux customization during cloning or

deployment  59
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Windows customization during cloning or

deployment  57
guest operating systems

changing  86
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customizing  20, 26
installing  40, 41
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H
hard disks

adding  124
adding to a virtual machine  126

hardware, virtual machine  77, 78
hardware version, virtual machines  82
hardware versions, virtual machines  22
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CD drives  137
DVD drives  137

hosts
clustering  31
connecting virtual machines to  31
viable for migration  97, 98
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guest operating systems over PXE  40
Microsoft Sysprep tool  73
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IP address configuration  193
IP addresses, generating with a script  56
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M
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hot adding  103, 104
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Microsoft Sysprep tool

installing  73
installing from CD  74
installing from Web  73

migrating
powered-off virtual machines  222, 223
powered-on virtual machines  225, 226
suspended virtual machines  222, 223
virtual machine disks  227, 228
virtual machines  221
virtual machines with Storage vMotion  227,

228
with vMotion  225, 226

migration, about  221
migration with vMotion, conditions for USB

passthrough  151
multicore CPUs  89
multiple monitors, selecting  147

N
name-ip-generator  56
names, virtual machines  83
network adapters

adding  109
configuring  108

supported types  107
See also NICs

network association settings  194
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connecting  35
DHCP settings  193
IP address configuration  193
proxy server settings  194

New Virtual Machine wizard, opening  29
NIC, See network adapters
NICs

adding  109
assigning MAC addresses  109
configuring  108, 109
legacy virtual machines  108
Spanning Tree protocol  35

NUMA  105
NUMA nodes, memory allocation  104
NX flag  97, 98

O
Open Virtual Machine Format, See also OVF
operating systems, guest  40
optical drives

connecting to client device  136
connecting to host device  137

options, virtual machine  78
OVA, selecting, See also OVF
OVF

browsing virtual appliance marketplace  69
defining environment properties  192
deploying templates  67, 68
exporting templates  67, 70
folder location for files  70

P
parallel ports

adding  119
changing  118
configuring  118

paravirtual SCSI controller  134
paravirtual SCSI controllers  134
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snapshot support for  145
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power off
vApps  196
virtual machines  172

power on
vApps  195, 196
virtual machines  172

power states, virtual machine  172
preboot execution environment  40
preface  7
privileges, required for common tasks  231
processors, See CPUs
provisioning, virtual machines  12
proxy server settings, networks  194
PVSCSI, See also paravirtual SCSI controller
PXE  40

R
raw device mappings  36, 38, 121, 126, 127
RDMs, adding to a virtual machine  126
renaming, templates  53
required privileges, for common tasks  231
resetting virtual machines  172
resource pools, selecting  19, 22, 26, 32
resources, virtual machine  78
resources, virtual machine  11
restart settings, for virtual machines  172
resume

vApps  197
virtual machines  172

S
SAN LUN  38
SAN LUNs  121, 127
scheduled tasks, clone virtual machine  46
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SCSI
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controller  132
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devices, changing  144
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selecting controllers  35
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VMware Paravirtual  35
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templates  18
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changing  114
conditions for network connections  112
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sharing, disks  38
shutdown, settings for virtual machines  172
shutdown, settings, for virtual machines  203
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adding to virtual machines  170, 171
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about  207
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behavior  207
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copy-on-write  209
Delete all option  218
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deleting  218, 219
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exclude virtual disks from  212
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GO to command  217
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limitations  210
manage  210
memory  211
memory files  209
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performance impact of  210
quiescing  213, 214
quiescing virtual machine files  211
restoring  215, 217
revert to parent  217
reverting to  215, 216
Snapshot Manager  210
sparse disks  209
taking  211, 213, 214
unsupported disk types  210
virtual machine activity  211
virtual machines with dynamic disks  214

solutions,viewing  199
standby settings, for virtual machines  172
startup settings, for virtual machines  203
statistics, virtual machines  176
storage  121, 127
Storage vMotion  221
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storing, device nodes, using nondefault device
notes  36

suspending
vApps  196, 197
virtual machines  172

swap file location  106
swap files, virtual machines  106
Sysprep Answer Files

custom  64
sysprep.inf  64
sysprep.xml  64

Sysprep tool
installing  73
installing from CD  74
installing from Web  73
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taking, snapshots  213
tasks, clone virtual machine  46
templates

changing names  53
cloning  48, 49
converting to virtual machines  55
converting virtual machines to  47
creating  15, 47, 48
customizing guest operating systems  20, 26
deleting  53, 54
deploy virtual machines  50
deploying from  17
deploying virtual machines  18
editing  53
OVF  70
removing from inventory  54
renaming  53
returning to vCenter Server  207
returning to inventory  54
selecting  18
unregistering  53

thick provisioned disks  48, 49
thin provisioned disks  48, 49, 130
Thin Provisioning  36
troubleshooting

debugging and statistics  177
virtual machine software installation  176
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upgrading

virtual machine hardware  81
VMware Tools  87
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adding to virtual machine  153, 154, 161, 166
removing from virtual machine  158, 163, 169

USB devices
adding from client computer to VM in the

vSphere Client  168
adding from client computer to VM in the

vSphere Web Client  162
adding host device to virtual machine  157
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adding to hosts  153
behavior with hot add operations  164
cascading hubs  152
compound  152
configuring for vMotion  151
connecting to a client computer  160, 165
ejecting from guest OS  158
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removing from host  158
removing from remote client  164, 169
removing host device from virtual

machine  158
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setting up on host  152
supported devices for Mac OS X guest  164

USB passthrough
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autoconnect feature  150
avoiding data loss  151, 159, 164
configuring from a client computer to a VM  159,

164
configuring from a host to a virtual

machine  149
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devices, See also USB devices
DRS requirements  151, 165
features supported with  151, 165
restarting the USB arbitrator  170
troubleshooting device connections  170

USB passthrough devices  156
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advanced properties  191
allocating resources  181, 183
cloning  195
completing creation  181, 183
configuring DNS  194
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configuring networks  186, 189
creating  180, 182
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defining OVF environment properties  192
editing advanced IP allocation properties  192
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editing custom properties  192
editing properties  185, 186, 188, 189
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IP pools  193
managing  179
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power off settings  196
power on settings  195, 196
product properties  187
resuming  197
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selecting DHCP  193
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selecting name  180
selecting network associations  194
selecting proxy server for  194
shutdown options  187, 188
starting wizard  182
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suspending  196, 197
viewing license agreement  189
viewing OVF Sections  190

vCenter Converter client plug-in  68
vCenter Server  10
version, virtual machine  32
video cards

configuring  146, 147
selecting number of displays  147

virtual compatibility mode  38
virtual device node  144
virtual devices

adding USB controller  153, 154, 161, 166
CPU limitations  89
See also virtual hardware

virtual disks
clustering features  36
configuration  122, 123
configuring  121
creating  36
disk mode  211
flat format  36
formats  122
modes  36
requirements for guest operating system

customization  55
sharing  38
thick format  130
thin format  36, 130
types  36
using nondefault device node  36, 38

virtual hard disks, adding  124

virtual hardware
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machine  157
adding USB devices  162, 168
CPU advanced settings  95–97
CPU hyperthreading  95, 96
CPU/MMU enablement  99, 100
CPUs  34
disks  36
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hot adding virtual CPUs  92
licenses for  10
memory  34
multicore CPUs  89
NICs  35
parallel ports  118, 119
SCSI controllers  35
SCSI devices  143, 144
serial ports  115, 117
video cards  146, 147

virtual infrastructure  10
virtual machine, memory  103
virtual machine communication interface  145
Virtual Machine Communication Interface, See

VMCI, enabling
virtual machine console, installing  204
virtual machine files  9
virtual machine hardware

determining version  83
upgrading  81
virtual disks  122, 123

virtual machine hardware version  81
virtual machine options  78
virtual machine resources  78
virtual machine storage profile

associate with virtual disks  132
associate with virtual machine  132
definition  131

virtual machines
acceleration  176
add existing  206
adding  206
adding hard disks  124, 126
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boot sequence  174
CD drives  136
changing name  83
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completing  40
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configuration file location  84
configuration files  84
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configuration parameters  84
configuring  77
configuring devices  136
configuring guest operating systems  87
console options  86
converting templates to  55
converting to templates  47
CPU configuration  91, 92
CPU resources  88
creating  17, 20, 21, 29, 30
creating and deploying  11
creating templates  15
customizing hardware  20, 23, 27
debugging  177
debugging information  176
defined  9
deploy and export  15
deploy from templates  50
deploying  17
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disk formats  130
DVD drives  136
enabling logging  175
exporting  70
files  9
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floppy drives  140–142
guest operating system  40, 86
hard disks  127
hardware  77, 78
hardware version  82, 83
hardware versions  11, 22, 81
hot add enablement  103, 104
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lifecycle  11
managing  203
memory  100, 101
memory allocation to NUMA nodes  104
memory resources  102
migrating  221–223, 227, 228
migration  221
names  83
naming  19, 22, 25, 31
network adapter  110
network adapters  109
network configuration  107
NIC  110
opening console  206
optical drives  139
options and resources  11
parallel ports  118

power management settings  171
power states  172
provisioning  12, 15
remove from the datastore  206
remove from vCenter Server  206
removing  206
requirements for vMotion  221
resources  77
returning to vCenter Server  207
scheduled task to clone  46
selecting  25
selecting configuration option for creation  30
selecting folders  19, 22, 25
selecting guest operating systems  23, 33
serial ports  112
shutdown settings  203
snapshots  207
startup settings  203
statistics  176
swap file  106
swap files  106
templates, converting to  47
upgrading hardware version  81
versions  32
viewing consoles  205
virtual machine communication interface  145
Virtual SMP  34
See also templates, clones
See also virtual hardware

virtual memory
allocation  100, 101
configuring  100

virtual processors, See CPUs
Virtual Serial Port Concentrator  111, 115, 117
Virtual SMP  34
VMCI, enabling  146
VMFS volume  121
vMotion

CD-ROM migration limitation  137
compatibility  97, 98
limitations for USB passthrough  151
migrating virtual machines with  225, 226
requirements  222
virtual machine requirements  221

VMware Compatibility Guide, accessing  55
VMware Tools
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requirement for customization  55
upgrading  87

vService, add a dependency  148, 190
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vservices, configuring  148
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vServices,monitoring  201
vSPC  111, 115, 117
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Windows
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